About this Manual
Notations
The following notations may be used in this manual.
• Microsoft Windows 8.1 64-bit Edition operating system  Windows 8.1(64bit version)*
• Microsoft Windows Server 2012 R2 64-bit Edition operating system  Windows Server 2012
R2
• Microsoft Windows 8 64-bit Edition operating system  Windows 8 (64bit version)*
• Microsoft Windows Server 2012 64-bit Edition operating system  Windows Server 2012
• Microsoft Windows 8.1 operating system  Windows 8.1*
• Microsoft Windows Server 2012 R2 operating system  Windows Server 2012 R2*
• Microsoft Windows 8 operating system  Windows 8*
• Microsoft Windows Server 2012 operating system  Windows Server 2012*
• Microsoft Windows 7 64-bit Edition operating system  Windows 7 (64bit version)*
• Microsoft Windows Vista ™ 64-bit Edition operating system  Windows Vista (64bit
version)*
• Microsoft Windows Server 2008 R2 64-bit Edition operating system  Windows Server 2008
R2
• Microsoft Windows Server 2008 64-bit Edition operating system  Windows Server 2008
(64bit version)*
• Microsoft Windows Server ™ 2003 x64 Edition operating system  Windows Server 2003
(x64 version)*
• Microsoft Windows 7 operating system  Windows 7*
• Microsoft Windows Vista ™ operating system  Windows Vista*
• Microsoft Windows Server 2008 operating system  Windows Server 2008*
• Microsoft Windows Server ™ 2003 operating system  Windows Server 2003*
• Generic name for Windows, Windows 8.1, Windows Server 2012 R2, Windows 8, Windows
Server 2012, Windows 7, Windows Vista, Windows Server 2008 R2, Windows Server 2008,
Windows Server 2003  Windows
* If there is no special description, 64 bit version is included inWindows 8.1, Windows 8,
Windows Server 2012, Windows 7, Windows Vista, Windows Server 2008 and Windows
Server 2003.
• MacOS 9.0/9.0.4/9.1/9.2/9.2.1/9.2.2  MacOS
• MacOS X 10.3 and later  Mac OS X
• Generic name for MacOS 9.0/9.0.4/9.1/9.2/9.2.1/9.2.2, and Mac OS X 10.3 or later 
Macintosh

Terms
Note!

Memo

Cautions or restrictions that are required to operate this software correctly.
Be sure to read sections with this mark to ensure operations are performed correctly.
Indicates information that is useful to know or refer to when using the software. You should
read sections with this mark.

-2-

Important
Trademark Information
OKI is a registered trademark of Oki Electric Industry Co., Ltd.
Microsoft, Windows, Windows Server, Windows Vista, Excel, and Active Directory are the
trademarks or registered trademarks of Microsoft Corporation in the United States and other
countries.
Macintosh and Mac OS are the trademarks or registered trademarks of Apple Computers Inc.
in the United States and other countries.
PageMaker is the trademark or registered trademark of Adobe Systems Incorporated in the
United States and other countries.
SD Memory Card is the trademark or registered trademark of SD Association.
Other product names and brand names are registered trademarks or trademarks of their
proprietors.

About This Manual
1. Unauthorized copying of this manual in whole or in part is strictly forbidden.
2. The contents of this manual may be changed at any time without prior notice.
3. Every effort has been made to ensure that the information in this document is complete,
accurate and up-to-date. However, in the unlikely event you find a mistake or missing entry,
please contact your local vendor.
4. While all reasonable efforts have been made to make this document as accurate and helpful
as possible, we make no warranty of any kind, expressed or implied, as to the accuracy or
completeness of the information contained herein.

Manual Copyright
Oki Data Corporation owns the entire copyright to this manual. Unauthorized reproduction,
transcription, and translation of this document are prohibited. You must obtain written
permission from Oki Data Corporation to reproduce, transcribe, or translate any sections of
this manual.
© 2013 Oki Data Corporation
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License Agreement
Please read the following license agreement before using this software. This software includes
Print Job Accounting, Print Job Accounting Enterprise, Print Job Accounting Client, and all related
explanatory materials provided by Oki Data Corporation (hereinafter Oki Data). By using this
software, you are consenting to be bound by this agreement with Oki Data, and agree to the
conditions outlined herein.
1. This software can only be used with the corresponding Oki Data printer.
The user is only permitted to install one copy of Print Job Accounting (or Print Job Accounting
Enterprise) on one computer. You are required to purchase additional software in order to use
this software on two or more computers.
Print Job Accounting Client can be installed an used on any number of computers.
2. Ownership of all copyrights associated with this software and any copies therein belong to Oki
Data and any licenser who has been granted licensing rights by Oki Data. The customer is not
granted any rights to this software other than the rights described in this agreement. Other
than the installation described in article 1 above, the customer is not permitted to duplicate
this software in whole or in part, or to permit a third part to duplicate this software in whole
or in part. The customer agrees not to revise, modify, translate, reverse engineer, reverse
compile, or disassemble this software.
3. The customer agrees not to rent, loan, lease, distribute, copy, or transfer this software in
any way. The customer also agrees not to forward, transfer, export or re-export this software
outside Japan, and not to use this software for any unlawful activities.
4. If the customer violates any of the terms of this agreement, Oki Data can instruct the customer
to stop using the software and terminate the license agreement. In such a case in which the
license agreement is terminated, the customer shall cease use of the original software and all
copies, and destroy all copies of the software.
5. Within a period of 90 (ninety) days from the purchase of this software, if a physical defect to
the recording media on which this software is stored prevent proper use of the software, Oki
Data will provide a replacement equivalent item. If the software does not operate correctly
for any other reason, Oki Data will provide a refund to the customer that is limited to the
equivalent cost paid for the software. However, Oki Data provides no warranty whatsoever
for any cases in which the software does not operate that are caused by accidents, improper
handling, or misuse of the software by the customer. Furthermore Oki Data provides no
warranty whatsoever against problems that arise due to interference from other software on
the customer's computer.
6. The selection, use, and results of using this software are entirely the responsibility of the
customer.
7. This software may be changed or improved with no prior warning. However, irrespective of
customer wishes, Oki Data is not obliged to provide any kind of maintenance service such as
bug fixes, modified contents, or revised editions of this software. Furthermore, Oki Data is not
obliged to provide the customer with bug information, details of modified contents, or other
such revision information of this software.
8. Oki Data is not obliged to provide any kind of bug fixes or maintenance service for any
software manufactured by a different company that is provided with this software.
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1. Before Setup

1. Before Setup
1

This section explains the mechanisms and configuration of Print Job Accounting, and the
contents that need to be decided before setup.

What is Print Job Accounting?
Print Job Accounting sets detailed print restrictions on print jobs printed from computers
according to individual users and printers, and acquires and summarizes print job information
in a log.

Special Features of Print Job Accounting
Management of Print Restrictions
• Multiple users and printers can be put together into groups, and settings for allowing and disallowing
printing or color printing for each group can be configured.
• Settings for allowing or disallowing the printing or color printing of the login name, application name,
document name or host name can be configured.
• Upper limits for the number of prints can be set according to user, printer, user group and printer
group.
• Printing costs can be charged according to user and user group. Printing costs can be set according to
such factors as quantity and paper size. Also, different fees can be set for individual printers.
• Settings for allowing or disallowing printing or color printing can be configured for users or groups
registered in the Active Directory. (Only Enterprise edition)
• Printing costs can be charged according to users and groups in the Active Directory. (Only Enterprise
edition)

Log Acquisition and Summary
• Information included the printed date and time, user name, quantity and paper size can be acquired
and summarized in the log.
• The log can be output as a CSV file for use in commercially available spread sheet software.
• Information such as log information can also be saved in an SQL database and browsed from a web
browser. (Only Enterprise edition)
Memo

A CSV file is a text file separated by commas, and is a file format that is commonly used for
converting data between spread sheets and database management software.

Support for both Windows and Macintosh operating environments
• Both Windows and Macintosh operating environments are supported as client environments.
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Print Job Accounting Mechanisms
When the user sends a print job,
the job information is stored as a log on the printer's
built-in hard disk or flash memory, and the
Print Job Accounting server software obtains
the log. The information obtained by the server software is deleted from the printer.
The
log obtained in
is saved to the SQL database. (Only Enterprise edition)
User or group
information registered in the Active Directory is referenced. (Only Enterprise edition)

Client Computer

Printer

PrintJob Accounting
Server
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SQL Database
Server

Active Directory
Server

1

1. Before Setup

Print Job Accounting Configuration
1

Print Job Accounting server software (Windows)
This is a management tool for the system administrator. Registration of printers and users, and print
limitation settings can be configured. Also, the log is obtained and saved from the printer at a set
schedule.
This is called server software.

Print Job Accounting Client Software (Windows)
Install onto the Windows client computer.
Set the setting method (Job Accounting Mode) for setting the User Name and Job Account ID in the client
computer.
This is called Client Software.

Print Job Accounting Client Plugin (Mac OS)
This is automatically installed when the Mac OS PS printer driver is installed. A panel for setting the
UserName and JobAccountingID is added to the print dialog.
This is called a plugin.

Print Job Accounting Client Software (MacOS X)
This is installed in the Mac OS X client computer.
Set the Username and JobAccountingID on the client computer.
Only the Mac OS X PS printer driver is enabled.
This is called Client Software.
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Print Job Accounting Installation Process
1

Setting up server software
Prepare Job Account ID, name and User Name
information.

Installing the server software.

If required, configure software that is related to the
server software. (Only Enterprise edition)

Configure the printer in the server software.

Register the Job Account ID and name.

Setting up Client Software
For Windows
Install the Client
Software.

For Mac OS
Configure the plugins.

Select Job Accounting
Mode.

For Mac OS X
Install the Client
Software.

Set the UserName
and JobAccountingID.

- 15 -

1. Before Setup

Preparing User Information
1

In Print Job Accounting, set the user for the server software and Client Software/plugin.
Before setup, it is necessary to decide which users will use the printer.
Note!

• Users can be added/deleted at a later date. For details, see "Job Account ID management"

(page 48).
• When using in combination with Active Directory, it is not necessary to decide which
users will use the printer. For details, see "Syncing with Active Directory user information"
(page 102). (Only Enterprise edition)

Information required for settings
In order to configure user settings, Job Account ID, name and User Name information is
required.
Read the explanation below carefully, and prepare the Job Account ID, name and User Name
information according to the objectives of the print restrictions and log.

Server software
Setting
information
Job Account ID

Details
This number is used to recognize users
in Print Job Accounting. Assigned to each
user, settings such as print restrictions

Registration range
1~999999999

and cost burden are set for each Job
Account ID on the server software.
Name

This name is applied to make the Job
Account ID easy to distinguish.

Up to 80 characters
(Names cannot include a ” symbol.)

Client Software/Plugin
Setting
information
Job Account ID

Details
This number is used to recognize users
in Print Job Accounting.
When print restrictions or logs are
configured for each department, the
same ID is assigned to all users within
the department.
When printing is performed without
setting the Job Account ID, printing is
performed by an unregistered user and
0 remains as the Job Account ID in the
log.
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Registration range
1~999999999
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Setting
information
Name

Note!

Details

Registration range

This setting is for recognizing the actual
user who ordered the print job from
the client computer. This information is
stored in the "User" section of the log.
When printing is performed from a
Windows or Mac OS X computer that is
not configured with the Client Software,
the user is an unregistered user, Job
Account ID is 0, and the user name used
to log on to either Windows or Mac OS X
remains in the log as the User Name.
When printing is performed from a Mac
OS computer that is not configured with
the "Job Accounting" panel, the user is
an unregistered user, JobAccountingID
is 0, and UserName remains as a blank
space in the log.

Up to 80 characters
(Names cannot include a ” symbol.)

Depending on applications such as the Windows version of PageMaker, data that does not use
printer drivers may be created.
In this case, the user is an unregistered user, Job Account ID is 0, and User Name is remains
as a blank space in the log.
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Example of assigning the Job Account ID

1

The following usage methods are possible depending on how the settings and limitations are
configured and the logging method.

Example of Use

Server software settings

Client Software/Plugin
Settings

When you want to
permit printing for
only some users.

Set the Job Account ID
and name only to users
who are permitted to
print. Unregistered IDs are
prohibited from printing.

Set the Job Account IDs that are
permitted to print.

When you want
to permit color
printing for only
some users.

Set the Job Account ID and
name only to users who
are permitted to print in
color. Unregistered IDs are
prohibited from color printing.

Set the Job Account IDs that are
permitted to print.

When you want
to keep a record
of the printing
limitations and log
for each user.

Set a unique Job Account ID
and name for each user so
there are no duplications.

Set the User Name and Job
Account ID for each user so there
are no duplications.

When you want
to keep a record
of the printing
limitations and
log for each
department.

Set a Job Account ID and
name for each department.
When information is totaled
for [Job Account ID],  the log
for each department can be
obtained.

Set the Job Account ID assigned
to the department, and set the
name of the user that is printing
as the User Name.

When you want
to place print
restrictions on each
department, but
log printing in each
person's name.

Set a Job Account ID and
name for each department.
When information is totaled for
[User Name],  the log for each
user can be obtained.

Set the Job Account ID assigned
to the department, and set the
name of the user that is printing
as the User Name.

When you want
to apply print
limitations and
obtain logs for
each department,
yet also apply
limitations and
obtain logs for each
user.

Set a unique Job Account ID
and name for each user so
there are no duplications.
Divide users into user groups
according to department.

Set the User Name and Job
Account ID for each user so there
are no duplications.
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Example of Use
When you want
to just collect a
print log without
imposing print
restrictions.

Server software settings
The Job Account ID and name
do not need to be set.
When information is totaled for
[User Name], the log for each
user can be obtained.

Client Software/Plugin
Settings
<For Windows and Mac OS X>
The Client Software does not
need to be installed on the client
computer. The login user name
used for Windows or Mac OS X
remains in the log as the User
Name.
<For Mac OS>
The JobAccountingID is set as
desired, and the UserName is set
as the user name for printing.

If Print Job Accounting associates with Active Directory, Login name and Card ID registered
on Active Directory in advance can be used as the user information. (Only Enterprise edition)
Card ID is registered to assign to unused arbitrary attribute with Active Directory.

Setting information for Active
Directory

Memo

Details

Login name

This name is used to login to Windows.

Card ID

This ID is the meaning information which
can identify a card.

For detail on usable Card ID, refer to Card Secure Kit user manual.

- 19 -

1

1. Before Setup

Memo
1
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2. Setting up the server software

2. Setting up the server software
This section explains how to set up the Print Job Accounting server software.

2

Note!

The window and setting contents differ depending on the printer model.

Installing the server
software

Operating Environment
	Windows 8.1 / Windows 8.1 (64bit

version)
 Windows Server 2012 R2

Note!

 Windows 8 / Windows 8 (64bit version)

It is necessary to logon as a user with
PC administrator privileges.

 Windows Server 2012

❶ Launch the server software application.

 Windows 7 / Windows 7 (64bit version)

❷ If the [User Account Control] dialog box
appears, click [Yes] or [Continue].

	Windows Vista / Windows Vista (64bit

version)

❸ Click [Next].

 Windows Server 2008 R2
	Windows Server 2008 / Windows Server

2008 (x64 version)
	Windows Server 2003 / Windows Server

2003 (x64 version)
Note!

• The computer in which the server
software is installed needs to remain
switched on, or needs to be running at
the time at which the log is set to be
obtained from the printer.
• Approximately 3MB of hard disk space
is required to save 10,000 log entries
on the computer.

❹ Read “Software License Agreement” and
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then click [Yes].

2. Setting up the server software

❺ Verify the desired installation destination

❽ Check the settings and begin copying

location, and click [Next].

files by clicking [Next].

2

❻ Select appropriate Program Folder, and

❾ Click [Finish].

click [Next].

❼ Select [North America] or [Europe],
depending on location and then click
[Next].

Installing the server software is now
complete.  
If the server software is Enterprise Edition,
proceed to “Activating the license for the
server software” (page 24).
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Activating the license for
the server software
2

Note!

❺ Verify that “The Activation was
successful” dialog box is displayed, and
click [Continue].

The server software is required for
activation of the license.

❶ Select [Start] > [All Programs] >
[Okidata] > [Print Job Accounting
Enterprise] > [Print Job Accounting
Enterprise].

❷ When the [User account management]
window is displayed, click [Continue] or
[Yes].

❸ Click [Activate Print Job Accounting
Enterprise].

Note!

• If "Could not communicate with the

server" is displayed in the dialog box,
please check that the computer can
connect the Internet.
• If "The License could not be found on
the server” is displayed, please check
[Password] and [License ID] in step ❹.

❻ Check that “Server ID” is displayed, and
click [OK].

❹ Enter [License Key] in the first box and
[Password] in the second box and Click
[Continue].
Memo

①

After the installation is completed, you
can check “Server ID”.
[Help] menu> [Server ID]

❼ Activating the server software is now
complete.

②
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Server software window configuration
①② ③④ ⑤ ⑥
⑧

⑦

① [File] Menu
Commands for exiting the server software are displayed.

② [Printer] Menu
Commands for adding, deleting and managing printers that obtain logs are displayed.

③ [Log] Menu
Logs and summaries are displayed, and commands for writing to files are also displayed.
Memo

Items in the [Printer] menu and [Log] menu can also be selected by right-clicking the mouse
on the printer or log to be operated, and selecting the command.

④ [Policy] Menu
Commands for setting the usage limitations are displayed.

⑤ [Option] Menu
Commands for setting the options are displayed.

⑥ [Help] Menu
You can view the Server ID, help and version information.

⑦ Selection window
Printers managed using Print Job Accounting and obtained logs are displayed in a tree
format according to printer and date.
The tree can be opened and closed using the same standard operations as Windows
Explorer. The tree is in the closed state directly after starting the server software, and needs
to be opened in order to select items.

⑧ Details window
Double-click the [Printer] that is at the origin of the tree in the selection window, and the
address, group it belongs to, log obtained/unobtained status, and date on which the last log
was obtained for printers managed by Print Job Accounting are displayed.
Double-click the log in the selection window to display the log.
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Starting the server software
Note!

2

The server software settings cannot
be configured without computer
administrator authority.

Configuring Active Directory
settings (Only Enterprise
edition)

❶ Check that the printer power is ON.
❷ Select [Start] > [All Programs] > [Oki
Data] > [Print Job Accounting] > [Print
Job Accounting].
When the [User Account Control] window
is displayed, click [Yes] or [No].
The server software starts.

❸ When the server software is started for
the first time, a window is displayed
notifying you of the Server ID. You must
write down the Server ID and store it
safely.
Memo

Setting up the server
software

In Print Job Accounting, the log from
one printer cannot be obtained by
multiple servers. For this reason, in
order to distinguish which server is
obtaining the printer log, the Server ID
is set in the printer.
If a Print Job Accounting sever
cannot be used due to breakdown
etc, obtaining of the log needs to be
changed to a different server.

Settings for Active Directory such as
setting usage limitations and registered
printers for user information managed
using Active Directory or registering an IC
card compatibility table to Active Directory
need to be configured in the server
software.
Before registering the printer in the server
software, if you complete all settings for
the Active Directory first, the operation to
register user information managed in the
Active Directory or the IC compatibility
table to the printer can be performed
smoothly.
Active Directory settings can also be
configured after registering the server
software to the printer.
For details on Active Directory settings, see
chapter 6 "Syncing with Active Directory
User Information" (page 102).

Configuring Database
settings (Only Enterprise
edition)
In order to export log or Job Account IDs
that are managed with the sever software
to the database, database settings need to
be configured in the server software.
If you complete the database settings
before registering the printer to the server
software, the operation for exporting logs
or Job Account IDs managed using the
server software to the database can be
performed smoothly.
Database settings can also be configured
after registering the server software to the
printer.
For details on the database settings, see
chapter 7 "Saving managed data to the
database" (page 146).
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①-2 Enter the community name in the

Adding a printer that
acquires the log
Note!

entry field and click [ADD].

A maximum 50 printers (In Enterprise
edition, 1,000 printers) can be
registered to the server software.

2

❶ Select the [Printer] menu > [Add a
Printer].

①-3 Click [OK].

❷ Specify the printer that will acquire the
log.

② Select the search method.

<To search for a printer>

<Local port or broadcast search>

① To search for TCP/IP network printers,
specify the community name that is
used for authentication to search for
printers by using SNMP communication.

①-1 Click [SNMP Setting].

②-1 Select [Search printers and select
from the list], check the port to
which the printer is connected,
and click [Next].
Memo
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To search for printers in different
segments of the TCP/IP network, enter
the broadcast address. If it is unknown,
contact the network administrator.
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<Searching for the printer from a CSV file>

① Select [Specify the printer by address],

②-1 Create a CSV file using software
such as Notepad or Excel etc.

2

<To specify a printer directly>
and select [Address]. When connected
to a TCP/IP network, enter the printer
IP address into [IP Address].

  <For Notepad>
i Write the IP address and name of
each printer on one line for each
printer. Separate the IP address and
printer names with a comma ",".
The printer name can be omitted.
ii

Save in text format with the
extension "CSV".

  <For Excel>
i Write the IP address and name of each
printer on one line for each printer.
The printer name can be omitted.
ii

Save in CSV file format.

②-2 Select [Import printers from a
file], and click [Reference].
②-3 Specify the CSV file created in ①,
and click [Open].
②-4 Click [Next].
③ Select the printer from the list, and
click [Next].

Memo

② Click [Next].

Only printers that are supported by
Print Job Accounting are displayed.
Press and hold the Shift key or Ctrl key
while selecting to select more than 1
printer.
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❸ Set the printer to acquire the log, and

Acquire Logs

click [Finish].

Set the schedule by which the log is acquired.
Note!

Always set a time when the computer in
which the server software is set up and
printer power are both switched ON.
The log is not acquired if the power is
not ON.

Interval
Set the interval when the log is acquired over
a fixed time. The maximum interval time that
can be set is 24 hours. The default setting is
set as an optimized value detected from the
state of the added printer. If the interval is
set to a time that is longer than the default
settings, some of the logs may not be acquired.

Time
Set the specific time. Click [Change Time], and
add the time to the [Change Time To Acquire
Logs] window. Up to 5 acquisition times can be
added. After adding, click [OK].

Fees
Set the fee definition pattern when assigning
printing costs to users.
Click [Define fees] to add definitions.
For details on the fee charge definitions, see
"Creating fee charge definitions" (page 180).
Memo

Printer Name
Set the name of the printer to be displayed in the
server software.

Printer Group
Select the group that the printer belongs to.

The initial settings definition shows
a rough guide to the running costs
calculated from the standard prices of
various consumables and the number of
prints over the lifetime for each model.

Operation at Log Full
Set the process when the printer log buffer is full.

• Delete old logs
The oldest log is deleted, and the new log is
received.

• Cancel the job
All subsequent print jobs are cancelled.

• Do not acquire the log
The log is not obtained for subsequent print
jobs.

- 29 -

2

2. Setting up the server software

Inhibit the initialization of the Hard Disk
and Flash Memory
Check this check box to prevent the printer builtin hard disk, SD memory card, and flash memory

2

from being initialized. When Print Job Accounting
is used, always check this check box.

SNMP Setting
Set the community name that is used for
authentication to manage printers by SNMP
communication.

• Read
Specify the read community name for the
server software.

Auto Export Logs
Set to automatically write the acquired log to a

• Write
Specify the write community name for the

CSV format file, and send the file via e-mail.

server software.

• Retry

• Do not automatically export

Specify the number of times to retry the

Automatic export is not performed.

SNMP get or set operation. This setting is

• Automatically export logs
The acquired log is automatically written as
a CSV format file to the automatic export

effective only on some models.

• Timeout
Specify the timeout for the retries of the

destination.

SNMP get or set operation. This setting is

• Mail logs to administrator

effective only on some models.

The acquired log is automatically written as
a CSV format file to the automatic export

• Read Community
Specify the read community name for traps.

destination, and the file is sent by e-mail to
the administrator.

This setting is effective only on some models.

• Write Community
Specify the write community name for traps.

Record logs in a database (Only
Enterprise edition)

This setting is effective only on some models.

Check to export the acquired log to a database.

• Trap Port
Specify the Trap log receiving port. This

Acquire Only Logs (do not use
restrictions)

setting is effective only on some models.

Check this check box when you do not want to
automatically activate access restrictions for

❹ When the "Please enter the administrator

models that have an access restriction function
on the control panel.
Note!

Users cannot be registered.

password of the printer" window is
displayed, enter the printer administrator
password, and click [OK].
Note!

Start acquiring the log immediately after
adding
Check this check box to start acquiring the log

• Depending on the printer, this is not
displayed.
• For details on the factory set printer
administrator password, see the User's
Manual of the printer.

after adding a printer.

Next, the "Job Account ID registration"
window is displayed.
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Registering the Job Account
ID and Name
The Job Account ID and Name can be
registered using the following method.
• Manual registration.
• Create a CSV file that contains the
Job Account IDs and User Names, and
register them in a batch.
• Users registered in Windows on the
network are read.
This section explains how to register
manually. For details on other methods,
see "Adding the Job Account ID"
(page 48).

❸ Enter the [Job Account ID], [Name], and
[E-mail address] (can be omitted), and
click [Add].
Memo

The e-mail address needs to be set in
[Notifies total result by e-mail] and
[Notifies by e-mail when Limit Value
was exceeded] in step ❺.

❶ Click [Add] in the [Job Account ID
registration].

❹ Click [Next].
❺ Set functions for the Job Account ID, and
click [Next].

❷ Select [Add a User], select the group that
the user belongs to from [User Group],
and click [Next].
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Notifies total result by e-mail

2

Disable Color Copying

Notifies the total amount used every month by

Color copying using panel operations is

email.

prohibited. When this is disabled, the color

Notifies by e-mail when Limit Value was
exceeded
A mail notification is sent when the print quantity
exceeds the limit value and printing is no longer
possible, and when the limit value is reset and
printing is made possible again.

printing prohibited settings are applied.

Disable USB Memory to Print
Prohibits printing from a USB memory using
panel operations.

Disable USB Memory to Color Print
Prohibits color printing from a USB memory using

Do not process Limit Value as a group
Limit values can be set individually for users that
belong to a printer group, and users that belong
to a printer group.

panel operations.

Disable Scan to E-mail
Prohibits Scan to Email using panel operations.

❻ Set the use restrictions, and click [Next].

Disable Scan to Network PC /
Disable Scan to Shared Folder
Prohibits Scan to Network PC and Scan to Shared
Folder using panel operations.

Disable Scan to USB Memory
Prohibits Scan to USB memory using panel
operations.

Disable Fax Sending
Fax sending using panel operations is prohibited.
Fax sending that uses the fax driver is also
cancelled.

Disable Scan to Internet Fax
Prohibits scan to internet fax using panel
operations.

Disable Printing

Disable Scan to Fax Server

Cancels printing.

Prohibits scan to fax server using panel
operations.

Disable Color Printing
Cancels color printing. If there is color data partway through a print job, all printing from that
point onwards is cancelled.

Print In MONO
When disable color printing is set, monochrome
printing is performed without cancelling color
data.

Disable Copying
Copying using panel operations is prohibited.
When this is disabled, the printing prohibited
settings are applied.
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❼ Set the limit values that can be used by
Job Account ID.
When each of the limit values is
exceeded, printing is cancelled until the
valid period set in step ❽.
Note!

❽ Set the expiration date for the limit
values set in ❼, and click [Finish]. When
the valid period is exceeded, the limit
value count is reset.

2

The limit value settings are enabled
from the point at which the server
software obtains the log when the limit
value has been exceeded. Printing can
still be performed when the limit value
is exceeded until the server software
receives the log.

Do not specify
The valid period is not set. When the limit value
set in

❼ is not set, printing is cancelled unless

the limit value is increased, or the usage status
are manually reset.

By month
Set the valid period in month units. Set the

Printed Sheets
Set the number of sheets that can be printed.

Fees
Set the upper limit of the fee charges.

Staple
When the optional finisher is installed, set the
number of times that the stapler can be used.
When limit values are set

 click [Next], and proceed to step ❽.
When limit values are not set

 click [Finish], and proceed to step ❾.

number of months and base date (10th, 20th,
end of month, deadline).

By week
Set the valid period in week units. Set the
number of weeks and base day.

By day
Set the valid period in day units. The number of
days is set.

Carry over unused value to the next valid
period
Check to carry over the amount that is not used
within the valid period to the next period.

❾ When the "Please enter the administrator
password of the printer" window is
displayed, enter the printer administrator
password, and click [OK].
Note!
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• Depending on the printer, this may not
be displayed.
• For details on the factory set printer
administrator password, see the User's
Manual of the printer.
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 Click [End] in the [Job Account ID
registration] window.

 When the "Please enter the administrator

2

password of the printer" window is
displayed, enter the printer administrator
password, and click [OK].
Note!

Depending on the printer, this may not
be displayed.

Managing multiple printers
as a group
Multiple printers can be managed as
one group. When managed as a group,
the log can be displayed in group units.
Furthermore, the user control values can
be set to all of the printers that belong to
the group.

❶ Start the server software.
❷ Select the [Printer] menu > [Manage
multiple printers as a group].

❸ Enter the printer group name, and click
[Next].

❹ Select the printer to assign to the group
from the list, and click [Finish].

Memo
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Press and hold the Shift key or Ctrl key
while selecting to select more than 1
printer.
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❺ Register users to the group.
The Job Account ID registration window
is displayed. To register users, follow
the instructions in "Registering the Job
Account ID and Name" (page 31) and
register the users.

Deleting the printer group
❶ Start the server software.
❷ Double-click [Printer] in the selection
window. The registered printer list is
displayed in the list view of the details
window.

❻ The [Do you want to register the Job
Account ID registered in the group?]
window is displayed.
Click [Yes], and the user registered in
step ❺ is registered to the printer.
Memo

❸ Select the printer group you want to
delete, and select the [Printer] menu >
[Delete a Printer/Printer Group].

When limit values are set for users
or user groups that are registered to
printer groups, the limit values are
enabled for the total amount of usage
for users and user groups of all printers
that belong to the printer group.
However, the usage amount of users
and user groups that have the [Do not
process Limit Value as a group] check
mark checked are not included.

Changing the printer group
The printer can be changed to a different
group. This is useful for when the printer is
relocated to a different department.

❶ Start the server software.
❷ Double-click [Printer] in the selection
window. The registered printer list is
displayed in the list view of the details
window.

❸ Select the printer whose group you want
to change, and select the [Printer] menu
> [Change a Printer Group].
Memo

Memo

❹ Click [Yes].
Memo

Printers that belong to the deleted
printer group are changed to [Not in a
group].

Backing up printer settings
Printer settings can be backed up. Backedup settings can be restored to a different
computer that has the server software
installed. This means that even if a
problem occurs with your computer, you
can continue using the same settings on
a different computer. Settings that can be
backed up are the printer settings, user
ID settings, fee settings, and user settings
that are synced with the Active Directory
(Only Enterprise edition).

❶ Start the server software.
❷ Select the [Printer] menu > [Backup of

Multiple printers can be selected.

❹ Select the new group to be assigned to,
and click [OK]. To remove the printer
from all groups, select [Not in a group].

❺ When the [Do you want to register the
Job Account ID registered in the group?]
window is displayed, click [Yes].
Note!

Multiple printer groups can be selected.

When [No] is clicked, the users
registered to that group are processed
as unregistered users in that printer.
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2
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❸ Specify the save location and file name of
the printer settings, and click [OK].
Note!

2

• Store the backed-up setting file on a
different computer.
• We recommend creating a new
settings backup file each time the
software settings are changed.
• Acquired logs are not backed up.

Restoring printer settings
Backed-up printer settings are restored in
the server software.

❶ Start the server software.
❷ Select the [Printer] menu > [Add a
Printer].

❹ Click [Finish].

❸ Select [Import printers from a file], and
specify the file path of the setting backup
file.
The extension of the settings backup file
is "dat".
You can also click the [Reference] button
and select the file.
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❺ When the administrator password window
is displayed, enter the administrator
password and click [OK].

❻ When the printer registration results
notification window is displayed, click
[Close].

2
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Memo

2
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3. Setting up the client software
This section explains how to set up the print job accounting client software with plugins.

❹ Click [Next].

Setting up in Windows
3

Operating Environment
●W
 indows 8.1 / Windows 8.1 (64bit
version)
● Windows Server 2012 R2
● Windows 8 / Windows 8 (64bit version)
● Windows Server 2012
● Windows 7 / Windows 7 (64bit version)
●W
 indows Vista / Windows Vista (64bit
version)
● Windows Server 2008 R2

❺ Read “Software License Agreement” and
then click [Yes].

●W
 indows Server 2008 / Windows Server
2008 (x64 version)
●W
 indows Server 2003 / Windows Server
2003 (x64 version)

Installing the Client Software
Note!

It is necessary to logon as a user with
PC administrator privileges.

❶ Launch the Client Software application.
❷ If the [User Account Control] dialog box
appears, click [Yes] or [Continue].

❻ Verify installation destination folder, and
click [Next].

❸ Choose the appropriate Language, and
then Click [Next].
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❼ Select appropriate Program Folders, and
then click [Next].

Setting Job Accounting Mode
Job Accounting Mode is a method of
setting the User Name and Job Account
ID in the Windows client computer. There
are 4 modes. The default status is the
unsupported mode.
Memo

Job Accounting Mode settings can only
be configured in a print driver that
supports Print Job Accounting.

Tab
The tab for setting the User Name and Job

❽ Verify settings and click [Next] to begin
copying files.

Account ID to the print driver properties is
displayed.
It is used by the user themselves to set or
change the User Name and Job Account ID.

Popup
A popup window for setting the User Name and
Job Account ID to be sent for each print job is
displayed.
It is used when 1 computer is used by multiple
users.
Note!

❾ Click [Finish].

Installing the Client Software is now
complete.
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Even if printing is performed on the
shared printer client side, the input
window is not displayed. Use Hide for
shared printers.

3
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❸ Click [OK] in the change successful

Hide

window.

Even if printing is performed on the shared

❹ Select [File] menu > [Close].

printer client side, the input window is not
displayed. Use the hide mode for shared
printers. The system administrator creates an ID
file that contains the Job Account ID and User
Name that correspond to the Windows login user

3

in advance. By specifying this file with the client
software, the user that performed the printing
is identified, and the corresponding Job Account
ID is automatically acquired. Furthermore, the
same Job Account ID can be set for all login
users. The users do not need to configure
settings or to know their own Job Account ID.
When using the Windows computer as a print
server and the printer as a shared printer, install

❺ In Windows 8.1/Server 2012 R2/8/Server
2012/7/Server 2008 R2/Vista/Server
2008 select [Start] > [Control Panel],
and click [Printer]. (For Windows Server
2003, select [Start] > [Printers and
FAX].)

and use the client software onto the computer to
be used as a print server.

Not supported
Users identification is not performed, and all

❻ On the printer driver icon, right-click the

jobs are recognized as Unregistered ID. The
User Name is the user name used to login to

mouse button and select [Properties].

windows, and the Job Account ID is 0. Used

❼ In the [Job Accounting] tab, enter the

when user recognition is not needed.

User Name and Job Account ID.

This section explains how to set the tab
mode. For details on how to change other
modes, see "Changing Job Accounting
Mode" (page 214).

In the default settings, the User Name is
the user name used to login to Windows,
and the Job Account ID is 1.

❶ Select the printer driver of the printer
that will acquire the log from the
[Driver] list. To set all of the printer
drivers to the same mode, check [Set
the same mode for all drivers].
Note!

When the shared printer is used,
do not use the function that sets all
printer drivers to the same mode.
When using a shared printer on
the client side to print, the account
information is not output.

❷ Select [Tab], and click [Change].

❽ Click [OK].
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Setting up in Mac OS
Note!

Setting up in Mac OS X

Depending on the model or print driver
used, the setting method or operating
environment may differ.

When the printer drivers are installed in Mac
OS, the plugins are installed together. Set
the User Name and Job Account ID in the
[JobAccounting] panel of the print dialog.
Note!

If printing is performed without
configuring these settings, the User
Name is blank and the Job Account ID is
0 in the log.

Operating Environment
Macintosh running Mac OS X 10.3 or later
Note!

Depending on the model or print driver
used, the operating environment may
differ.

Installing Client Software
❶ Double-click on the Client Software file.
❷ Disk image is mounted on the desktop.
❸ Copy to any location by dragging-and-

Configuring the plugins

dropping the Client Software icon onto
the disk image.

❶ Set up the printer drivers in Mac OS.
❷ Select the [File] menu > [Desktop Print].
❸ Select the [JobAccounting] panel.

Installing the Client Software is now
complete.
Memo

The Client software is a utility for
registering, editing and managing
JobAccountingID for the job account.

Registering the
JobAccountingID
Double-click the Print Job Accounting icon.

❶ Click [New].
❹ Set the User Name and Job Account ID,
and click [Save Settings].

❷ Enter the login name used for Mac OS X,
and the JobAccountingID and UserName
for Print Job Accounting, and click [Save].

❺ Click [OK] in the confirmation window.

❻ Click [Cancel] to close the dialog box.

Memo
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Repeat this operation to register
multiple users.

3
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❸ Click [Save].

Registering multiple users
together
Multiple JobAccountingID and UserName
can be registered using a CSV file. This is
useful when multiple login user names are
used in Mac OS X.

3

❶ Use commercially available software to
prepare a CSV file.
In the CSV file, enter the Mac OS X login
name, JobAccountingID and UserName in
this order.

❹ Enter the password, and click [OK].

①
②

Using 1 line for each user, enter the Mac
OS X login name, JobAccountingID and
UserName.
Save the CSV format file.

❷ Use the client software to register.
①

❺ Quit the client software.

②
③
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Double-click the Print Job Accounting
icon.
Select Import from the file menu.
Import the CSV file created in

❶.

④

Click [Save].

⑤

Enter the password, and click [OK].

⑥

Quit the client software.

3. Setting up the client software

Deleting the
JobAccountingID and
UserName

Changing the
JobAccountingID and
UserName
The Client software can be used to change
JobAccountingID and UserName that have
already been registered.

❶ Double-click Print Job Accounting.
❷ Select the user that you want to delete,
and click [Delete].

❶ Double-click the Print Job Accounting
icon.

Memo

❷ Select the user that you want to change,
and click [Edit].

❸ Enter the new JobAccountingID and

To delete all registered users, click
[Delete All].

❸ Click [Save].

UserName, and click [Save].

❹ Click [Save].

❹ Enter the password, and click [OK].

❺ Enter the password, and click [OK].

❺ Quit the client software.

❻ Quit the client software.
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Memo

3
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4. Job Account ID Management
This section explains how to add or delete a Job Account ID, how to change settings for the
Job Account ID use restrictions, and management of Job Account IDs.
Note!

The window and setting contents differ depending on the printer model.

Adding the Job Account ID
4

Job Account IDs can be added as required.
Add them using one of the following
methods.

❹ Select the printer or printer group,
and then select the [Printer] menu >
[Properties].
Memo

Multiple printers can be selected.

• Adding manually.
• Creating a user list file and adding in a
batch.
• Users registered in Windows on the
network are read.  
For details on Job Account IDs, see
"Preparing User Information" (page 16).

Adding manually
❶ Check that the printer power is ON.
❷ Start the server software.
❸ Double-click [Printer] in the selection
window. The registered printer list is
displayed in the list view of the details
window.

❺ In the [User] tab, click [Register].
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❻ Click [Add].

❽ Enter the [Job Account ID], [Name], and
[E-mail address] (can be omitted), and
click [Add].
Note!

Memo

If the names or user IDs duplicate
users that are already registered in the
printer, they cannot be added.  
The e-mail address needs to be set in
[Notifies total result by e-mail] and
[Notifies by e-mail when Limit Value
was exceeded] in "Setting functions or
use restrictions" (page 53).  

❼ Select [Add a User], select the group that
the user belongs to from [User Group],
and click [Next].

❾ Click [Next].
Proceed to "Setting functions or use restrictions"
(page 53).
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Creating a CSV file to add in
a batch

<For Excel>

①

Users can be added by creating a CSV file
that contains the Job Account ID, Name
and E-mail address, and importing the file.
Note!

4

Enter the Name, Job Account ID and
E-mail address for each user on an
individual line. Enter the Job Account ID.
The E-mail address can be omitted.
Name

Job Account ID

If the User Names or Job Account IDs
in the CSV file duplicate users that are
already registered in the printer, the
printer information remains, and only
the names and Job Account IDs that are
not duplicated are added.

❶ Create a CSV file using software such as
Notepad or Excel etc.
<For Notepad>

①

Enter the Name, Job Account ID, and
E-mail address for each user on an
individual line. Enter the Job Account ID.
Separate the Name, Job Account ID and
E-mail address with a comma (,). The
E-mail address can be omitted.

Name Job Account ID

E-mail address

②

Save in CSV file format.

❷ Check that the printer power is ON.
❸ Start the server software.
❹ Double-click [Printer] in the selection
window. The registered printer list is
displayed in the list view of the details
window.

❺ Select the printer or printer group,
and then select the [Printer] menu >
[Properties].

E-mail address

②

Save in text format with the extension
"CSV".

Memo

Multiple printers can be selected.

❻ In the [User] tab, click [Register].
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❼ Click [Add].

❾ Click [File].

4
❽ Select [Add a User], select the group that
the user belongs to from [User Group],
and click [Next].

 Specify the CSV file created in ❶, and
click [Open].

	Check that the Job Account ID and Name
have been added to the user list.

 Click [Next].
Proceed to "Setting functions or use
restrictions" (page 53).
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Importing users registered in
Windows

❼ Select [Add a User], select the group that
the user belongs to from [User Group],
and click [Next].

User name information from Windows
specified on the network can be obtained
and registered as a batch to the server
software. Names that can be obtained
are accounts registered on the specified
computer.
Note!

4

•  Access permission for the specified
computer is required.
•  If the names of users that are already
registered to the printer and those
registered to the computer are
duplicated, the printer information is
not imported, and only names that
are not duplicated are added.

❶ Check that the printer power is ON.
❷ Start the server software.

❽ Click [Remote Server].

❸ Double-click [Printer] in the selection
window. The registered printer list is
displayed in the list view of the details
window.

❹ Select the printer or printer group,
and then select the [Printer] menu >
[Properties].
Memo

Multiple printers can be selected.

❺ In the [User] tab, click [Register].
❻ Click [Add].
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❾ Select the computer from which to obtain
user information from in [Import Source],
and click [Add].

Setting functions or use
restrictions
Memo

The following steps apply to all Job
Account IDs registered in the steps
from page 48 to page 53. These can be
changed for individual Job Account IDs
afterwards.

❶ Set functions for the Job Account ID, and
click [Next].

Users that are registered as accounts
in the selected computer are added to
the [User] list. The Job Account ID is
assigned at random.

Notifies total result by e-mail
Notifies the total amount used every month by

 If user information that is not required
has been added, select Name, and click
[Delete].

 Click [OK].  

 Click [Next].
Proceed to "Setting functions or use
restrictions" (page 53).

Notifies by e-mail when Limit Value was
exceeded
A mail notification is sent when the print quantity

	Check that the Job Account ID and Name
have been added to the user list.

e-mail.

exceeds the limit value and printing is no longer
possible, and when the limit value is reset and
printing is made possible again.

Do not process Limit Value as a group
Limit values can be set individually for printer
users that belong to a printer group, and users
that belong to a user group.
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❷ Set the use restrictions, and click [Next].

Disable Scan to Network PC /
Disable Scan to Shared Folder
Prohibits Scan to Network PC and Scan to Shared
Folder using panel operations.

Disable Scan to USB Memory
Prohibits Scan to USB memory using panel
operations.

Disable Fax Sending
Fax sending using panel operations is prohibited.

4

Fax sending that uses the fax driver is also
cancelled.

Disable Scan to Internet Fax
Prohibits scan to internet fax using panel
operations.

Disable Printing

Disable Scan to Fax Server

Cancels printing.

Prohibits scan to fax server using panel
operations.

Disable Color Printing
Cancels color printing. If there is color data partway through a print job, all printing from that
point onwards is cancelled.

Print In Mono
When disable color printing is set, monochrome

Assign to a user group, and if [Do not
process Limit Value as a group] is not
checked in step ❶, click [Finish] and
proceed to step ❺. In other situations,
click [Next] and proceed to step ❸.

printing is performed without cancelling color
data.

Disable Copying
Copying using panel operations is prohibited.
When this is disabled, the printing prohibited
settings are applied.

Disable Color Copying
Color copying using panel operations is
prohibited. When this is disabled, the color
printing prohibited settings are applied.

Disable USB Memory to Print
Prohibits printing from a USB memory using
panel operations.

Disable USB Memory to Color Print
Prohibits color printing from a USB memory using
panel operations.

Disable Scan to E-mail
Prohibits Scan to e-mail using panel operations.
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❸ Set the limit values that can be used by
Job Account ID.
When each of the limit values is
exceeded, printing is cancelled until the
valid period set in step ❹.
Note!

❹ Set the valid period for the limit values
set in ❸, and click [Finish].  
When the valid period is exceeded, the
limit value count is reset.

The limit value settings are enabled
from the point at which the server
software obtains the log when the limit
value has been exceeded. Printing can
still be performed when the limit value
is exceeded until the server software
receives the log.

4

Do not specify
The valid period is not set. When the limit value
set in

❸ is not set, printing is cancelled unless

the limit value is increased, or the usage status is
manually reset.

By month
Set the valid period in month units. Set the

Printed Sheets

number of months and base date (10th, 20th,

Set the number of sheets that can be printed.  

Fees

number of weeks and base day.

Staple

By day

When the optional finisher is installed, set the
number of times that the stapler can be used.

click [Next], and proceed to step

By week
Set the valid period in week units. Set the

Set the upper limit of the fee charges.

When limit values are set

end of month, deadline).

❹.

When limit values are not set
click [Finish], and proceed to step

Set the valid period in day units. The number of
days is set.

Carry over unused value to the next valid
period
Check to carry over the amount that is not used

❺.

within the valid period to the next period.
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❺ When the "Please enter the administrator
password of the printer" window is
displayed, enter the printer administrator
password, and click [OK].
Note!

• Depending on the printer, this may
not be displayed.
• For details on the factory set printer
administrator password, see the User's
Manual of the printer.

4

Registering the same Job
Account ID to multiple
printers
The Job Account IDs and Names set in a
printer can be copied to a different printer.
Note!

❻ Click [End] in the [Job Account ID
registration] window.

❼ In the [Properties of printer from which
logs are acquired] window, click [OK].

• If the Job Account ID or Name of
the users that are already registered
to the copy destination printer are
duplicated from users in the copy
source printer, the information in the
copy destination printer remains, and
only Names and Job Account IDs that
are not duplicated are added from the
copy source.
• Use restriction settings are also copied
together with the Job Account ID.

❶ Check that the printer power is ON.
❷ Start the server software.
❸ Double-click [Printer] in the selection
window. The registered printer list is
displayed in the list view of the details
window.

❹ Select the printer or printer group,
and then select the [Printer] menu >
[Properties].
Memo

Multiple printers can be selected.

❺ In the [User] tab, click [Register].
❻ Click [Other Printer].
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❼ Select a printer or printer group that
already has user information registered
from [Import Source], and click [Add].

Managing multiple users as a
group
Multiple Job Account IDs can be managed
as one group. When managed as a group,
the log can be displayed in group units.
Furthermore, the limit values can be set to
all of the users that belong to the group.

❶ Start the server software.
❷ Double-click [Printer] in the selection
window. The registered printer list is
displayed in the list view of the details
window.

❸ Select the printer for which you want to
create a user group, and then select the
[Printer] menu > [Properties].
Memo

Multiple printers can be selected.

❹ Click [Registration] in the user tab.
❺ Click [Add].
The Job Account IDs and Names
registered in the selected printer or
printer group are added to the [User] list.

❽ If user information that is not required
has been added, select the Name, and
click [Delete].  

❾ Click [OK].
 When the "Please enter the administrator
password of the printer" window is
displayed, enter the printer administrator
password, and click [OK].
Note!

Depending on the printer, this may not
be displayed.

	Check that the Job Account ID and Name
have been added to the user list.  

	Click [End] in the [Job Account ID
registration] window.

	In the [Properties of printer from which
logs are acquired] window, click [OK].
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❻ Select [Management multiple Job Account

❽ Set the functions for the group, and click

ID as a group], enter the [Group Name]
and [E-mail address] (can be omitted),
and click [Next].
Memo

[Next].

The e-mail address needs to be set in
[Notifies total result by e-mail] and
[Notifies by e-mail when Limit Value
was exceeded] in step ❽.

4

Notifies total result by e-mail
Notifies the total amount used every month by
email.

Notifies by e-mail when Limit Value was
exceeded

❼ Select the user that you want to assign to
the group, and click [Next].

A mail notification is sent when the print quantity
exceeds the limit value and printing is no longer
possible, and when the limit value is reset and
printing is made possible again.

Do not process Limit Value as a group
Limit values can be set individually for user
groups of printers that belong to the printer
group.
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❾ Set the use restrictions, and click [Next].

Disable Scan to Network PC /
Disable Scan to Shared Folder
Prohibits Scan to Network PC and Scan to Shared
Folder using panel operations.

Disable Scan to USB Memory
Prohibits Scan to USB memory using panel
operations.

Disable Fax Sending
Fax sending using panel operations is prohibited.
Fax sending that uses the fax driver is also
cancelled.

Disable Scan to Internet Fax
Prohibits scan to internet fax using panel
operations.

Disable Printing

Disable Scan to Fax Server

Cancels printing.

Prohibits scan to fax server using panel

Disable Color Printing

operations.

Cancels color printing. If there is color data partway through a print job, all printing from that
point onwards is cancelled.

Print In Mono
When disable color printing is set, monochrome
printing is performed without cancelling color

Create a user group in the printer group,
and if [Do not process Limit Value as a
group] is not checked in step ❽, click
[Finish] and proceed to step . In other
situations, click [Next] and proceed to step
.

data.

Disable Copying
Copying using panel operations is prohibited.
When this is disabled, the printing prohibited
settings are applied.

Disable Color Copying
Color copying using panel operations is
prohibited. When this is disabled, the color
printing prohibited settings are applied.

Disable USB Memory to Print
Prohibits printing from a USB memory using
panel operations.

Disable USB Memory to Color Print
Prohibits color printing from a USB memory using
panel operations.

Disable Scan to E-mail
Prohibits Scan to e-mail using panel operations.
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 Set the limit values that can be used by
the user group.
If the total amount used by all users that
belong to the group exceeds the limit
values, printing is cancelled for all users
that belong to the group until the valid
period set in step .
Note!

4

 Set the valid period for the limit values
set in , and click [Finish].
When the valid period is exceeded, the
limit value count is reset.

The limit value settings are enabled
from the point at which the server
software obtains the log when the limit
value has been exceeded. Printing can
still be performed when the limit value
is exceeded until the server software
receives the log.  

Do not specify
The valid period is not set. When the limit value
set in

❸ is exceeded, printing is cancelled unless

the limit value is increased, or the usage status is
manually reset.

By month
Set the valid period in month units. Set the
number of months and base date (10th, 20th,
end of month, deadline).

Printed Sheets

By week

Set the number of sheets that can be printed.  

Set the valid period in week units. Set the
number of weeks and base day.

Fees

By day

Set the upper limit of the fee charges.

Set the valid period in day units. The number of

Staple
When the optional finisher is installed, set the
number of times that the stapler can be used.
When limit values are set
click [Next], and proceed to step

.

When limit values are not set
click [Finish], and proceed to step

days is set.

Carry over unused value to the next valid
period
Check to carry over the amount that is not used
within the valid period to the next period.

.
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 Click [End] in the [Job Account ID

Changing the user group

registration] window.

❶ Start the server software.
❷ Double-click [Printer] in the selection
window. The registered printer list is
displayed in the list view of the details
window.

❸ Select the printer whose user group you
want to change, and then select the
[Printer] menu > [Properties].
Memo

Multiple printers can be selected.

❹ In the [User] tab, click [Register].
 In the [Properties of printer from which
logs are acquired] window, click [OK].

❺ Select the user whose group you want to
change, and click [Change Group].
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❻ Select the new group to be assigned to,
and click [OK]. To remove the printer
from all groups, select [Not in a group].

Deleting a Job Account ID
or User Group
Note!

[Local Print], [Email To Print], and
[Unregistered ID] cannot be deleted.

❶ Check that the printer power is ON.
❷ Start the server software.  
❸ Double-click [Printer] in the selection

4

window. The registered printer list is
displayed in the list view of the details
window.

❼ Click [End].

❹ Select the printer, and then select the
[Printer] menu > [Properties].
Memo

Multiple printers can be selected.

❺ In the [User] tab, click [Register].  
❻ Select the Name or Group Name from
the [List of registered IDs], and click
[Delete].

❽ Check that the group is changed, and
click [OK].

❼ Click [Yes] in the confirmation window.
❽ Click [End] in the [Job Account ID
registration] window.  

❾ In the [Properties of printer from which
logs are acquired] window, click [OK].
Memo
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When a user group is deleted, the users
that belonged to the deleted user group
are changed to [Not in a group].
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Changing Job Account ID
and User Group settings

❼ Change the settings in the [Job Account
ID] (or [User Group] for groups), [User
Restrictions], and [Limit Value] tabs, and
click [OK].

❶ Check that the printer power is ON.
❷ Start the server software.  
❸ Double-click [Printer] in the selection
window. The registered printer list is
displayed in the list view of the details
window.

4

❹ Select the printer, and then select the
[Printer] menu > [Properties].

Memo

Multiple printers can be selected.

❺ In the [User] tab, click [Register].  
❻ Select the Name or Group Name whose
settings you want to change from
the [List of registered IDs], and click
[Change].

Job Account ID tab
Name
This can be specified in a maximum of 80
characters. """ cannot be used.
Note!

The Job Account ID cannot be changed.
In order to change the Job Account ID,
delete the Job Account ID and then add
it again.

E-mail address
Enter to send an e-mail when the use amount or
limit values are exceeded.

User Group
Set the group to assign the user to.
If you do not want to assign the user to a group,
select [Not in a group].

Notifies total result by e-mail
Notifies the total amount used every month by
e-mail.

Notifies by e-mail when Limit Value was
exceeded
A mail notification is sent when the print quantity
exceeds the limit value and printing is no longer
possible, and when the limit value is reset and
printing is made possible again.
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Do not process Limit Value as a group

Disable Scan to E-mail
Prohibits Scan to e-mail using panel operations.

Printer limit values can be set individually for
users/user groups that belong to printer groups,
and users that belong to user groups.

Disable Scan to Network PC /
Disable Scan to Shared Folder
Prohibits Scan to Network PC and Scan to Shared

User Restriction tab

Folder using panel operations.

Disable Scan to USB Memory
Prohibits Scan to USB memory using panel
operations.

4

Disable Fax Sending
Fax sending using panel operations is prohibited.
Fax sending that uses the fax driver is also
cancelled.

Disable Scan to Internet Fax
Prohibits scan to internet fax using panel
operations.

Disable Scan to Fax Server
Prohibits scan to fax server using panel
operations.

Disable Printing
Cancels printing.

Limit Value tab

Disable Color Printing
Cancels color printing. If there is color data partway through a print job, all printing from that
point onwards is cancelled.

Print In Mono
When disable color printing is set, monochrome
printing is performed without cancelling color
data.

Disable Copying
Copying using panel operations is prohibited.
When this is disabled, the printing prohibited
settings are applied.

Disable Color Copying
Color copying using panel operations is

Printed Sheets

prohibited. When this is disabled, the color

Set the number of sheets that can be printed.

printing prohibited settings are applied.

Fees

Disable USB Memory to Print

Set the upper limit of the fee charges.

Prohibits printing from a USB memory using
panel operations.

Staple

Disable USB Memory to Color Print

When the optional finisher is installed, set the

Prohibits color printing from a USB memory using

number of times that the stapler can be used.

panel operations.
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Checking the usage status
of individual Job Account
IDs and User Groups

Valid Period
The valid period is displayed when limit
values are set. When the valid period is
exceeded, the limit value count is reset.

Do not specify
The valid period is not set. When the limit value

Checking the usage status

is exceeded, printing is cancelled unless the
Note!

limit value is increased, or the usage status is
manually reset.

By month
Set the valid period in month units. Set the
number of months and base date (10th, 20th,

❶ Start the server software.

end of month, deadline).

❷ Double-click [Printer] in the selection

By week

window. The registered printer list is
displayed in the list view of the details
window.

Set the valid period in week units. Set the
number of weeks and base day.

By day
Set the valid period in day units. The number of

❸ Select the printer, and then select the
[Printer] menu > [Properties].

days is set.

Carry over unused value to the next valid
period
Check to carry over the amount that is not used
within the valid period to the next period.
Note!

Memo

Multiple printers can be selected.

❹ In the [User] tab, click [Register].  
❺ Select the Name or Group Name that you

• The limit value settings are enabled
from the point at which the server
software obtains the log when the limit
value has been exceeded. Printing can
still be performed when the limit value
is exceeded until the server software
receives the log.
• If the valid period is changed, a
confirmation window is displayed to
check whether or not to reset the
usage status. To reset the usage
status, click [Yes].

❽ When the "Please enter the administrator
password of the printer" window is
displayed, enter the printer administrator
password, and click [OK].
Note!

To check or reset the usage status
including the log remaining in the
printer, first refer to "Immediately
acquiring the log" (page 196), and
acquire the log.  

Depending on the printer, this may not
be displayed.

❾ Click [End] in the [Job Account ID
registration] window.

 In the [Properties of printer from which
logs are acquired] window, click [OK].
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want to check from the [List of registered
IDs], and click [Change].

4
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❻ Check the [Usage Status] tab.

Resetting the usage status
❶ Follow the steps from ❶ to ❺ in
"Checking the usage status" (page 65).  

❷ Check the [Reset] check box in the
[Usage Status] tab, and click [OK].
Note!

4

If the [Status] in the [Job Account ID]
tab (or [User Group] tab for groups) is
"Disable Printing (Exceeded the limit
value)", it cannot be reset unless the
printer power is ON.  

Printed Sheets
The number of sheets printed until now and the
remaining number of prints are displayed.  

Fees
The fees incurred until now and the remaining fee
amount are displayed.

Staple
When the optional finisher is installed, the
number of times the stapler was used until now
and the remaining number of times are displayed.
Memo

• The usage status of the users and user
groups registered to the printer group
is the total usage amount of the users
and user groups from all printers that
belong to the printer group. Also, the
usage status of the user group is the
total usage amount of all users that
belong to the user group. However,
the usage amount of users and user
groups that have the [Do not process
Limit Value as a group] check mark
checked are not included.

❸ Click [Yes] in the confirmation window.
❹ Click [End] in the [Job Account ID
registration] window.

❺ In the [Properties of printer from which
logs are acquired] window, click [OK].
Memo

• When a valid period is set for the
Job Account ID, when the period has
passed, the usage status value is
automatically reset to 0.  

❼ When the confirmation is completed, click
[OK].

❽ Click [End] in the [Job Account ID
registration] window.  

❾ In the [Properties of printer from which
logs are acquired] window, click [OK].
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When the usage status of the user and
user group registered to the printer
group is reset, the usage status of the
users and user groups of all printers
that belong to the printer group are
reset. Also, when the usage status of a
user group is reset, the usage status of
all users that belong to the user group
are reset. However, the usage status
of users and user groups that have the
[Do not process Limit Value as a group]
check mark checked are not reset.

4. Job Account ID Management

❼ Click [OK].

Receiving log results by
e-mail

❽ Click [End] in the [Job Account ID

Log results can be notified by e-mail to the
user every month.
Note!

Memo

registration] window.

❾ In the [Properties of printer from which

The outgoing mail server and sender's
e-mail address need to be configured in
advance according to the "Setting the
outgoing mail function" (page 224).
•The mail is sent of the day after the
deadline (default setting is end of
the month) set in the "Changing the
deadline" (page 195).
• Items to be logged can be changed in
"Changing log items to be exported"
(page 201).

❶ Start the server software.
❷ Double-click [Printer] in the selection
window. The registered printer list is
displayed in the list view of the details
window.

❸ Select the printer or printer group,
and then select the [Printer] menu >
[Properties].
Memo

Multiple printers can be selected.

❹ In the [User] tab, click [Register].
❺ Select the user to set, and click
[Change].

❻ Enter the E-mail address in the [E-mail
address] field of the [Job Account ID]
tab, and check the [Notifies total result
by e-mail] check box.
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logs are acquired] window, click [OK].

4
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❹ Select the printer or printer group,

Associating Job Account
IDs to authentication
users

4

and then select the [Printer] menu >
[Properties].
Memo

Multiple printers can be selected.

In models that have an access restriction
function on the control panel in which
user name/password authentication is
being used, a Job Account ID can be
associated with user names that perform
authentication. When a Job Account ID is
associated with a user name, when that
user name/password are used to login to
the control panel, or when the user name/
password are set in the printer driver when
printing is performed, the use restrictions
associated with the Job Account ID are
enabled.
Note!

• "Admin" cannot be specified as the
user name.

❺ Click [Authentication User] in the [User]

• The same Job Account ID can be
associated with different user names.

Adding manually
❶ Check that the printer power is ON.
❷ Start the server software.
❸ Double-click [Printer] in the selection
window. The registered printer list is
displayed in the list view of the details
window.
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tab.
The association between the user name
registered to the printer and Job Account
ID is acquired and displayed in the
register list.
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❻ Enter the [User Name] in the user name,

❽ When the "Please enter the administrator

select the Job Account ID that you want
to associate with the user name from
[Job Account ID], and click [Add]. To
delete associations, select the association
that you want to delete from the
registration list, and click [Delete].

password of the printer" window is
displayed, enter the printer administrator
password, and click [OK].
Note!

For details on the factory set printer
administrator password, see the User's
Manual of the printer.

4

❾ When a message showing that the
process was successful is displayed, click
[OK].

❼ Click [Registration].
Note!

• Register all associations between the
registration list user names and Job
Account IDs.
• The associations deleted from the
registration list are also deleted from
the printer.

 Click [End].
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Creating a CSV file to add in
a batch
A CSV file that contains the User Name
and Job Account ID can be created, and
associations added to the user names and
Job Account IDs by importing the file.

❶ Create a CSV file using software such as
Notepad or Excel etc.

4

❷ Check that the printer power is ON.
❸ Start the server software.
❹ Double-click [Printer] in the selection
window. The registered printer list is
displayed in the list view of the details
window.

❺ Select the printer or printer group,
and then select the [Printer] menu >
[Properties].

<For Notepad>

①

The authentication user and Job Account
ID are included for each user individually
on a separate line. The authentication
user and Job Account ID are separated
with a comma (,).

Memo

Multiple printers can be selected.

❻ In the [User] tab, click [Authentication
User].
The association between the User Name
registered to the printer and Job Account
ID is acquired and displayed in the
register list.

❼ Click [File].

②

Save in text format with the extension
"CSV".

<For Excel>

①

The authentication user and Job Account
ID are included for each user individually
on a separate line.

❽ Specify the CSV file created in ❶, and
click [Open].

❾ Check that the User Name and Job
Account ID have been added to the
registration list.
Note!

②

Save in CSV file format.

- 70 -

When a Job Account ID that is not
registered to the printer is specified,
the registration list is not displayed. A
Job Account Id needs to be added in
advance.

4. Job Account ID Management

 Click [Registration].
Note!

• Register all associations between the
registration list User Names and Job
Account IDs.
• The associations deleted from the
registration list are also deleted from
the printer.

Importing users registered in
Windows
User name information can be acquired
from Windows specified on the network,
and a Job Account ID can be associated.
User names that can be obtained are
accounts registered on the specified
computer.
Note!

Access permission for the specified
computer is required.

❶ Check that the printer power is ON.
❷ Start the server software.
❸ Double-click [Printer] in the selection
window. The registered printer list is
displayed in the list view of the details
window.

❹ Select the printer or printer group,
and then select the [Printer] menu >
[Properties].

 When the "Please enter the administrator
password of the printer" window is
displayed, enter the printer administrator
password, and click [OK].
Note!

For details on the factory set printer
administrator password, see the User's
Manual of the printer.

Memo

Multiple printers can be selected.

❺ In the [User] tab, click [Authentication
User].
The association between the User Name
registered to the printer and Job Account
ID is acquired and displayed in the
register list.

❻ Click [Remote Server].

 When a message showing that the
process was successful is displayed, click
[OK].

 Click [End].
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4. Job Account ID Management

❼ When the computer from which user

❾ Click [OK].

information is acquired is selected in
[Import Source], the acquired User Name
is displayed in the [User] list.

 Check that the User Name and Job
Account ID have been added to the
registration list.

 Click [Register].
Note!

• Register all associations between the
registration list User Names and Job
Account IDs.
• The associations deleted from the
registration list are also deleted from
the printer.

4

❽ Select the user name from the [User
Name] list, select the Job Account ID to
be associated from the [Job Account ID]
list and click [Add], and the User Name
and Job Account ID are added to the
[User] list.

 When the "Please enter the administrator
password of the printer" window is
displayed, enter the printer administrator
password, and click [OK].

 When a message showing that the
process was successful is displayed, click
[OK].

 Click [End].
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❼ Select the printer from which user

Importing from a different
printer
The associations of User Names and Job
Account IDs set in a printer can be copied
to a different printer.
Note!

information is acquired in [Import
Source] and click [Add], and the User
Names and Job Account IDs are added to
the [User] list.

❽ Click [OK].

If the associations between User Names
and Job Account IDs already registered
in the copy destination printer are
duplicated by those in the copy source
printer, the copy destination information
remains, and the associations of User
Names and Job Account IDs that are not
duplicated are added.

4

❶ Check that the printer power is ON.
❷ Start the server software.
❸ Double-click [Printer] in the selection
window. The registered printer list is
displayed in the list view of the details
window.

❹ Select the printer or printer group,
and then select the [Printer] menu >
[Properties].
Memo

Multiple printers can be selected.

❾ Check that the User Name and Job

❺ In the [User] tab, click [Authentication

Account ID have been added to the
registration list.

User].
The association between the user name
registered to the printer and Job Account
ID is acquired and displayed in the
register list.

 Click [Registration].
Note!

❺ Click [Other Printer].

• Register all associations between the
registration list user names and Job
Account IDs.
• The associations deleted from the
registration list are also deleted from
the printer.
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 When the "Please enter the administrator
password of the printer" window is
displayed, enter the printer administrator
password, and click [OK].

4
 When a message showing that the
process was successful is displayed, click
[OK].

 Click [End].
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5. Managing use restrictions

5. Managing use restrictions
This section explains how to manage use restrictions, such as adding or deleting use
restrictions to login names, application names, document names (URL), and host names
included in print jobs.

Setting use restrictions to
the login name

❺ Select [Manual] as the registration
method.

If required, use restrictions can be set to
the login name. Add the settings using one
of the following methods.

5

• Adding manually
• Adding from the log
•C
 reating a login name list file and adding
in a batch
 sers registered in Windows on the
•U
network are read

Adding manually

❻ Enter the login name that you want to
add settings to in the login name input
field.

❶ Check that the printer power is ON.
❷ Start the server software.
❸ Click the [Policy] menu > [Edit Policy].

❹ Click the [Login Name] tab.

❼ Select the use restrictions that you want
to use.
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Adding from the log

Enable Printing
Allows printing.

Use restrictions can be set to the login
names included in an acquired log.

Print in Mono
When color printing is executed, printing is output

Note!

in monochrome.

Disable Color Printing
Cancels color printing. If there is color data partway through a print job, all printing from that

Before going to the following, you need
to complete the procedures of “Export
job information in a file if this utility
acquires logs” (page 237).

❶ Check that the printer power is ON.
❷ Start the server software.

point onwards is cancelled.

Disable Printing

❸ Click the [Policy] menu > [Edit Policy].

Cancels printing.

❹ Click the [Login Name] tab.

❽ Click [Add] in the Policy field.

❺ Select [Log] as the registration method.

The added login name and use
restrictions are displayed in the [Policy
for Login Name] list.

❻ Select the login name that you want to
add settings from the list to.

❾ Click [Add] at the bottom of the window.

❼ Select the use restrictions that you want
to use.
Proceed to “Adding settings to printers”
(page 93).

Note!

If the "Adding settings to printers"
(page 93) steps are not executed, the
set use restrictions are not registered to
the printer.
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Creating a CSV file to add in
a batch

Enable Printing
Allows printing.

Print in Mono
When color printing is executed, printing is output
in monochrome.

You can create a CSV file that contains the
login names, and add settings to the login
names by importing the file.

❶ Create a CSV file using software such as

Disable Color Printing
Cancels color printing. If there is color data partway through a print job, all printing from that

Notepad or Excel etc.

<For Notepad>

point onwards is cancelled.

Disable Printing

5

Cancels printing.

❽ Click [Add] in the Policy field.
The added login name and use
restrictions are displayed in the [Policy
for Login Name] list.

①
②

Write 1 login name on each line.
Save in text format with the extension
"CSV".

<For Excel>

❾ Click [Add] at the bottom of the window.

Proceed to “Adding settings to printers”
(page 93).

Note!

If the "Adding settings to printers"
(page 93) steps are not executed, the
set use restrictions are not registered to
the printer.
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①
②

Write 1 login name on each line.
Save in CSV file format.

5. Managing use restrictions

❷ Start the server software.

Enable Printing

❸ Click the [Policy] menu > [Edit Policy].

Allows printing.

Print in Mono

❹ Click the [Login Name] tab.
❺ Select [File] as the registration method.

When color printing is executed, printing is output
in monochrome.

Disable Color Printing
Cancels color printing. If there is color data partway through a print job, all printing from that
point onwards is cancelled.

Disable Printing
Cancels printing.

❾ Click [Add] in the Policy field.
The added login name and use
restrictions are displayed in the [Policy
for Login Name] list.

❻ Click [Select File], specify the CSV file
that you created in step ①, and click
[Open].

❼ Select the login name that you want to
add settings from the list to.

 Click [Add] at the bottom of the window.

❽ Select the use restrictions that you want
to use.

Proceed to “Adding settings to printers”
(page 93).

Note!
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If the "Adding settings to printers"
(page 93) steps are not executed, the
set use restrictions are not registered to
the printer.

5

5. Managing use restrictions

Importing users registered in
Windows

❼ Select the computer from which the login
names are acquired.

User name information from Windows
specified on the network can be obtained
and registered as a batch to the server
software. Names that can be obtained
are accounts registered on the specified
computer.
Note!

5

• Access permission for the specified
computer is required.
• If the names of users that are already
registered to the printer and those
registered to the computer are
duplicated, the printer information is
not imported, and only names that are
not duplicated are added.

❽ Select the login name that you want to
add settings from the list to.

❶ Check that the printer power is ON.
❷ Start the server software.
❸ Click the [Policy] menu > [Edit Policy].
❹ Click the [Login Name] tab.
❺ Select [Server/Network] as the
registration method.

❾ Select the use restrictions that you want
to use.

❻ Click [Server].
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Adding unregistered item
settings

Enable Printing
Allows printing.

Print in Mono
When color printing is executed, printing is output

Use restrictions can be set for login names
that are not registered on the printer.

❶ Check that the printer power is ON.

in monochrome.

Disable Color Printing

❷ Start the server software.

Cancels color printing. If there is color data partway through a print job, all printing from that

❸ Click the [Policy] menu > [Edit Policy].
❹ Click the [Login Name] tab.

point onwards is cancelled.

Disable Printing

❺ Select the use restrictions that you want
to use.

Cancels printing.

 Click [Add] in the Policy field.
The added login name and use
restrictions are displayed in the [Policy
for Login Name] list.

Enable Printing
Allows printing.

Print in Mono

 Click [Add] at the bottom of the window.

When color printing is executed, printing is output
in monochrome.

Disable Color Printing
Cancels color printing. If there is color data partway through a print job, all printing from that
point onwards is cancelled.

Disable Printing
Cancels printing.

Proceed to “Adding settings to printers”
(page 93).

Note!

If the "Adding settings to printers"
(page 93) steps are not executed, the
set use restrictions are not registered to
the printer.
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5
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❻ Check the [Add Unregistered Item] check
box.
The [Other Login Names] and their use
restrictions are displayed in the [Policy
for Login Name] list.

Setting use restrictions to
the application name
If required, use restrictions can be set to
the application name. Add the settings
using one of the following methods.
• Adding manually
• Adding from the log

Adding manually
❶ Check that the printer power is ON.

5

❷ Start the server software.
❼ Click [Add] at the bottom of the window.

❸ Click the [Policy] menu > [Edit Policy].
❹ Click the [Application] tab.

❺ Enter the application name that you want

Proceed to “Adding settings to printers”

to add settings to in the application name
input field.

(page 93).

Note!

If the "Adding settings to printers"
(page 93) steps are not executed, the
set use restrictions are not registered to
the printer.
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❻ Select the use restrictions that you want

❽ Click [Add] at the bottom of the window.

to use.

Proceed to “Adding settings to printers”

Enable Printing

(page 93).

Allows printing.

Print in Mono
When color printing is executed, printing is output

Note!

in monochrome.

Disable Color Printing
Cancels color printing. If there is color data partway through a print job, all printing from that
point onwards is cancelled.

Disable Printing
Cancels printing.

❼ Click [Add] in the Policy field.
The added application name and use
restrictions are displayed in the [Policy
for Applications] list.
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If the "Adding settings to printers"
(page 93) steps are not executed, the
set use restrictions are not registered to
the printer.

5
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Adding from the log

Disable Color Printing

Use restrictions can be set to the
application names included in an acquired
log.
Note!

Before going to the following, you need
to complete the procedures of “Export
job information in a file if this utility
acquires logs” (page 237).

Cancels color printing. If there is color data partway through a print job, all printing from that
point onwards is cancelled.

Disable Printing
Cancels printing.

❼ Click [Add] in the Policy field.
The added application name and use
restrictions are displayed in the [Policy
for Applications] list.

❶ Check that the printer power is ON.
❷ Start the server software.

5

❸ Click the [Policy] menu > [Edit Policy].
❹ Click the [Application] tab.
❺ Select the application name that you
want to add settings from the list to.

❽ Click [Add] at the bottom of the window.

❻ Select the use restrictions that you want
to use.

Proceed to “Adding settings to printers”
(page 93).

Note!

Enable Printing
Allows printing.

Print in Mono
When color printing is executed, printing is output
in monochrome.
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If the "Adding settings to printers”
(page 93) steps are not executed, the
set use restrictions are not registered to
the printer.

5. Managing use restrictions

❻ Check the [Add Unregistered Item] check

Adding unregistered item
settings

box.
The [Other Applications] and use
restrictions are displayed in the [Policy
for Applications] list.

Use restrictions can be set for application
names that are not registered on the
printer.

❶ Check that the printer power is ON.
❷ Start the server software.
❸ Click the [Policy] menu > [Edit Policy].
❹ Click the [Application] tab.
❺ Select the use restrictions that you want

5

to use.

❼ Click [Add] at the bottom of the window.

Enable Printing
Allows printing.

Print in Mono

Proceed to “Adding settings to printers”
(page 93).

When color printing is executed, printing is output
in monochrome.

Disable Color Printing

Note!

Cancels color printing. If there is color data partway through a print job, all printing from that
point onwards is cancelled.

Disable Printing
Cancels printing.
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If the "Adding settings to printers”
(page 93) steps are not executed, the
set use restrictions are not registered to
the printer.

5. Managing use restrictions

Setting use restrictions to
the document name

❻ Select the use restrictions that you want
to use.

If required, use restrictions can be set
to the document name. Add the settings
using one of the following methods.
• Adding manually
• Adding from the log

Adding manually
❶ Check that the printer power is ON.

5

Enable Printing

❷ Start the server software.

Allows printing.

❸ Click the [Policy] menu > [Edit Policy].

Print in Mono

❹ Click the [Document] tab.

When color printing is executed, printing is output
in monochrome.

Disable Color Printing
Cancels color printing. If there is color data partway through a print job, all printing from that
point onwards is cancelled.

Disable Printing
Cancels printing.

❺ Enter the document name that you want

❼ Click [Add] in the Policy field.

to add settings to in the document name
input field.

Memo

* (Asterisk) can be used as a wild card
in the document name. However, items
that are just * or contain ** cannot be
registered.
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The added document name and use
restrictions are displayed in the [Policy
for Document Names/URLs] list.

5. Managing use restrictions

❽ Click [Add] at the bottom of the window.

Adding from the log
Use restrictions can be set to the document
names included in an acquired log.
Note!

Before going to the following, you need
to complete the procedures of “Export
job information in a file if this utility
acquires logs” (page 237).

❶ Check that the printer power is ON.
❷ Start the server software.
❸ Click the [Policy] menu > [Edit Policy].
❹ Click the [Document] tab.

Proceed to “Adding settings to printers”

❺ Select the document name that you want

(page 93).

to add settings from the list to.
Note!

If the "Adding settings to printers”
(page 93) steps are not executed, the
set use restrictions are not registered to
the printer.

❻ Select the use restrictions that you want
to use.

Enable Printing
Allows printing.

Print in Mono
When color printing is executed, printing is output
in monochrome.

Disable Color Printing
Cancels color printing. If there is color data partway through a print job, all printing from that
point onwards is cancelled.

Disable Printing
Cancels printing.
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❼ Click [Add] in the Policy field.

Adding unregistered item
settings

The added document name and use
restrictions are displayed in the [Policy
for Document Names/URLs] list.

Use restrictions can be set for document
names that are not registered on the
printer.

❶ Check that the printer power is ON.
❷ Start the server software.
❸ Click the [Policy] menu > [Edit Policy].
❹ Click the [Document] tab.
❺ Select the use restrictions that you want

5

to use.

❽ Click [Add] at the bottom of the window.

Enable Printing
Allows printing.

Proceed to “Adding settings to printers”

Print in Mono

(page 93).

When color printing is executed, printing is output
Note!

If the "Adding settings to printers”
(page 93) steps are not executed, the
set use restrictions are not registered to
the printer.

in monochrome.

Disable Color Printing
Cancels color printing. If there is color data partway through a print job, all printing from that
point onwards is cancelled.

Disable Printing
Cancels printing.
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❻ Check the [Add Unregistered Item] check
box.
The [Other URLs] and use restrictions
are displayed in the [Policy for Document
Names/URLs] list.

Setting use restrictions to
the host name
If required, use restrictions can be set to
the host name.
Add the settings using one of the following
methods.
• Adding manually
• Adding from the log

Adding manually
❶ Check that the printer power is ON.
❷ Start the server software.
❼ Click [Add] at the bottom of the window.

❸ Click the [Policy] menu > [Edit Policy].
❹ Click the [Host] tab.

Proceed to “Adding settings to printers”

❺ Enter the host name that you want to add

(page 93).

Note!

settings to in the host name input field.

If the "Adding settings to printers”
(page 93) steps are not executed, the
set use restrictions are not registered to
the printer.
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5
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❻ Select the use restrictions that you want

❽ Click [Add] at the bottom of the window.

to use.

5

Proceed to “Adding settings to printers”

Enable Printing

(page 93).

Allows printing.

Print in Mono
When color printing is executed, printing is output

Note!

in monochrome.

Disable Color Printing
Cancels color printing. If there is color data partway through a print job, all printing from that
point onwards is cancelled.

Disable Printing
Cancels printing.

❼ Click [Add] in the Policy field.
The added host name and use restrictions
are displayed in the [Policy for Host
Names] list.
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If the "Adding settings to printers”
(page 93) steps are not executed, the
set use restrictions are not registered to
the printer.

5. Managing use restrictions

❼ Click [Add] in the Policy field.

Adding from the log

The added host name and use restrictions
are displayed in the [Policy for Host
Names] list.

Use restrictions can be set to the document
names included in an acquired log.
Note!

Before going to the following, you need
to complete the procedures of “Export
job information in a file if this utility
acquires logs” (page 237).

❶ Check that the printer power is ON.
❷ Start the server software.
❸ Click the [Policy] menu > [Edit Policy].
❹ Click the [Host] tab.

5

❺ Select the host name that you want to

❽ Click [Add] at the bottom of the window.

add settings from the list to.

❻ Select the use restrictions that you want

Proceed to “Adding settings to printers”

to use.

(page 93).

Note!

Enable Printing
Allows printing.

Print in Mono
When color printing is executed, printing is output
in monochrome.

Disable Color Printing
Cancels color printing. If there is color data partway through a print job, all printing from that
point onwards is cancelled.

Disable Printing
Cancels printing.
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If the "Adding settings to printers”
(page 93) steps are not executed, the
set use restrictions are not registered to
the printer.

5. Managing use restrictions

❻ Check the [Add Unregistered Item] check

Adding unregistered item
settings

box.
The [Other Host Names] and use
restrictions are displayed in the [Policy
for Host Names] list.

Use restrictions can be set for host names
that are not registered on the printer.

❶ Check that the printer power is ON.
❷ Start the server software.
❸ Click the [Policy] menu > [Edit Policy].
❹ Click the [Host] tab.
❺ Select the use restrictions that you want

5

to use.

❼ Click [Add] at the bottom of the window.

Enable Printing
Allows printing.

Print in Mono
Proceed to “Adding settings to printers”

When color printing is executed, printing is output

(page 93).

in monochrome.

Disable Color Printing
Cancels color printing. If there is color data part-

Note!

way through a print job, all printing from that
point onwards is cancelled.

Disable Printing
Cancels printing.
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If the "Adding settings to printers”
(page 93) steps are not executed, the
set use restrictions are not registered to
the printer.

5. Managing use restrictions

Adding settings to
printers

Displaying use restrictions
that are already
registered in printers

The set use restrictions can be added to
the printer.
Note!

The use restrictions of items that are
already registered and exist in the
printer are changed.

❶ The use restrictions that are already
registered in printers can be displayed.

❷ Check that the printer power is ON.
❸ Start the server software.

❶ Select the printer that you want to add
use restrictions to, and click [Add].
Printers that can have use restrictions
added are displayed in the [Selected
Printer] list. To add use restrictions to all
of the printers, click [Add All]. To exclude
printers from having use restrictions
added, select the printer in the displayed
[Selected Printer] list, and click [Delete].

❹ Click the [Policy] menu > [Edit Policy].
❺ Select the printer, and click [Acquire
Policy].

❻ The registered use restrictions are
displayed in the use restriction lists in
each of the [Login Name], [Application],
[Document] and [Host] tabs.

❷ Click [Apply].

❸ When the administrator password window
is displayed, enter the administrator
password and click [OK].
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5
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Deleting use restrictions

❼ Click [Update] at the bottom of the
window.

Use restrictions that are registered in
printers can be deleted.

❶ Check that the printer power is ON.
❷ Start the server software.
❸ Click the [Policy] menu > [Edit Policy].
❹ Select the printer, and click [Acquire
Policy].

❽ Select the printer that you want to delete

5

use restrictions from, and click [Add].
Printers that can have use restrictions
deleted are displayed in the [Selected
Printer] list. To delete use restrictions
from all of the printers, click [Add All].
To exclude printers from having use
restrictions deleted, select the printer in
the displayed [Selected Printer] list, and
click [Delete].

❺ The registered use restrictions are
displayed in the use restriction lists in
each of the [Login Name], [Application],
[Document] and [Host] tabs.

❻ Select the use restriction that you want
to delete from the user restriction list,
and click [Delete]. The use restriction
display is deleted from the use restriction
list.

❾ Click [Apply].
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 When the administrator password window
is displayed, enter the administrator
password and click [OK].
Note!

Changing use restrictions
Use restrictions that are registered in
printers can be changed.

Unregistered items such
as OtherLoginNames,
OtherApplicationNames, OtherURLs, and
OtherHostNames cannot be deleted.

❶ Check that the printer power is ON.
❷ Start the server software.
❸ Click the [Policy] menu > [Edit Policy].
❹ Select the printer, and click [Acquire
Policy].

5

❺ The registered use restrictions are
displayed in the use restriction lists in
each of the [Login Name], [Application],
[Document] and [Host] tabs.

❻ Select the Name of the use restrictions
that you want to change from the
use restriction list, and select the use
restriction.

Enable Printing
Allows printing.

Print in Mono
When color printing is executed, printing is output
in monochrome.

Disable Color Printing
Cancels color printing. If there is color data partway through a print job, all printing from that
point onwards is cancelled.
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 Click [Apply].

Disable Printing
Cancels printing.

❼ Click [Change]. The changed use
restrictions are displayed in the use
restrictions list.

	When the administrator password window

5

is displayed, enter the administrator
password and click [OK].

❽ Click [Update] at the bottom of the
window.

❾ Select the printer that you want to
change the use restrictions for, and
click [Add]. Printers that can have use
restrictions changed are displayed in the
[Selected Printer] list. To change use
restrictions for all of the printers, click
[Add All]. To exclude printers from having
use restrictions changed, select the
printer in the displayed [Selected Printer]
list, and click [Delete].
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❻ When the administrator password window

Deleting all use
restrictions

is displayed, enter the administrator
password and click [OK].

All of the use restrictions set for the Login
Name, Application Name, Document Name
and Host Name can be deleted.

❶ Check that the printer power is ON.
❷ Start the server software.
❸ Click the [Policy] menu > [Delete All
Policy].

5

❹ Select the printer that you want to delete
all of the use restrictions from, and click
[Add]. Printers that can have all use
restrictions deleted are displayed in the
[Selected Printer] list. To delete all use
restrictions from all of the printers, click
[Add All]. To exclude printers from having
all use restrictions deleted, select the
printer in the displayed [Selected Printer]
list, and click [Delete].

❺ Click [Apply].
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Temporarily disabling use
restrictions

❺ Click [Apply].

Use restrictions can be temporarily
disabled. The use restrictions set for the
Job Account ID for printing jobs from a PC
are also disabled.

❶ Check that the printer power is ON.
❷ Start the server software.
❸ Click the [Policy] menu > [Disable

5

Policy].

❻ When the administrator password window
is displayed, enter the administrator
password and click [OK].

❹ Select the printer whose use restrictions
you temporarily want to disable, and
click [Add]. Printers that can have use
restrictions temporarily disabled are
displayed in the [Selected Printer] list. To
temporarily disable use restrictions for all
of the printers, click [Add All]. To exclude
printers from having use restrictions
temporarily disabled, select the printer in
the displayed [Selected Printer] list, and
click [Delete].

- 98 -

5. Managing use restrictions

Enabling use restrictions

❺ Click [Apply].

Use restrictions that were temporarily
disabled can be enabled again.

❶ Check that the printer power is ON.
❷ Start the server software.
❸ Click the [Policy] menu > [Enable Policy].

❻ When the administrator password window
❹ Select the printer whose use restrictions
you want to enable again, and click
[Add]. Printers that can have use
restrictions enabled again are displayed
in the [Selected Printer] list. To enable
use restrictions again for all of the
printers, click [Add All]. To exclude
printers from having use restrictions
enabled again, select the printer in the
displayed [Selected Printer] list, and click
[Delete].
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is displayed, enter the administrator
password and click [OK].

5

5. Managing use restrictions

Memo

5
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6. Syncing with Active Directory User Information

6. Syncing with Active Directory User
Information
This section explains how to add or delete use restrictions or change settings for user
information managed by Active Directory, and how to sync with Active Directory user
information.

Setting the printer to
be linked with Active
Directory

❹ Click the [Option] tab > [Detail setting].

❶ Start the server software.

6

❷ Double-click [Printer] in the selection
window. The registered printer list is
displayed in the details window.

❸ Select the printer, and then select the
[Printer] menu > [Properties].
Memo

❺ Check the [Synchronize user list with
Active Directory] check box.

Multiple printers can be selected.

❻ Select [Policy based printing].
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❾ If the settings for creating an IC card

User is identified by Job Account ID
Print restrictions from a registered user PC are
set in the Job Account ID. For jobs from PCs, the
Job Account ID needs to be set in advance in the
client software driver of the print source PC.

User is identified by PC Login name/card
Print restrictions from an unregistered user PC
are set in the login name. The client software
does not need to be installed in the print source
PC.

❼ Click [OK].

compatibility table are not set, a message
notifying that the IC card compatibility
table cannot be registered to the printer
is displayed. Click [OK].
In order to register an IC card
compatibility table to the printer,
the settings for creating an IC card
compatibility table need to be configured.
For details on the settings required for
creating an IC card compatibility table,
see "Creating an IC card compatibility
table" (page 133).

 When the window notifying the changes
to setting items is displayed, click [Yes].

6

❽ Click [OK] at the bottom of the window.

 When the window notifying that
the setting changes are complete is
displayed, click [Close].

 When the [Login name/Group name
which synchronizes with Active Directory]
is displayed, configure the Active
Directory settings. For details, see page
104.
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❸ Click [Add] in the [Active Directory User/

Configuring the Active
Directory settings

Group Settings].

Configure the connection destination and
other such settings for the Active Directory
that is linked to the server software.
Connecting to the currently logged-on
Active Directory

❶ Click [Policy] menu > [User Registration
on Active Directory].

6
❷ Click [Setup] in the [Login name/Group
name which synchronizes with Active
Directory] window.

❹ Click [Options] in the [Active Directory
Search].

❺ Check the [Set Up Active Directory] tab
in [Search the currently logged on Active
Directory].
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❻ To change the port number to which

❽ To search for users that have locked

Active Directory connects, enter the [Port
Number]. The range of the port number
is from 1-65535.

❼ To change the search target, enter [Base

accounts, check the [Search for locked
users] check box.

❾ Click [OK].

DN]. An example input when the domain
name is [domain.local] is shown below.
When there is no OU: CN=Users,
DC=domain, DC=local
When OU is specified: OU=OU name,
DC=domain, DC=local
If these values are not entered, the
search is made based on DC=domain,
DC=local.

Memo

When OU is specified, the time required
to complete the search can be reduced.
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❹ Click [Options] in the [Active Directory

Connecting to an Active
Directory in a specified
domain

Search].

❶ Click [Policy] menu > [User Registration
on Active Directory].

❷ Click [Setup] in the [Login name/Group

6

name which synchronizes with Active
Directory] window.

❺ Uncheck the [Set Up Active Directory] tab
in [Search the currently logged on Active
Directory].

❸ Click [Add] in the [Active Directory User/
Group Settings].

❻ Enter the [Domain Name], [Logon Name]
and [Password].

Domain Name
Enter the Active Directory domain name for
searching for the user and group.

Logon Name
Enter the user name for logging on to the Active
Directory.
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❾ To search for users that have locked

Password
Enter the password for logging on to the Active
Directory.

accounts, check the [Search for locked
users] check box.

❼ To change the port number to which
Active Directory connects, enter the [Port
Number]. The range of the port number
is from 1-65535.

 Click [OK].

6
❽ To change the search target, enter [Base
DN]. An example input when the domain
name is [domain.local] is shown below.
When there is no OU: CN=Users,
DC=domain, DC=local
When OU is specified: OU=OU name,
DC=domain, DC=local
If these values are not entered, the
search is made based on DC=domain,
DC=local.

Memo

The search time can be reduced by
specifying the OU because the search is
only performed within the specified OU.
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❹ Click [Options] in the [Active Directory

To add attributes to the
displayed user list

Search].

❶ Click [Policy] menu > [User Registration
on Active Directory].

❷ Click [Setup] in the [Login name/Group
name which synchronizes with Active
Directory] window.

6

❺ Select the items that you want to display
in the [Choose Columns] tab > [Viewable
Column], and click [Add].

❸ Click [Add] in the [Active Directory User/
Group Settings].

❻ Click [OK].
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To hide attributes in the user
list

❹ Click [Options] in the [Active Directory
Search].

❶ Click [Policy] menu > [User Registration
on Active Directory].

❷ Click [Setup] in the [Login name/Group
name which synchronizes with Active
Directory] window.

❺ Display the [Choose Columns] tab.
❻ Select the items that you want to hide in
[Column to View], and click [Remove].

❸ Click [Add] in the [Active Directory User/
Group Settings].

❼ Click [OK].
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To change the order of
attributes displayed in the
user list

❹ Click [Options] in the [Active Directory
Search].

❶ Click [Policy] menu > [User Registration
on Active Directory].

❷ Click [Setup] in the [Login name/Group

6

name which synchronizes with Active
Directory] window.

❺ Display the [Choose Columns] tab.
❻ Select the items that you want to change
the order of in [Column to View], and
click [Up] or [Down].

❸ Click [Add] in the [Active Directory User/
Group Settings].

❼ Click [OK].
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Specifying attributes for
obtaining IC card information

❸ Click [Add] in the [Active Directory User/
Group Settings].

IC card information (card ID) registered
in the Active Directory attributes can be
obtained, and the IC card compatibility
table can be added when an Active
Directory user is added. This setting
requires the IC card compatibility table to
be registered to the printer.

❶ Click [Policy] menu > [User Registration
on Active Directory].

6
❷ Click [Setup] in the [Login name/Group
name which synchronizes with Active
Directory] window.

❹ Click [Options] in the [Active Directory
Search].

❺ Display the [IC Card] tab.
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❻ Check the [Gets IC card information
from Active Directory] check box, and
enter the name of the attribute in which
IC card information stored by the Active
Directory in [Attribute].

Adding an Active Directory
user
Search for the user or group from the
Active Directory, and use restrictions or
limit values can be set.

Searching for users
❶ Start the server software.
❷ Click [Policy] menu > [User Registration
on Active Directory].

6

❼ Click [OK].

❸ Click [Setup] in the [Login name/Group
name which synchronizes with Active
Directory] window.

Memo

Note!

The Active Directory attribute name
that you created yourself can also be
specified.
• Primary attribute items such as "cn"
cannot be used as attributes for IC
card information.
• If an invalid attribute name is
specified, IC card information cannot
be obtained.
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❹ Click [Add] in the [Active Directory User/
Group Settings].

Description
Enter the character string that you want to search
the Active Direction explanation for. Items that
match the beginning of the entered character
string are displayed. If a character string has
been entered into the [Name] column, items that
match both are displayed.

Type
Select the Active Directory search target. Groups
or users can be set as search targets.
Memo

• If the [Start Search] button is clicked
when the [Name] and [Description]
sections are blank, the search is
performed for all users or groups.
• "*" can be entered as a wild card
for [Name] and [Description]. "*"
represents more than 0 character
strings.

❻ The groups or users are displayed in the
❺ Enter the search conditions into the
[Active Directory Search] window, and
click [Start Search]. To stop the search,
click [Stop].

Note!

The search cannot be performed
unless the Active Directory connection
destination is set. For details on
setting the Active Directory connection
destination, see page 106.

Name
Enter the character string that you want to search
from the Active Directory display name, surname,
name, and Name. Items that match the beginning
of the entered character string are displayed. If
items have been entered into the [Description]
column, items that match both are displayed.

[Active Directory Search] window.
To set use restrictions or limit values,
select the group or user and click
[Settings].

When setting use restrictions or limit
values for groups, the same use
restrictions are set for the users that
belong to that group. However, use
restrictions or limit values can also be set
for specific users or groups that belong to
the group.
•T
 o set use restrictions or limit values for
groups or users, proceed to "Setting use
restrictions or limit values" (page 114).
•T
 o set use restrictions or limit values
for specific users or groups that belong
to groups, proceed to "Referencing
members that belong to groups"
(page 114).

- 113 -

6

6. Syncing with Active Directory User Information

Referencing members that
belong to groups
Use restrictions or limit values can also be
set for specific users or groups that belong
to the group.

Setting use restrictions or
limit values
❶ Set the use restrictions in the [Use
Restrictions] tab.

❶ Select a group from those displayed in
the [Active Directory Search] window,
and click [Member Reference].

6
Disable Printing
Cancels printing.

Disable Color Printing

❷ Users that belong to the group are
searched. To stop the search, click
[Stop]. To search the users that belong to
the group again, click [Re-search].

Cancels color printing. If there is color data partway through a print job, all printing from that
point onwards is cancelled.

Print in Mono
When Disable Color Printing is set, monochrome
printing is performed without cancelling color
data.

Disable Copying
Copying using panel operations is prohibited.
When this is disabled, the Disable Printing
settings are followed.

❸ Select a group or user displayed in the
[List of Members Belonging to Selected
Group] window, and click [Settings].

Disable Color Copying
Color copying using panel operations is
prohibited. When this is disabled, the Disable
Color Printing settings are followed.

Disable USB Memory to Print
Prohibits printing from a USB memory using
panel operations.

Disable USB Memory to Color Print
Prohibits color printing from a USB memory using
panel operations.
Proceed to "Setting use restrictions or limit
values" (page 114).

Disable Scan to Email
Prohibits Scan to Email using panel operations.
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Disable Scan to Network PC /
Disable Scan to Shared Folder

exceeds the limit value is cancelled.

❷ Set the limit values in the [Limit Values]

Prohibits Scan to Network PC and Scan to Shared
Folder using panel operations.

tab.
When each of the limit values is
exceeded, printing is cancelled until the
valid period set in step ❾.

Disable Scan to USB Memory
Prohibits Scan to USB memory using panel
operations.

Disable Fax Sending
Fax sending using panel operations is prohibited.
Fax sending that uses the fax driver is also
cancelled.

Disable Scan to Internet Fax
Prohibits scan to internet fax using panel

6

operations.

Disable Scan to Fax Server
Prohibits scan to fax server using panel
operations.

Note!

Notifies total result by e-mail
Notifies the total amount used every month by
e-mail.

Notifies by e-mail when Limit Values was
exceeded
A mail notification is sent when the print quantity
exceeds the limit value and printing is no longer
possible, and when the limit value is reset and
printing is made possible again.

Do not process Limit Value as a group
Limit values can be set individually for printer

The limit value settings are enabled
from the point at which the server
software obtains the log when the limit
value has been exceeded. Printing can
still be performed when the limit value
is exceeded until the server software
receives the log.

Printed Sheets
Set the number of sheets that can be printed.

Fees
Set the upper limit of the fee charges.

Staple

users that belong to a printer group, and users

When the optional finisher is installed, set the

that belong to a user group. When [Do not

number of times that the stapler can be used.

process Limit Value as a group] is unchecked, if
the total amount used by users that belong to the

If the limit value was set, proceed to step

group exceeds the specified limit value, printing

If the limit value was not set, proceed to

of all users that belong to the group is cancelled.

step

When [Do not process Limit Value as a group] is
checked, if the total amount used by users that
belong to the group exceeds the specified limit
value, printing of the users whose print total
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❸ Set the valid period for the limit value set
in step ❽.

❹ Click [OK].

Note!

6

When the valid period is exceeded, the
limit value count is reset.

Do not specify
The valid period is not set. When the limit
value set in

❽ is not set, printing is cancelled

unless the limit value is increased, or the usage
conditions are manually reset.

By month
Set the valid period in month units. Set the
number of months and base date (10th, 20th,
end of month, deadline).

By week
Set the valid period in week units. Set the
number of weeks and base day.

By day
Set the valid period in day units. The number of
days is set.

Carry over unused value to the next valid
period
Check to carry over the amount that is not used
within the valid period to the next period.
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• The use restrictions for users that
belong to multiple groups are all
set to prohibited when the multiple
groups are set to prohibited. Printing
and copying etc, are set to printing
(copying) available, Print in Mono,
color printing (copying) unavailable,
and printing (copying) unavailable in
this priority order.
• The limit values are taken as those
from the group with the highest
priority level. To change the priority
of groups, see "Changing the priority
level of groups" (page 122).
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Copying user settings from
other groups
The settings of groups or users whose use
restrictions or limit values are completed
can be copied to other groups or users.

Applying settings to the
printer
Memo

❶ Select the copy destination group or user
in the Active Directory Search window.

The following steps apply to all users
registered in the steps from page 102
to page 116. These can be changed for
each user later.

❶ Click [End] in the [Active Directory
Search] window.

6

❷ Click [Copy Setting].
❷ Click [End] in the [Active Directory User/
Group Settings] window.

❸ Select the group or user whose settings
are to be copied, and click [OK].
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❸ When the [Assign Job Account ID]

❻ When the administrator password window

window is displayed, assign a Job Account
ID to users that currently do not have a
Job Account ID assigned, and click [OK].
For details on how to assign Job Account
IDs, see "Assigning a Job Account ID to
an Active Directory user" (page 125).

is displayed, enter the administrator
password and click [OK].

❼ When the settings for registering the IC
card compatibility table to the printer are
enabled, a window inquiring whether or
not to register the IC card compatibility
table to the printer is displayed. Click
[Yes] to send the IC card compatibility
table to the printer, or [No] to not send
the IC card compatibility table to the
printer.

6

❹ Click [Apply] in the [Login name/Group
name which synchronizes with Active
Directory] window.

❺ When the confirmation window appears
confirming whether or not to apply use
restrictions to the printer, click [OK].
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Changing Active Directory
user settings

❹ Select the user in the [Active Directory
User/Group Settings] window, and click
[Change].

The use restrictions or limit values set to
the Active Directory users or groups can be
changed.
Changing use restrictions or limit values

❶ Start the server software.
❷ Click [Policy] menu > [User Registration
on Active Directory].

6
❸ Click [Setup] in the [Login name/Group
name which synchronizes with Active
Directory] window.

❺ Set the use restrictions in the [Use
Restrictions] tab.

Disable Printing
Cancels printing.

Disable Color Printing
Cancels color printing. If there is color data partway through a print job, all printing from that
point onwards is cancelled.

Print in Mono
When Disable Color Printing is set, monochrome
printing is performed without cancelling color
data.
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Disable Copying

Do not process Limit Value as a group

Copying using panel operations is prohibited.

Limit values can be set individually for printer

When this is disabled, the printing prohibited

users that belong to a printer group, and users

settings are applied.

that belong to a user group. When [Do not
process Limit Value as a group] is unchecked, if

Disable Color Copying

the total amount used by users that belong to the

Color copying using panel operations is
prohibited. When this is disabled, the Disable
Color Printing settings are followed.

of all users that belong to the group is cancelled.
When [Do not process Limit Value as a group] is
checked, if the total amount used by users that

Disable USB Memory to Print

belong to the group exceeds the specified limit

Prohibits printing from a USB memory using

value, printing of the users whose print total

panel operations.

exceeds the limit value is cancelled.

❻ Set the limit values in the [Limit Values]

Disable USB Memory to Color Print

6

group exceeds the specified limit value, printing

Prohibits color printing from a USB memory using

tab.

panel operations.

Disable Scan to Email
Prohibits Scan to Email using panel operations.

Disable Scan to Network PC /
Disable Scan to Shared Folder
Prohibits Scan to Network PC and Scan to Shared
Folder using panel operations.

Disable Scan to USB Memory
Prohibits Scan to USB memory using panel
operations.

Disable Fax Sending
Fax sending using panel operations is prohibited.
Fax sending that uses the fax driver is also
cancelled.

When each of the limit values is
exceeded, printing is cancelled until the
valid period set in step ❾.
Note!

Disable Scan to Internet Fax
Prohibits scan to internet fax using panel
operations.

Disable Scan to Fax Server
Prohibits scan to fax server using panel

Printed Sheets

operations.

Set the number of sheets that can be printed.

Notifies total result by e-mail
Notifies the total amount used every month by
e-mail.

Fees
Set the upper limit of the fee charges.

Notifies by e-mail when Limit Values was
exceeded
A mail notification is sent when the print quantity
exceeds the limit value and printing is no longer
possible, and when the limit value is reset and
printing is made possible again.

The limit value settings are enabled
from the point at which the server
software obtains the log when the limit
value has been exceeded. Printing can
still be performed when the limit value
is exceeded until the server software
receives the log.

Staple
When the optional finisher is installed, set the
number of times that the stapler can be used.
If the limit value was set, proceed to step
If the limit value was not set, proceed to
step
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❼ Set the valid period for the limit value set
in step ❻.

❽ Click [OK].

Note!

When the valid period is exceeded, the
limit value count is reset.

Do not specify
The valid period is not set. When the limit
value set in

❽ is not set, printing is cancelled

unless the limit value is increased, or the usage
conditions are manually reset.

By month
Set the valid period in month units. Set the
number of months and base date (10th, 20th,
end of month, deadline).

By week
Set the valid period in week units. Set the
number of weeks and base day.

By day
Set the valid period in day units. The number of
days is set.

Carry over unused value to the next valid
period
Check to carry over the amount that is not used
within the valid period to the next period.
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• The use restrictions for users that
belong to multiple groups are all
set to prohibited when the multiple
groups are set to prohibited. Printing
and copying etc, are set to printing
(copying) available, Print in Mono,
color printing (copying) unavailable,
and printing (copying) unavailable in
this priority order.
• The limit values are taken as those
from the group with the highest
priority level. To change the priority
of groups, see "Changing the priority
level of groups" (page 122).

6
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Changing the priority level of
groups
When users that are set with use
restrictions or limit values belong to
multiple groups, the priority level at which
group use restrictions or limit values are
applied to users can be changed. The use
restrictions or limit values of the highest
priority level group are assigned to the
user.

❹ Select the user in the [Active Directory
User/Group Settings] window, and click
[Change].

❶ Start the server software.
❷ Click [Policy] menu > [User Registration
on Active Directory].

6

❸ Click [Setup] in the [Login name/Group
name which synchronizes with Active
Directory] window.

❺ Click the [Limit Values] tab > [Set
Priorities].
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❻ Select the group whose priority you want
to change in the [Set Priorities] window,
and click [Up] or [Down].

Applying settings to the
printer
❶ Click [Apply] in the [Login name/Group
name which synchronizes with Active
Directory] window.

6
❼ Click [OK].

❷ When the confirmation window appears
confirming whether or not to apply use
restrictions to the printer, click [OK].

❸ When the administrator password window
is displayed, enter the administrator
password and click [OK].

❹ When the settings for registering the IC

Note!

The priority order settings are applied to
all users that belong to the group.

card compatibility table to the printer are
enabled, a window inquiring whether or
not to register the IC card compatibility
table to the printer is displayed. Click
[Yes] to send the IC card compatibility
table to the printer, or [No] to not send
the IC card compatibility table to the
printer.
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❹ Select the user in the [Active Directory

Deleting an Active
Directory user

User/Group Settings] window, and click
[Remove].

The use restrictions or limit values set to
the Active Directory users or groups can be
deleted.

❶ Start the server software.
❷ Click [Policy] menu > [User Registration
on Active Directory].

6

❸ Click [Setup] in the [Login name/Group
name which synchronizes with Active
Directory] window.

❺ When the user delete confirmation
window is displayed, click [Yes].

❻ Click [End].
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❼ Click [Apply] in the [Login name/Group
name which synchronizes with Active
Directory] window.

Assigning a Job Account
ID to an Active Directory
user
Active Directory users that are set with
use restrictions or limit values must be
assigned with a unique Job Account ID.
There are two methods for assigning a Job
Account ID to an Active Directory user that
is set with use restrictions or limit values,
which is done when the user is added
to the Active Directory. These are the
automatic method or the manual method.

❽ When the confirmation window appears
confirming whether or not to apply use
restrictions to the printer, click [OK].

❾ When the administrator password window
is displayed, enter the administrator
password and click [OK].

 When the settings for registering the IC
card compatibility table to the printer are
enabled, a window inquiring whether or
not to register the IC card compatibility
table to the printer is displayed. Click
[Yes] to send the IC card compatibility
table to the printer, or [No] to not send
the IC card compatibility table to the
printer.

Automatically assigning a
Job Account ID
When the setting for automatically
assigning the Job Account ID is enabled,
a unique Job Account ID can be
automatically assigned to a user when the
user is added to the Active Directory.

❶ Start the server software.
❷ Click [Policy] menu > [User Registration
on Active Directory].

❸ In the [Login name/Group name which
synchronizes with Active Directory]
window, check the [Auto Assign Job
Account ID] check box.
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❸ Select the user to assign the Job Account

Manually assigning a Job
Account ID

ID to in [User], and click [Change].

When [Auto Assign Job Account ID] in
the [Login name/Group name which
synchronizes with Active Directory] window
is disabled, the [Assign Job Account ID]
window is displayed when a user is added
to the Active Directory. A unique Job
Account ID can be assigned manually to
the user.

❶ Check the [Only display non-assigned
login name] check box.

6
❹ Click [OK].

❷ Enter the Job Account ID to be assigned
in the [Job Account ID] column.

Note!
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These settings are not reflected in
the printer until [Apply] in the [User
Registration on Active Directory]
window that appears after step ❾ is
clicked.

6. Syncing with Active Directory User Information

Assigning a Job Account ID
from a file

<For Excel>

When [Auto Assign Job Account ID] in
the [Login name/Group name which
synchronizes with Active Directory] window
is disabled, the [Assign Job Account ID]
window is displayed when a user is added
to the Active Directory. A Job Account ID
can be assigned to the user by creating
a CSV file that contains the user name
and Job Account ID, and then reading the
created CSV file.
Note!

• Assignment of the Job Account ID is
only available for users that are added
from the Active Directory.
• If a Job Account ID is already assigned
to the user, the file contents are
overwritten.

6

❶ Create a CSV file using software such as
Notepad or Excel etc.

① Write 1 login name on each line.
② Save in CSV file format.

<For Notepad>

❷ Check the [Only display non-assigned
login name] check box.

①
②

Write 1 login name on each line.
Save in text format with the extension
"CSV".
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❸ Click [File].

❻ Click [OK].

6
❹ Specify the CSV file created in ❶, and

Note!

click [Open].

❺ Check that the Job Account ID is
displayed in [User].
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These settings are not reflected in
the printer until [Apply] in the [User
Registration on Active Directory]
window that appears after step ❻ is
clicked.
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Changing the assigned Job
Account ID

❺ Select the user whose Job Account ID is
to be changed in [User].

❶ Start the server software.
❷ Click [Policy] menu > [User Registration
on Active Directory].

❸ Click [Assign] in the [Login name/Group
name which synchronizes with Active
Directory] window.

6
❻ Change the entry in [Job Account ID],
and click [Change].

❹ Uncheck the [Only display non-assigned
login name] check box.
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❼ Click [OK].

Exporting data for client
software
Users added from Active Directory can be
used in the client software hidden mode.
For details on the client software hidden
mode, see "Setting Job Accounting Mode"
(page 41).

❶ Start the server software.
❷ Click [Policy] menu > [User Registration
on Active Directory].

6
Note!

These settings are not reflected in
the printer until [Apply] in the [User
Registration on Active Directory]
window that appears after step ❼ is
clicked.

❸ Click [Export Users].

❹ Check the [For Client reference] check
box, and click [Browse].
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❺ Select the folder that you want to save,
and click [OK].

❻ Click [OK] in the [Export Users] window.

Exporting the IC card
compatibility table
The IC card compatibility table associates
three types of data, namely the IC card
information (card ID), Job Account ID, and
login name. When the IC card compatibility
table is registered to the printer, the use
restrictions assigned to the Job Account
ID or login name can be applied to the IC
card authentication print job. In order to
register the IC card compatibility table with
the printer, all of the following conditions
need to be fulfilled.
•A
 n SD card for receiving the IC card
compatibility table is installed in the
printer
• The printer power is ON

❼ A file named opjobac4.dat is generated
in the folder selected in ❺, and the
generated file can be specified in the
[Hidden mode] of the client software.
For details on specifying the export file
for the client software, see "Acquiring
user information from files in hide mode"
(page 219).

•T
 he IC card compatibility table
registration settings in the printer
in which you want to register the IC
card compatibility table are enabled
(page 131)
•T
 he settings for creating an IC card
compatibility table are enabled
(page 133)

Setting the printer to which
the IC card compatibility
table is registered
Enable the IC card compatibility table
registration settings in the printer in
which you want to register the IC card
compatibility table.

❶ Check that the printer power is ON.
❷ Start the server software.
❸ Double-click [Printer] in the selection
window. The registered printer list is
displayed in the details window.
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❹ Select the printer, and then select the

❼ Check the [Download enrolled card table

[Printer] menu > [Properties].
Memo

to a printer] check box.

Multiple printers can be selected.

❽ Click [OK].

6

❺ Click the [Option] tab > [Detail setting].

❾ Click the [Option] tab > [OK].

❻ Check the [Synchronize user list with
Active Directory] check box.
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 If the settings for creating an IC card
compatibility table are not set, a message
notifying that the IC card compatibility
table cannot be registered to the printer
is displayed. Click [OK]. In order to
register an IC card compatibility table
to the printer, the settings for creating
an IC card compatibility table need
to be configured. For details on the
settings required for creating an IC card
compatibility table, see "Creating an IC
card compatibility table" (page 133).

Creating an IC card
compatibility table
The IC card compatibility table is created
based on Active Directory user information
that has already been registered.

❶ Start the server software.
❷ Click [Policy] menu > [User Registration
on Active Directory].

 When the window notifying the changed
setting items is displayed, click [Yes].

❸ Click [Export Users].

 When the window notifying that
the setting changes are complete is
displayed, click [Close].

❹ Check the [Create card table] check box,

 When the [Login name/Group name
which synchronizes with Active Directory]
is displayed, configure the Active
Directory settings. For details, see page
104.

and click [Browse].

❺ Select the folder that you want to save,
and click [OK].
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❻ Click [OK] in the [Export Users] window.

Adding IC card information
to the IC card compatibility
table
The following methods can be used to add
IC card information (card ID) to the IC
card compatibility table.

• Obtain from the Active Directory
 The IC card information obtained when a user
is added to the Active Directory can be added
to the IC card compatibility table. For details
on obtaining IC card information from the
Active Directory, see "Specifying attributes for
obtaining IC card information" (page 111).

6

• Using the Card Enroll Tool

❼ When a window inquiring whether or not
to send the IC card compatibility table
to the printer is displayed, click [Yes] to
send the table, or [No] not to send the
table.
When [Create card table] is checked, the
IC card compatibility table is updated
when Active Directory users are added,
deleted, or when settings are changed.

 When using the Card Enroll Tool, the IC card
reader attached to the computer in which the
server software is installed is used to read
data from an IC card, which is then added to
the IC card compatibility table. The IC card ID
can also be added manually. Follow the steps
below to use the Card Enroll Tool.

❶ Install the Card Enroll Tool on the same
computer in which the server software is
installed.

❷ To enter the IC card ID manually, proceed
to step ❸. To enter the IC card ID from
the IC card, attach an IC card reader
to the computer in which the server
software is installed.

❸ Start the server software.
❹ Click [Policy] menu > [User Registration
on Active Directory].
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❺ Click [Export Users].

❾ The Card Enroll Tool starts. The record list
of the IC card compatibility table created
by the server software is displayed in the
window.

❻ Check the [Create card table] check box,
and click [Browse].

 To add an IC card ID manually, doubleclick the IC card ID field so the ID can be
entered. In this state, enter the IC card
ID using the keyboard.

❼ Select the folder that you want to save,
and click [OK].

❽ Click [Edit card table].

When entering the IC card ID from the
IC card, check the IC card ID recorder
check mark, and place the IC card over
the IC card reader. The IC card ID is
automatically entered into the checked
recorder.
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 Click [Send].

 When the window confirming whether to

6

send the IC card compatibility table is
displayed, click [YES].

 The updated IC card compatibility table is
saved, and the IC card compatibility table
is registered t o the printer.
Note!

Memo

The IC card compatibility table cannot
be registered to a printer whose IC
card compatibility table registration
settings are not enabled. For details on
how to enable the IC card compatibility
table registration settings, see
"Setting the printer to which the IC
card compatibility table is registered"
(page 131).
The Card Enroll Tool can be installed in
a different computer to that in which
the server software is installed, and the
IC card ID can be added to the IC card
compatibility table created by the server
software.
For details on adding IC card IDs to the
IC card compatibility table created with
the server software from a Card Enroll
Tool installed on a different computer,
see the User's Manual from the IC card
authentication kit.
When adding IC card IDs to the IC card
compatibility table created with the
server software from a Card Enroll Tool
installed on a different computer, the
following settings are required on the
computer in which the server software
is installed.
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①

Set the folder in which the IC card
compatibility table exists as a shared
folder, and set the access permissions
to allow changes from the computer
on which Card Enroll Tool is installed.

②

Check that the [Remote Registry]
service is started. When the [Remote
Registry] service is started, the [Control Panel] > [Administrative Tools]>
[Services] > [Remote Registry] status is displayed as [Started]. If it is
not displayed as [Started], [Start] is
displayed on the left side. Click it to
start the [Remote Registry] service.
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❻ Click [Send card table].

Registering the IC card
compatibility table to the
printer
The created IC card compatibility table can
be manually registered to the printer.

❶ Start the server software.
❷ Click [Policy] menu > [User Registration
on Active Directory].

❼ When the window confirming whether to

❸ Click [Export Users].

register the IC card compatibility table is
displayed, click [YES].

❽ When the window notifying that sending
is completed is displayed, click [Close].

❹ Check the [Create card table] check box,
and click [Browse].

When automatically updating registered
Active Directory users, the updated IC
card compatibility table is automatically
registered in the printer. For details
on automatically updating registered
Active Directory users, see “Setting the
automatic update service” (page 141).
Note!

❺ Select the folder that you want to save,
and click [OK].
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The IC card compatibility table cannot
be registered to a printer whose IC
card compatibility table registration
settings are not enabled. For details on
how to enable the IC card compatibility
table registration settings, see
"Setting the printer to which the IC
card compatibility table is registered"
(page 131).

6
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Displaying error messages at
server software startup

❺ Click [OK].

If the IC card compatibility table cannot be
registered to the printer, an error message
can be displayed at server software startup
to notify you of the error.

❶ Start the server software.
❷ Click [Policy] menu > [User Registration
on Active Directory].

6
❸ Click [Export Users].

❹ Check the [Display a message at startup
of this utility] check box.
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Sending an error notification
mail to the administrator

❺ Click [OK].

If the IC card compatibility table cannot
be registered to the printer, a mail that
contains the error details can be sent once
a day to the administrator.

❶ Start the server software.
❷ Click [Policy] menu > [User Registration
on Active Directory].

6
❸ Click [Export Users].

Note!

❹ Check the [Notify administrator by
e-mail] check box.
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The outgoing mail server, sender's
e-mail address, and administrator's
e-mail address need to be configured in
advance according to the "Setting the
outgoing mail function" (page 224).
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❺ Click the [Option] tab > [Detail setting].

Permitting alternative
authentication to IC cards
The settings for the IC card alternative
authentication mode of the printer can be
configured.

❶ Check that the printer power is ON.
❷ Start the server software.
❸ Double-click [Printer] in the selection
window. The registered printer list is
displayed in the details window.

6
❻ Check the [Synchronize user list with
Active Directory] check box.

❹ Select the printer, and then select the
[Printer] menu > [Properties].
Memo

Multiple printers can be selected.

❼ To enable the IC card alternative
authentication mode, check the [Allow
alternative authentication for card] check
box. To disable the IC card alternative
authentication mode, uncheck the [Allow
alternative authentication for card] check
box.
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❽ Click [OK].

Setting the automatic
update service
The Active Directory user information can
be periodically monitored, and changes
to registered user or group information
can be updated. Monitoring in order to
automatically update registered users or
groups is set to enabled by default, but
settings such as the monitoring schedule
settings, and which users and groups are
target for monitoring can be changed.

❾ Click the [Option] tab > [OK].

Note!

When a new user that belongs to a
group that is target for monitoring in
the Active Directory is added, users can
be registered to the printer until the
maximum number of users that can
be registered to the printer is reached.
After the maximum number of users
that can be registered is reached,
subsequent users are not registered to
the printer.

❶ Start the server software.
❷ Click [Policy] menu > [User Registration
on Active Directory].

 When the window notifying the changed
setting items is displayed, click [Yes].

 When the window notifying that
the setting changes are complete is
displayed, click [Close].

❸ Click [Setup].
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❹ Click [Set Up Refresh Service] in the

❼ Check the users/groups to monitor for

[Active Directory User/Group Settings].

updates on the Active Directory. When a
group is checked, the users that belong
to the group are also monitored.

6
❺ Set the automatic update timing.

❽ Click [OK].

Specify Time
Automatic update can be performed at a set time.
This can be set in day units.

Specify Interval
The automatic update interval can be set in
minute units.

❻ Set the user/group to monitor for
updates.
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Immediately updating user
settings
Updates can be performed immediately as
well as those performed at the automatic
update timing set in the [Set Up Refresh
Service] window.

❶ Start the server software.

Selecting the users to
apply settings to
Click [Apply] in the [Login name/Group
name which synchronizes with Active
Directory] window and the users/groups to
registered to the printer can be selected.

❶ Select the printer from the printer list

❷ Click [Policy] menu > [User Registration
on Active Directory].

in the [Login name/Group name which
synchronizes with Active Directory]
window.

6
❸ Click [Setup].

❷ Click [Select user].

❹ Click [Refresh Now] in [Active Directory
User/Group Settings].
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❸ Check the users/groups to register in
the printer in the [Select user which is
registered] window.

6

❹ Click [OK].

Note!

Users that belong to groups are not
displayed in the [Select user which is
registered] window.
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7. Saving managed data to the database
This section explains how to export the log, Job Account ID, and fee charge definition to
the database, and how to browse the log, Job Account ID, and fee charge definition from a
web browser. The log can be exported to the database from the point at which it is obtained
from the printer. The Job Account ID can be exported to the database at the point when it
is registered to or deleted form the printer, or when the settings are changed. To export the
managed information to the database, the following settings need to be configured.
• Database software settings (page 146)
• Settings for connecting to the database (page 147)
In order to export the managed log and Job Account ID information to the database, the
following settings also need to be configured in addition to the settings listed above.
•	Settings for recording information to the database of the printer that you want to export
managed information to must be enabled (page 148)

7

Configuring the database
software settings

❻ Enter the administrator "root" password
that was set when MySQL was installed.

❼ Execute the following command.
grant all privileges on *.* to
'root'@'%' with grant option;

Connecting to MySQL
Database
When using MySQL on a different computer
that contains the server software, libmysql.
dll needs to exist in the server software
installation folder.

❶ Copy libmysql.dll from the "bin" folder or
"lib" folder of the installation folder of the
MySQL installation to be used.

❷ Paste the file into the installation folder of
the server software.
Depending on the MySQL version, the
administrator "root" permissions may not
be sufficient. In this case, increase the
permission level.

❸ Start [MySQL Server Instance Config
Wizard] and check the [Include Bin
Directory in Windows PATH] check box to
complete the settings.

❹ Start the command prompt in Windows
OS.

❺ Execute the following command.
Mysql –u root –p
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Settings for connecting to
the database
❶ Start the server software.
❷ Click the [Option] menu > [Setup].

Note!

If [Record logs in database] is disabled,
it is not possible to connect to the
database.

❺ Configure the settings for the database to
connect to.

Database
Select the type of database to connect to. The
types of database that can be selected are
Microsoft SQL Server, Microsoft SQL Server
Express Edition, Microsoft Access and MySQL.

❸ Display the [Database] tab.

Authentication
Select the authentication method used when
connecting to the database.

Windows authentication
Authenticated connection using the Windows
user permission registered in the database.
This can only be selected in Microsoft SQL
Server or Microsoft SQL Server Express Edition.

User authentication
Authenticated connection using the user
permission for User authentication registered in
the database.

Access
Specify whether the connected database is a
location connection or network connection.

Local database

❹ Check the [Record logs in database]
check box.

Connect to a database that exists on this
computer.

Network database
Connect to a database that exists on a different
computer on this network.

Server Name
Specify the IP address or computer name of
the computer on which the database exists. A
maximum of 270 can be entered.

Path Name
Specify the path name where the database to
connect to exists. A maximum of 270 can be
entered. This can only be entered when Microsoft
Access is used.
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User Name
Specify the user name of the database to
connect to. A maximum of 80 can be entered.
When Windows authentication is selected for
[Authentication], specify a valid Windows account

Setting the printer for
recording managed data
to the database

that can connect to the database using Windows

❶ Check that the printer power is ON.

authentication from the obtain log service. For

❷ Start the server software.

example, the computer administrator.

❸ Double-click [Printer] in the selection

Password
Specify the password of the database to
connect to. A maximum of 80 can be entered.

window. The registered printer list is
displayed in the details window.

When Windows authentication is selected for
[Authentication], specify the password for the
Windows account name.

❻ Click [OK]. Connect to the set database,

7

and the settings are complete when the
connection is successfully established.

❹ Select the printer, and then select the
[Printer] menu > [Properties].
Memo
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Multiple printers can be selected.
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❺ Check the [Option] tab > [Record logs in
a database] check box.

❼ When the window notifying the changed
setting items is displayed, click [Yes].

❽ A window inquiring whether or not to

Note!

If the settings for connecting to
a database (page 147) are not
implemented, [Record logs in a
database] is grayed out.

❻ Click [OK].

export the database to the Job Account
ID registered in the printer is displayed.
Click [YES] to immediately export the
database. Click [NO] to not export the
database.

❾ When the window notifying that
the setting changes are complete is
displayed, click [Close].
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Exporting the fees to the
database

❹ Check the [Record logs in database]
check box.

The managed fee definitions are exported
to the database.

❶ Start the server software.
❷ Click the [Option] menu > [Setup].

❸ Display the [Database] tab.

7
❺ Configure the settings for the database to
connect to.
For details on the settings of the
connected database, see "Settings for
connecting to the database" (page 147).

❻ Click [Fee]. Connect to the set database,
and when the connection is successfully
established the fee export window is
displayed.
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❼ Select the fee charges from [Fee], and
click [Add].

Deleting fees from the
database
Delete the fee definitions from the
database.

❶ Start the server software.
❷ Click the [Option] menu > [Setup].

❸ Display the [Database] tab.

7

Note!

• Fees that already exist in the database
are overwritten.
• Single quotation marks that exist in
the character string are replaced with
space characters, and the information
is saved in the database.
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❹ Check the [Record logs in database]

❼ Select the fee charges from [Database's

check box.

fees], and click [Delete].

7
❺ Configure the settings for the database to
connect to.
For details on the settings of the
connected database, see "Settings for
connecting to the database" (page 147).

❻ Click [Fee]. Connect to the set database,
and when the connection is successfully
established the fee export window is
displayed.
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Exporting the log to the
database

❹ Select the log to export, and select the
[Log] menu > [Export logs into the
database].

The obtained log is written to the
database. In order to change the log items
written to the database, see "Changing the
log items to be exported" (page 212).

❶ Start the server software.
❷ Click the plus mark on the left side of
[Log] in the selected window. The log
tree opens.

Note!

❸ Using the same operation as step 2, open
the tree for [Printer] or [Date].
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• Single quotation marks that exist in
the character string are replaced with
space characters, and the information
is saved in the database.
• Logs of printers whose database
recording settings are disabled are
not exported. For details on enabling
the database recording settings, see
"Setting the printer for recording
managed data to the database"
(page 148).

7
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❹ Select the log that you want to delete

Deleting logs from the
database

from [List of logged months and years].

Delete a log from the database.

❶ Start the server software.
❷ Click the [Log] menu > [Delete logs from
the database].

7

❺ Click [Delete].
❸ Display the database logs using either
the [By printer] or [By month and year]
method.

By printer
Just the logged month and year of the printer
selected in [List of printers being logged] are
drawn from the database and displayed.

By month and year
Just the logged months and years selected in
[List of database-logged months and years] are
drawn from the database and displayed.
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Exporting the printer
users to the database

❹ Check the [Record logs in database]
check box.

The managed Job Account IDs are
exported to the database.

❶ Start the server software.
❷ Click the [Option] menu > [Setup].

❸ Display the [Database] tab.

7
❺ Configure the settings for the database to
connect to.
For details on the settings of the
connected database, see "Settings for
connecting to the database" (page 147).

❻ Click [Printer User].
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❼ When connection to the set database
is successfully established, a message
confirming whether or not to export
the Job Account ID to the database is
displayed. Click [YES].
Note!

• Job Account IDs that already exist in
the database are overwritten.
• Job Account IDs of printers whose
database recording settings are
disabled are not exported. For details
on enabling the database recording
settings, see "Setting the printer
for recording managed data to the
database" (page 148).
• Single quotation marks that exist in
the character string are replaced with
space characters, and the information
is saved in the database.

Registering database
connection users
Register database connection users.

❶ Start the server software.
❷ Click the [Option] menu > [Setup].

❸ Display the [Database] tab.

7
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❹ Check the [Record logs in database]

❼ Click [Add].

check box.

❽ Specify the [User Name],
[Authentication], [Password], [Repeat
Password] and permissions, and click
[Add].

7
❺ Configure the settings for the database to
connect to.
For details on the settings of the
connected database, see "Settings for
connecting to the database" (page 147).

❻ Click [Database user registration].
When connection to the set database
is successfully established, the [Regist
user to connect with database] window is
displayed.

Note!
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If the users and user names duplicate
those that are already registered in the
database, they cannot be added.
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❾ Click [OK].

Changing the permissions
for database connection
users
Change the permissions for registered
database connection users.

❶ Start the server software.
❷ Click the [Option] menu > [Setup].

❸ Display the [Database] tab.

7

 When the registration results notification
window is displayed, click [Close].

Note!

Users registered to a Microsoft Access
database only use authentication to
browse the database from a website.
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❹ Check the [Record logs in database]

❼ Select the users whose permissions you

check box.

want to change in [List of users], and
click [Change Privileges].

❽ Select the permissions, and click [OK].

7
❺ Configure the settings for the database to
connect to.
For details on the settings of the
connected database, see "Settings for
connecting to the database" (page 147).

❾ When the permission change results

❻ Click [Database user registration].
When connection to the set database
is successfully established, the [Regist
user to connect with database] window is
displayed.

notification window is displayed, click
[Close].
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Changing the password
for database connection
users

❹ Check the [Record logs in database]
check box.

Change the password for registered
database connection users.

❶ Start the server software.
❷ Click the [Option] menu > [Setup].

❸ Display the [Database] tab.

7
❺ Configure the settings for the database to
connect to.
For details on the settings of the
connected database, see "Settings for
connecting to the database" (page 147).

❻ Click [Database user registration].
When connection to the set database is
successfully established, the [Register
user to connect with database] window is
displayed.
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❼ Select the users whose permissions you
want to change in [List of users], and
click [Change Password].

Deleting database
connection users
Delete registered database connection
users.

❶ Start the server software.
❷ Click the [Option] menu > [Setup].

❽ Enter the [Password] and [Repeat
Password], and click [OK].

❸ Display the [Database] tab.

7
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❹ Check the [Record logs in database]

❼ Select the users whose permissions you

check box.

want to delete in [List of users], and click
[Delete].

❽ When a window confirming whether or
not to delete the user is displayed, click
[YES].

7
❺ Configure the settings for the database to
connect to.
For details on the settings of the
connected database, see "Settings for
connecting to the database" (page 147).

❻ Click [Database user registration].
When connection to the set database
is successfully established, the [Regist
user to connect with database] window is
displayed.
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Updating the database to
the newest version

❹ Check the [Record logs in database]
check box.

If a new format of database can be used
due to an update to the server software,
the database format can be updated to the
newest version. Data that already exists in
the database is retained.

❶ Start the server software.
❷ Click the [Option] menu > [Setup].

❸ Display the [Database] tab.

7
❺ Configure the settings for the database to
connect to. For details on the settings of
the connected database, see "Settings for
connecting to the database" (page 147).

❻ Click [Update the database table]. When
the connection to the set database
is successfully established, a window
inquiring whether or not to update
the database to the newest version is
displayed. Click [YES].
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Displaying error messages
at server software startup

Check the [Record logs in database]
check box.

A message can be displayed at startup if
additions to the log database fail.
Start the server software.
Click the [Option] menu > [Setup].

Display the [Database] tab.

7
Configure the settings for the database to
connect to. For details on the settings of
the connected database, see "Settings for
connecting to the database" (page 147).
Check the [Display a message at startup
of this utility] check box, and click [OK].
When connection to the set database is
successfully established, the settings are
saved.
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Sending an error
notification mail to the
administrator

Check the [Record logs in database]
check box.

If additions to the log database fail, a mail
that contains the error details can be sent
once a day to the administrator.
Start the server software.
Click the [Option] menu > [Setup].

Display the [Database] tab.

7
Configure the settings for the database to
connect to. For details on the settings of
the connected database, see "Settings for
connecting to the database" (page 147).
Check the [Notify administrator by
e-mail] check box. When connection
to the set database is successfully
established, the settings are saved.

Note!
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The outgoing mail server, sender's
e-mail address, and administrator's
e-mail address need to be configured in
advance according to the "Setting the
outgoing mail function" (page 224).
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Creating a website
[Microsoft Windows 8.1]
You can create a website on Microsoft
Windows 8 by taking the same steps as
those for creating a website using Microsoft
Windows 7 as the server software.
For the steps in creating a website
using Microsoft Windows 7 as the server
software, refer to “Creating a website
[Microsoft Windows 7]” (page 166).

Creating a website
[Microsoft Windows
Server 2012 R2]
7

You can create a website on Microsoft
Windows Server 2012 by taking the same
steps as those for creating a website using
Microsoft Windows Server 2008 as the
server software.
For the steps in creating a website using
Microsoft Windows Server 2008 as the
server software, refer to “Creating a
website [Microsoft Windows Server 2008]”
(page 169).

Creating a website
[Microsoft Windows
Server 2012]
You can create a website on Microsoft
Windows Server 2012 by taking the same
steps as those for creating a website using
Microsoft Windows Server 2008 as the
server software.
For the steps in creating a website using
Microsoft Windows Server 2008 as the
server software, refer to “Creating a
website [Microsoft Windows Server 2008]”
(page 169).

Creating a website
[Microsoft Windows 7]
This section explains how to create a
website when Microsoft Windows 7 is used
as the software.

Installing the internet
information service
In order to create a website, internet
information service needs to be installed in
the computer.

Creating a website
[Microsoft Windows 8]
You can create a website on Microsoft
Windows 8 by taking the same steps as
those for creating a website using Microsoft
Windows 7 as the server software.
For the steps in creating a website
using Microsoft Windows 7 as the server
software, refer to “Creating a website
[Microsoft Windows 7]” (page 166).

Select [Control Panel] > [Program and
Features], and select [Turn Windows
features on or off].
Check all of the items in [Internet
Information Services] > [Web
Management Tools] > [IIS 6 Management
Compatibility], and check the [IIS 6
Management Console] check box.
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Check the [ASP] and [ISASP Extensions]
in [Internet Information Services] >
[World Wide Web Service] > [Application
Development Features].

Configure settings for
browsing a Microsoft Access
database
In order to browse a Microsoft Access
database from a website, "Authenticated
Users" need to be added to the
[Properties] and [Security] tab in the
following folder, and the "Authenticated
Users" permissions need to be raised to full
control.
(System drive) Windows\temp\

Configure settings for
browsing a MySQL database
Check [Windows Authentication] in
[Internet Information Services] > [World
Wide Web Service] > [Security].

To browse a MySQL database from a
browser, MySQL Connector/ODBC 5.1
needs to be installed. MySQL Connector/
ODBC 5.1 can be downloaded from the
MySQL website.

Checking the version of
Microsoft SQL Server or
Microsoft SQL Server Express

Click [OK].

To browse a Microsoft SQL Server database
or Microsoft SQL Server Express Edition
database from a website, the database
version needs to be Microsoft SQL Server
2005 Service Pack 2 or higher, or Microsoft
SQL Server 2005 Express Edition Service
Pack 2 or higher.

Creating a website
Start the server software.
Click the [Option] menu > [Setup].

- 167 -

7

7. Saving managed data to the database

Display the [Database] tab.

Configure the settings for the database to
connect to. For details on the settings of
the connected database, see "Settings for
connecting to the database" (page 147).
Check the [Accessing database from
website] check box, enter the [Title
displayed on website], and click [OK].

7

Check the [Record logs in database]
check box.

When the connection is established
successfully to the set database, the
[Selection of Web site] window is
displayed. Select the website, and click
[OK].
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Setting the website
Configure the settings for accessing the
created website from a web browser on
the computer. The setting methods differ
between when the Windows authentication
method is used from the web browser, or
the User authentication method is used to
access the website.

Accessing using the Windows
authentication method
Select [Control Panel] > [Administrative
Tools], and open [Internet Information
Service (IIS) Manager].
When the window is displayed, select
the [JALogDB] website, and click
[Authentication].
Disable [Anonymous Authentication], and
enable [Windows Authentication].
Note!

Be careful when checking [Anonymous
Authentication], as any user can browse
the database.

Select [Control Panel] > [Administrative
Tools], and select [Internet Information
Service (IIS) Manager].

Disable [Windows Authentication].

This section explains how to create a
website when Microsoft Windows Server
2008 is used as the software.

Installing the internet
information service
In order to create a website, internet
information service needs to be installed in
the computer.
Select [Administrative Tools] > [Server
Manager], and select [roles] > [Add
roles].
Select [Web Server (IIS)], and check all
of the [Administrative Tools] and [IIS 6
Management Compatibility] items.
Select [Web Server (IIS)], and check all
of the [ASP] and [ISASP Extension] items
in [Administrative Tools] and [Application
Development Features] items.
Select [Web Server (IIS)], and check the
[Security] and [Windows Authentication]
check boxes.

Accessing using the User
authentication method

When the window is displayed, select
the [JALogDB] website, and click
[Authentication].

Creating a website
[Microsoft Windows
Server 2008]

Click [Install].

Configure settings for
browsing a Microsoft Access
database
In order to browse a Microsoft Access
database from a website, "Authenticated
Users" need to be added to the
[Properties] and [Security] tab in the
following folder, and the "Authenticated
Users" permissions need to be raised to full
control.
(System drive) Windows\temp\
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Configure settings for
browsing a MySQL database

Check the [Record logs in database]
check box.

To browse a MySQL database from a
browser, MySQL Connector/ODBC 5.1
needs to be installed. MySQL Connector/
ODBC 5.1 can be downloaded from the
MySQL website.

Checking the version of
Microsoft SQL Server or
Microsoft SQL Server Express

7

To browse a Microsoft SQL Server database
or Microsoft SQL Server Express Edition
database from a website, the database
version needs to be Microsoft SQL Server
2005 Service Pack 2 or higher, or Microsoft
SQL Server 2005 Express Edition Service
Pack 2 or higher.

Creating a website
Start the server software.
Click the [Option] menu > [Setup].

Configure the settings for the database to
connect to.
For details on the settings of the
connected database, see "Settings for
connecting to the database" (page 147).
Check the [Accessing database from
website] check box, enter the [Title
displayed on website], and click [OK].

Display the [Database] tab.
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When the connection is established
successfully to the set database, the
website selection window is displayed.
Select the website, and click [OK].

Creating a website
[Microsoft Windows Vista]
This section explains how to create a
website when Microsoft Windows Vista is
used as the software.

Installing the internet
information service
In order to create a website, internet
information service needs to be installed in
the computer.
Select [Control Panel] > [Program and
Features], and select [Turn Windows
features on or off].

Setting the website
Configure the settings for accessing the
created website from a web browser on the
computer.
The setting methods differ between when the
Windows authentication method is used from
the web browser, or the User authentication
method is used to access the website.

Check all of the items in [Internet
Information Services] > [Web
Management Tools] > [IIS 6 Management
Compatibility], and check the [IIS 6
Management Console] check box.

Accessing using the Windows
authentication method
Select [Control Panel] > [Administrative
Tools], and open [Internet Information
Service (IIS) Manager].
When the window is displayed, select
the [JALogDB] website, and click
[Authentication].
Disable [Anonymous Authentication], and
enable [Windows Authentication].
Note!

Check the [ASP] and [ISASP Extensions]
in [Internet Information Services] >
[World Wide Web Service] > [Application
Development Features].

Be careful when checking [Anonymous
Authentication], as any user can browse
the database.

Accessing using the User
authentication method
Select [Control Panel] > [Administrative
Tools], and select [Internet Information
Service (IIS) Manager].
When the window is displayed, select the
[JALogDB] website, and click [Authentication].
Disable [Windows Authentication].
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Check [Windows Authentication] in
[Internet Information Services] > [World
Wide Web Service] > [Security].

Configure settings for
browsing a Microsoft Access
database
In order to browse a Microsoft Access
database from a website, "Authenticated
Users" need to be added to the
[Properties] and [Security] tab in the
following folder, and the "Authenticated
Users" permissions need to be raised to full
control.

Window Vista
Select [Control Panel] > [Folder Options] >
[View] tab, and when the [Show hidden files,

Click [OK].

folders and drives] check box is checked in the
detailed settings, the following folder is displayed.
(System drive) Windows\ServiceProfiles\

7

NetworkService\AppData\Local\

Window Vista SP1 and subsequent
versions
(System drive) Windows\temp\

Configure settings for
browsing a MySQL database
To browse a MySQL database from a
browser, MySQL Connector/ODBC 5.1
needs to be installed. MySQL Connector/
ODBC 5.1 can be downloaded from the
MySQL website.

Checking the version of
Microsoft SQL Server or
Microsoft SQL Server Express
To browse a Microsoft SQL Server database
or Microsoft SQL Server Express Edition
database from a website, the database
version needs to be Microsoft SQL Server
2005 Service Pack 2 or higher, or Microsoft
SQL Server 2005 Express Edition Service
Pack 2 or higher.
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Creating a website

Check the [Record logs in database]
check box.

Start the server software.
Click the [Option] menu > [Setup].

Display the [Database] tab.

7
Configure the settings for the database to
connect to.
For details on the settings of the
connected database, see "Settings for
connecting to the database" (page 147).
Check the [Accessing database from
website] check box, enter the [Title
displayed on website], and click [OK].
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When the connection is established
successfully to the set database, the
website selection window is displayed.
Select the website, and click [OK].

Setting the website
Configure the settings for accessing the
created website from a web browser on
the computer. The setting methods differ
between when the Windows authentication
method is used from the web browser, or
the User authentication method is used to
access the website.

Accessing using the Windows
authentication method
Select [Control Panel] > [Administrative
Tools], and open [Internet Information
Service (IIS) Manager].

7

When the window is displayed, select
the [JALogDB] website, and click
[Authentication].
Disable [Anonymous Authentication], and
enable [Windows Authentication].
Note!

Be careful when checking [Anonymous
Authentication], as any user can browse
the database.

Accessing using the User
authentication method
Select [Control Panel] > [Administrative
Tools], and select [Internet Information
Service (IIS) Manager].
When the window is displayed, select
the [JALogDB] website, and click
[Authentication].
Disable [Windows Authentication].
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Creating a website
[Microsoft Windows
Server 2003]

Check the [Record logs in database]
check box.

This section explains how to create a
website when Microsoft Windows Server
2003 is used as the software. In order
to create a website, internet information
service needs to be installed in the
computer.

Creating a website
Start the server software.
Click the [Option] menu > [Setup].

7

Display the [Database] tab.

Configure the settings for the database to
connect to. For details on the settings of
the connected database, see "Settings for
connecting to the database" (page 147).
Check the [Accessing database from
website] check box, enter the [Title
displayed on website], and click [OK].
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When the connection is established
successfully to the set database, the
website selection window is displayed.
Select the website, and click [OK].

Accessing using the User
authentication method
Select [Control Panel] > [Administrative
Tools], and select [Internet Information
Service (IIS) Manager].
When the window is displayed, select the
[JALogDB] website, right-click, and click
[Properties].
When the [Directory Security] tab is
displayed, click [Anonymous access and
authentication control] > [Edit] button.
When the window is displayed,
uncheck the [Windows Comprehensive
authentication] check box.

7

Setting the website
Configure the settings for accessing the
created website from a web browser on
the computer. The setting methods differ
between when the Windows authentication
method is used from the web browser, or
the User authentication method is used to
access the website.

Accessing using the Windows
authentication method
Select [Control Panel] > [Administrative
Tools], and select [Internet Information
Service (IIS) Manager].
When the window is displayed, select the
[JALogDB] website, right-click, and click
[Properties].
When the [Directory Security] tab is
displayed, click [Anonymous access and
authentication control] > [Edit] button.
When the window is displayed, uncheck
the [Anonymous access] check box, and
check the [Windows Comprehensive
authentication] check box.
Note!

Be careful when checking [Anonymous
access], as any user can browse the
database.

Browsing the database from
the website
Connect to the website URL from a web
browser. The following methods can be
used to specify the URL.
When the server software is installed on
the computer

http://localhost/JALogDB/

When the server software is installed on
a different computer

 ttp://(Computer IP address)/
h
JALogDB

When the website is displayed, select
the authentication method. The following
authentication methods are available.

Window Auth
This is the Windows authentication method. This
can be used when connecting to Microsoft SQL
Server or Microsoft SQL Server Express Edition.
When [Window Auth] is selected, the PC in which
the server software is installed and PC in which
the database is installed need to be registered to
the same domain.

User Login
This method authenticates users that are
registered in the database. Enter the [Account]
and [Password].
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Displaying user information

Click the [Login] button.

When [User information] is clicked in the
selection window, the user information recorded
in the database is displayed.

The display window of the log registered
in the database is displayed. The
following operations can be performed in
the log display window.

Displaying fee information
When [Cost information] is clicked in the
selection window, the fee information recorded in
the database is displayed.

7

Displaying a specific printer log
When the printer name (IP address) is clicked in
the [Printer] section of the selection window, the
log of the printer whose IP address is selected in
the details window is displayed.

Displaying a log from a specific obtain
date
When the date is clicked in the [Date] section
of the selection window, the log from the obtain
date selected in the details window is displayed.

Aggregating displayed logs by printer
Click [Printer] in the [Export by] section of
the detail window, and the displayed logs are
aggregated according to the printer.

Aggregating displayed logs by Job
Account IDs
Click [User ID] in the [Export by] section of
the detail window, and the displayed logs are
aggregated according to the Job Account IDs.

Aggregating displayed logs by user name
Click [User name] in the [Export by] section of
the detail window, and the displayed logs are
aggregated according to the user name.

Aggregating displayed logs by date
Click [Date] in the [Export by] section of the
detail window, and the displayed logs are
aggregated according to the date.
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Memo

7
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8. Fees

8. Fees
Fees are used to request cost burdens from the user according to the status of use.
In the Print Job Accounting, fees can be defined in fine detail, such as the number of prints,
print paper size, and length of possession.
Note!

The window and setting contents differ depending on the printer model.

Creating fee charge
definitions

Enter the name of the definition to be
created in [Name].
Click the tabs of the items that you want
to set, and configure the settings.

Creating a definition

Page tab

Start the server software.
Select [Printer] menu > [Define Fees].

8

Click [Add].
Memo

The initial settings definition shows
a rough guide to the running costs
calculated from the standard prices of
various consumables and the number of
prints over the lifetime for each model.

The fees for one print based on the the total
number of prints and print pages can be set. In
the print pages, color printing and monochrome
printing and white/clear printing and white/clear
only printing can be set separately.

Check [Page], and then enter the fees
for [Color] and [Mono] and [White/
Clear] and [White/Clear Only].
Check [Sheet], and enter the fees.
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Toner use amount tab

According to the type of printer, the [Setting
life] check box is displayed instead of the [Large
Capacity] check box. To set the toner lifespan
and automatically calculate the cost, check the
[Setting life] check box, and enter [Color life] and
[Mono life]. When [Setting life] is not checked,
the [Do you want to acquire the information
of the toner installed in the printer?] message
is displayed. Check that the printer power is
ON, and click [Yes]. When [No] is clicked or if
information cannot be obtained from the printer,
toner information from when the printer was
registered is used for the automatic calculation.
When large capacity and standard toners are
mixed, calculations are based on the large
capacity toners.
For details on the toner usage level, see [Items
that can be aggregated] - [Toner].

Set to apply fees for the amount of toner used.
To apply fees for the amount of toner used, check
the [Toner use amount] check box, and set the
fee charges for the amount of toner used at each
level per page.
To set the fee charges per page for each level,
select the level that you want to set from the list,
click the [Change] button, enter the fee charge
per page in the [Color Fee] field and [Mono
Fee] field and [White/Clear Fee] field in the cost
change window, and click [OK].
To automatically calculate the fee charges, select
the printer in which automatic calculation will
be used from [A printer used for fee automatic
calculation], and enter the color toner price in the
[Color Price] field and monochrome toner price in
the [Mono Price] field and white/clear toner price
in the [White/Clear Price] field. When there are
two types of toner and the large capacity type of
toner is used, check the [Large Capacity] check
box and click [Automatic calculation].
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Drum use amount tab

8

Belt, fuser use amount tab

Set to apply fees for the amount of drum used.

Set to apply fees for the amount of belt and fuser

To apply fees for the amount of drum use, check

used.

[Drum use amount], and enter fees for color

To apply fees for the amount of belt and fuser

drum use per 1 A4 size page in the [Color Fee]

use, check [Belt, fuser use amount], and enter

field, and enter fees for the monochrome drum

fees for belt use per 1 A4 size page in the [Belt

use per 1 A4 size page in the [Mono Fee] field,

Fee] field, and enter fees for the fuser use per

and enter fees for the white/clear drum use per 1

page in the [Fuser Fee] field.

A4 size page in the [white/clear Fee] field.

To automatically calculate the fees, select the

To automatically calculate the fees, select the

printer to use from [A printer used for fee

printer to use from [A printer used for fee

automatic calculation], enter the belt price in the

automatic calculation], enter the color drum price

[Belt Price] field and fuser price in the [Fuser

in the [Color Price] field and monochrome drum

Price] field, and click [Automatic calculation].

(or 4-color combined unit drum) price in the
[Mono Price] field and white/clear drum price in
the [White/Clear Price] field, and click [Automatic
calculation]. For 4 color combined unit drum, the
[Color Fee] and [Color Price] fields cannot be
entered.
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Finisher tab

Size tab
Fees can be set for 1 page of each paper size.
Fees can also be applied just to specific sizes.

When the optional finisher is installed, set the fee
for each time that the stapler is used.

8

Check [Staple], and enter the fees.

Check [Size], and click [Change].
In the [Detailed setting for fees]
window, select the size to apply fees to
from [Size], and enter the fee charges.
Click [Add].
Repeat steps
and , and add the
sizes that require fees.
When all required sizes are added,
click [OK].
Note!
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A4, A4 Wide(SRA4), B5, letter, 16K
184×260mm, 16K 195×270mm and
16K 197×273mm are different paper
sizes with longitudinal feed and cross
feed. When cross feed is used, add A4
horizontal, A4 Wide(SRA4) horizontal,
B5 horizontal, A5 horizontal, letter
horizontal, 16K 184×260mm horizontal,
16K 195×270mm horizontal, and 16K
197×273mm horizontal.

8. Fees

Tray tab

Media Type tab

Fees can be set for 1 page from each used tray.

Fees can be set for 1 type of each paper size.

Fees can also be applied just to specific trays.

Fees can also be applied just to specific paper
types.

8

Check [Tray], and click [Change].

Check [Media], and click [Change].

In the [Detailed setting for fees]
window, select the tray to apply fees
to from [Tray], and enter the fee
charges.

In the [Detailed setting for fees]
window, select the paper type to apply
fees to from [Media type], and enter
the fee charges.

Click [Add].

Click [Add].

Repeat steps
and , and add the
trays that require fees.

Repeat steps
and , and add the
paper types that require fees.

When all required sizes are added,
click [OK].

When all required sizes are added,
click [OK].
Click [OK].
Click [End].
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Setting printer fee definitions
Start the server software.

Select the fee charges definition to be
used from the [Option] tab > [Fees], and
click [OK].

Double-click [Printer] in the selection
window. The registered printer list is
displayed in the list view of the details
window.

Select the printer, and then select the
[Printer] menu > [Properties].
Memo

Multiple printers can be selected.

8
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Changing fee charge
definitions

Deleting fee charge
definitions
Note!

Start the server software.
Select [Printer] menu > [Define Fees].

• Initial setting definitions cannot be
deleted.
• When the definition set in the current
printer is deleted, it is replaced with
the initial settings definition.

Select the definition name that you want
to change, and click [Properties].

Start the server software.
Select [Printer] menu > [Define Fees].
Select the definition name that you want
to delete, and click [Delete].

8

Change the settings in the [Define Fees]
window, and click [OK].
For details on the setting items, see
"Creating fee charge definitions"
(page 180).
Memo

Click [End].

When the name is changed, it is
registered as a new definition. The
previous settings remain under the
former definition name.

Click [End].
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9. Operating the Log
This section explains settings for acquiring the log, and operations such as displaying or
deleting the log.

What is the Log?
In Print Job Accounting, various information about print jobs such as who, when, and which
printer was used for print jobs is stored on the printer built-in hard disk or flash memory. This
information is called the log. The server software acquires the log from the printer according
to a set schedule.
By logging this information, it is possible to check how much individuals are printing, and how
much a specific printer is being used.
Note!

• A log entry is made when one or more sheets are printed. Furthermore, log entries are
made when printing is rejected, or when a job is cancelled because color printing is rejected.  
• However, log entries are not made when the printer power is turned OFF during processing
or printing, or if printing cannot be performed because the printer has an error.

Acquiring the Log
Information that can be acquired

9

Information that can be acquired as a log is as shown below.
Note!

The information that can be acquired differs depending on the printer model or whether
options are used.

Item

Details

Printer

The printer name and connection destination
displayed in the log. This is displayed when all printer
logs are displayed.

Date

The date of the displayed log. This is displayed when
logs from all dates are displayed.

Log No.

*1

The log number. Assigned for each month starting
from 1.

Job Account ID

The Job Account ID set in the client computer that
executed the printing job, or the PIN ID entered into
the control panel.

User

User name set in the client computer that executed
the printing job.

Login Name

Login name of the client computer that executed the
print job.

Document Name

Name of the printed document. If the document
name contains a " symbol, the " symbol is replaced
with a one-byte space. In some cases, the correct
document name cannot be acquired.

Application

Name of the application used to execute the print
job.
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Item

Details

Fees

Fees incurred for the print job.

Host Name

Name of the client computer that executed the print
job.

Port

Name of the port used for printing. When using over
a network, the IP address of the client computer is
displayed.

Total Sheets

Number of sheets printed.

Pages

Number of pages printed. When duplex printing
is used, one sheet is counted as two pages. This
number is the actual number of printed pages as
opposed to the document page number. For example,
when a 6 page document is printed using 2-UP
printing, the number of pages is 3 pages.

Status

The job processing result.
• Completed: Job completed normally.
• Canceled: Job cancelled by user operation. (For
printing, when one or more sheets are printed)
• Aborted: Job cancelled by a reason other than the
user operation.
• Abnormal Completed: Job completed abnormally.

Detailed Status

• Log Buffer Full:
Job cancelled because the printer log buffer is full.
• Access Control: Job cancelled by use restrictions.
• Memory Over Flow:
Job cancelled by memory overflow.
• Color Control:
Job cancelled by use restriction (Disable Color
Printing).
• Mono Printing (Color limited):
Job printed in monochrome due to use restriction
(Disable Color Printing).
• Lip Error:
Job cancelled by lip error.

Paper Size*1

Media Type

Size of the printed paper. If a there are multiple
paper sizes used in the same print job, this item is
displayed over a number of lines.
*1 *2

Media Weight

Duplex

*1

*1 *2

Type of the printed paper. If a there are multiple
paper types used in the same print job, this item is
displayed over a number of lines.
Thickness of the printed paper. If a there are multiple
paper thicknesses used in the same print job, this
item is displayed over a number of lines.
This distinguishes between single-sided or duplex
printing. If both single-sided and duplex printing used
in the same print job, this item is displayed over a
number of lines.
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Item
Sheets

9

Color

*1

Mono

*1

Details
When one print job is displayed over a number of
lines, the number of printed sheets is displayed on
each line.

*1

Number of color pages printed. When one print job
is displayed over a number of lines, the number of
pages is displayed on each line.
Number of monochrome pages printed. When one
print job is displayed over a number of lines, the
number of pages is displayed on each line.

N-up

Displays how many pages of data are reduced and
printed within the printing range of 1 page.

Toner

The level of toner (toner usage density for each A4
size page) used for each color is displayed as one of
the following 6 levels, from 0 to 5.
Level
Density of the amount of
toner used
0
0%
1
~5%
2
~15%
3
~30%
4
~60%
5
61%~

Drum

Amount of drum used for each color (converted to
amount of drum used for each A4 size page). The
amount of drum use of a 4-in-1 color drum unit is
displayed is drum (K).

Belt

Amount of belt used (converted to the amount of belt
used for each A4 size page)

Fuser

Amount of fuser used (amount of fuser used for each
page)

Staple

When the optional finisher is installed, this shows the
number of times the stapler is used.

Log Acquire Time
Start Time

Time at which the printer received the job.

*2 *3

Process Start Time
Process End Time
Print Start Time
End Time

The time at which the server software acquired the
log.

*2

Time at which the printer started processing.

*2 *3

Time at which the printer ended processing.

*2 *3

Time at which the printer started printing.

*2 *3

Time at which the printer ended printing.

*2 *3

Processing Off-line Time

*2

The time during which printer processing stopped due
to an error such as a paper jam during processing,
paper size error, or no paper, or the amount of time
(seconds) the printer is set to offline on the control
panel.
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Item

Details

Printing Off-line Time

*2

The time during which printer processing stopped
due to an error such as a paper jam during printing,
paper size error, or no paper, or the amount of time
(seconds) the printer is set to offline on the control
panel.

Tray1

*2

Number of sheets supplied from tray 1.

Tray2

*2

Number of sheets supplied from tray 2.

Tray3

*2

Number of sheets supplied from tray 3.

Tray4

*2

Number of sheets supplied from tray 4.

Tray5

*2

Number of sheets supplied from tray 5.

Multi-purpose Tray

Number of sheets supplied from the multi-purpose
tray/manual feeding tray.

*2

Multi-purpose Feeder

*2

Number of sheets supplied from the optional multipurpose feeder.

300dpi

*2

Number of pages printed at 300dpi.

600dpi

*2

Number of pages printed at 600dpi.

1200×600dpi
1200dpi

*2

*2

Number of pages printed at 1200 x 600dpi.
Number of pages printed at 1200dpi.

2400×600dpi

Number of pages printed at 2400 x 600dpi.

Color Scan Page

Number of pages scanned in color.

Mono Scan Page

Number of pages scanned in monochrome

Scan Page Print Status

Indicates whether the scanned pages are printed.
• Scan Job Print:
Number of scan jobs that are accompanied with
printing.
• Scan Job No Print:
Number of scan jobs that are not accompanied with
printing.

Job ID

Number used to identify the job. When multiple logs
are generated for the same job, the ID number is the
same.
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Item

Details

Function

• Print: Print job.
• Fax receive print: Fax receive print job.
• PC Scan: PC scan job.
• Push Scan: Push scan job.
• Scan to network PC:
Scan to network PC job.
• Scan to e-mail:
Scan to e-mail job.
• Fax send: Fax send job.
• Copy: Copy job.
• Scan to USB memory:
Scan to USB memory job.
• Scan to Internet Fax:
Scan to Internet fax job.
• Scan to Fax Server:
Scan to Fax Server job.
• Send Fax from PC: Send Fax from PC job.
• Printing from a saved Fax:
Printing job from a saved Fax.  
• E-mail receive printing: Printing job for a received
e-mail.
• Printing from USB Memory: Printing job from USB
memory.
• Printing from Control Panel:
Printing job from the control panel.
• Other scans: Other scan jobs.

Service

Name of the service.
• Print: Print processing log.
• Scan: Scan processing log.
• Fax: Fax processing log.
• PC Scan: PC scan processing log.  
• PC Fax: Fax send from PC processing log.
• E-mail: Receiving or sending e-mail processing log.
• Server:
Log of file save process to network PC.
• USB memory:
Log of file save process to USB memory.

Scan Page Size

Size of the scanned document.

Communication Time

Time required to send or receive a fax.

Destination

When the service is Fax or PC Fax, this is one of the
following: Telephone number of the Fax source or
destination, recipient ID, or equipment information.
If the service is a server, this is the file save
destination folder.
When the service is a USB memory, this is fixed as
USBMEM01.
When the service is an e-mail, this is the e-mail
address of the sender or receiver.

9
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Item

Details

Communication Mode

This is the type of communication, Fax or e-mail.
• Send: Fax send job.
• Receive: Fax receive job.
• Send to multiple recipients: Fax send job to
multiple recipients.
• Send from PC: Fax send job from a PC.
• Send to multiple recipients from a PC:
Fax send job to multiple recipients from a PC.
• E-mail send: E-mail send job.
• Send e-mail to multiple recipients:
E-mail send job to multiple recipients.

Manual

Turns "ON" when a fax is transmitted manually.

Time Specified

Turns "ON" when the time is specified in a fax.

Polling

Turns "ON" when polling transmission is used in a
fax.

F-Code

Turns "ON" when F code transmission is used in a
fax.

Call/Receipt

Call: Indicates when the receiver is called by fax.
Receipt: Indicates when a call is received from the
sender fax.

Fax Forwarding

Turns "ON" when a fax is forwarded.

Communication page

Number of pages sent or received by fax.

Service Code

Fax transmission error code.

White/Clear

This is the number of pages printed in White/
Clear color and other colors. For a print job that is
displayed in multiple lines, the number of pages is
displayed in each line by page size and counter.

*1

White/Clear only

*1

This is the number of pages printed only in White/
Clear color. For a print job that is displayed in
multiple lines, the number of pages is displayed in
each line by page size and counter.

*1 W
 hen multiple lines are displayed, items other than this main item are displayed as blank
spaces in the second and subsequent lines.
*2 This item is not displayed in the default settings.
*3 If the time is not notified to the printer, this remains blank.
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Changing the log acquisition
interval and time
The interval and time at which the server
software acquires the log can be changed.

In the [Option] tab, change [Acquire
Logs].
Note!

Start the server software.
Double-click [Printer] in the selection
window. The registered printer list is
displayed in the list view of the details
window.

Always set a time when the computer in
which the server software is set up and
printer power are both switched ON.
The log cannot be acquired if the power
is not ON.

Select the printer, and then select the
[Printer] menu > [Properties].

9

Memo

Multiple printers can be selected.

Interval
Set the interval when the log is acquired over a
fixed time. The maximum interval time that can
be set is 24 hours. The default setting is set as
an optimized value detected from the state of
the printer. If the interval is set to a time that is
longer than the default settings, some of the logs
may not be acquired.

Time
Set the specific time. Click [Change Time], and
add the time to the [Change Time To Acquire
Logs] window. Up to 5 acquisition times can be
added. After adding, click [OK].

Click [OK].
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Changing the deadline
The deadline date on which the log is collected can be set.
The log contents up to the set deadline date are counted for the month.
E.g) If the deadline is set for the 15th, the contents from the 16th of the previous month to
the 15th of this month are collected in the log.

1/15

For February

2/15

For March

3/15

When [Count logs after the closing dates as logs for this month] is checked, the logs for the
day after the set deadline are counted in the current month.
E.g) When the deadline is set for the 15th and [Count logs after the closing dates as logs for
this month] is checked, logs from the 16th of this month to the 15th of the following
month are collected in the log for this month.

9

1/15

For January

2/15

For February

Select [Option] menu > [Setup].
Click the [Change the closing data] tab.
Enter the date that you want to set as the deadline date.
Click [OK].
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Immediately acquiring the
log
The log can be acquired immediately
irrespective of the log acquisition schedule.
Check that the printer power is ON.
Start the server software.
Double-click [Printer] in the selection
window. The registered printer list is
displayed in the list view of the details
window.
Select the printer, and then select the
[Printer] menu > [Acquire a Log].
Memo

Notifying the printer of the
time
As some printer models do not have a
built-in clock, the server software notifies
the printer of the time every hour when
the log is acquired. Therefore, when the
printer power is turned OFF/ON, the time
information cannot be logged until the
printer is notified of the time. In this case,
the time can be notified manually to the
printer.
The time notified to the printer is the
time in the computer in which the server
software is set up.
Check that the printer power is ON.

Multiple printers can be selected.

Start the server software.
Double-click [Printer] in the selection
window. The registered printer list is
displayed in the list view of the details
window.
Select the printer, and then select the
[Printer] menu > [Setting the Time].

9

Click [Close] in the acquisition results
window.

Click [OK] in the completed window.

Memo

When the log is being displayed, select
the [Log] menu > [Refresh Display] to
refresh the log display.
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Displaying the Log

Changing the log save
location
The folder in which the acquired log is
saved and the folder to which the log is
automatically written can be specified.

The log can be displayed according to
printer or date. One log is divided by each
category and displayed, so you can display
or delete logs according to requirements.
When printers are managed in groups, the
log can be displayed as a group.

Displaying the Log
Start the server software.
Click the plus mark on the left side of
[Log] in the selected window.
The log tree opens.

9

Start the server software.

Using the same operations as in step
open [Printer] and [Date] in the tree.

Select [Option] menu > [Setup].

,

Displaying logs
by date

Click the [Login Storage] tab.
Click [Browse].
Select the folder that you want to save,
and click [OK].
Click [OK].

Displaying logs of all
printers belonging to
a group
Displaying individual
printer logs

Display logs by
printer group or by
individual printer
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Select the log that you want to display,
and select the [Log] menu > [Display
Logs].

Displaying all logs for a specific printer
group
In the selection window, select [Log] >
[Printer] > [Group Name] to display the
log.
Displaying all logs for a specific printer
group in a specific month
In the selection window, select [Log] >
[Date] > [XXXX/YY] (XXXX is the year,
YY is the month) > [Group Name] to
display the log.
Memo

①

9

①

③

⑤

• Logs that are acquired while a log is
being displayed can be displayed by
selecting the [Log] menu > [Refresh
Display].
• At the top of the details window, the
date and printer name or group name
of the currently displayed log is shown.

⑥

②

• When the title section of each item is
clicked, the order is sorted (changed)
according to the item contents. When
clicked again, the items are sorted in
reverse order.

④

Date of the
displayed log
④

Displaying all logs for all printers
In the selection window, select [Log] >
[Printer] or [Log] > [Date] to display
the log.
Displaying all logs for specific printers
In the selection window, select [Log] >
[Printer] > [Printer Name] to display the
log.
Displaying all logs for a specific month
In the selection window, select [Log] >
[Date] > [XXXX/YY] (XXXX is the year,
YY is the month) to display the log.
Displaying all logs for specific printers in a
specific month
In the selection window, select [Log] >
[Printer] > [Printer Name] > [XXXX/YY]
(XXXX is the year, YY is the month), or
select [Log] > [Date] > [XXXX/YY] >
[Printer Name] to display the log.
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Changing log items to be
displayed

Displaying all log items
(detail display)
Start the server software.

Start the server software.

Select the [Log] menu > [Display
Details], and check the [Log] check box.

Select the [Log] menu > [Display/Export
Item Settings] > [Log Display Items].

If the log is being displayed, the display is
updated and all of the items are displayed.

Check the items that you want to display,
and uncheck items you do not want to
display.
The display order is the same order as
that in the details window log. You can
change the order by selecting an item,
and clicking [Up] or [Down].

9

Click [OK].
When the log is displayed, the display is
updated.
Note!
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In the detailed display, all of the items
are displayed irrespective of these
settings.
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Deleting the Log
Note!

• As one log is displayed in both the
printer and date trees, if a log is
deleted from a printer tree, the
corresponding section is also deleted
from the corresponding log in the date
tree.
• Deleted logs cannot be recovered.

Outputting the Log as a
CSV file
Outputting as a CSV file
The acquired log can be output as a CSV
format file, and used in commercially
available spreadsheet software.

Start the server software.

Start the server software.

Click the plus mark on the left side of
[Log] in the selected window.
The log tree opens.

Click the plus mark on the left side of
[Log] in the selected window.
The log tree opens.

Using the same operations as in step
open [Printer] and [Date] in the tree.

,

Using the same operations as in step
open [Printer] and [Date] in the tree.

Select the log that you want to delete,
and select the [Log] menu > [Delete the
log].

Select the log that you want to export,
and select the [Log] menu > [Export
Logs].

Click [Yes] in the confirmation window.

Specify the folder and file name to be
saved, and click [Save].

9

Memo
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Changing log items to be
exported

Automatically outputting the
Log as a CSV file

Start the server software.
Select the [Log] menu > [Display/Export
Item Settings] > [Log Export Items].

The acquired log can be automatically
output as a CSV file.
Memo

• A folder of the printer connection
destination (IP address or port name)
is created in the folder specified in
[log auto exporting folder] explained
in "Changing the log save location"
(page 197), and the log is exported to
a file named okrptXXXXYY.csv (where
XXXX is the year and YY the month)
within that folder.
• The items exported in the log can be
changed in "Changing log items to be
exported" (page 201).

Start the server software.

Check the items you want to export, and
uncheck the items you do not want to
export.
The items are exported in the displayed
order. You can change the order by
selecting an item, and clicking [Up] or
[Down].

Double-click [Printer] in the selection
window. The registered printer list is
displayed in the list view of the details
window.
Select the printer, and then select the
[Printer] menu > [Properties].
Memo

Multiple printers can be selected.

In the [Option] tab, change [Auto Export
Logs] to [Automatically export logs].

Click [OK].

Click [OK].
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Exiting log acquisition

Sending a mail to the log
administrator
Acquired logs can be automatically output
to CSV files, and the output file can be
sent as an e-mail attachment every month
to the administrator.
Note!

Memo

The outgoing mail server, sender's
e-mail address and administrator's
e-mail address need to be configured in
advance according to the "Setting the
outgoing mail function" (page 224).
• The mail is sent of the day after the
deadline (default setting is end of
the month) set in the "Changing the
deadline" (page 195).

Log acquisition can be exited and
restarted.
Check that the printer power is ON.
Start the server software.
Double-click [Printer] in the selection
window. The registered printer list is
displayed in the list view of the details
window.
Select the printer, and then select the
[Printer] menu > [Start/End Log].
Memo

Multiple printers can be selected.

• The items exported in the log can be
changed in "Changing log items to be
exported" (page 201).

Start the server software.

9

Double-click [Printer] in the selection
window. The registered printer list is
displayed in the list view of the details
window.
Select the printer, and then select the
[Printer] menu > [Properties].
Memo

Click [Yes] in the confirmation window.

Multiple printers can be selected.

In the [Option] tab, change [Auto Export
Logs] to [Mail logs to administrator].

Click [OK].
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When the "Please enter the administrator
password of the printer" window is
displayed, enter the printer administrator
password, and click [OK].
Note!

Note!

Depending on the printer, this may not
be displayed.

When the following window is displayed,
a connection cannot be made to the
printer.
In this case, always click [No] and
connect to the printer before trying
again.
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Memo

9
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10. Aggregating logs

10.Aggregating logs
Acquired logs can be aggregated by printer, user ID, user name, or month. Also, aggregation
results can be exported as a CSV file.

Aggregating logs
Items that can be aggregated
Items that are displayed for aggregation are as shown below.
Note!

The items that can be aggregated differ depending on the printer model or whether options
are used.

Item

10

Details

Printer

Name of the aggregating printer. This is displayed when
logs are aggregated by printer.

Address

The connection destination of the aggregating printer. This
is displayed when logs are aggregated by printer.

Name

Name of the aggregating user ID. This is displayed when
logs are aggregated by user ID.

Job Account ID

This is the aggregating user ID. This is displayed when logs
are aggregated by user ID.

User

Name of the aggregating user. This is displayed when logs
are aggregated by user name.

Date

Date of aggregation. This is displayed when logs are
aggregated by date.

Group

The name of the group that the aggregating printer or user
belongs to.

Fees

The total fees.

Jobs

The total number of jobs.

Sheets

The total number of sheets printed.

Pages

The total number of pages printed.

Color

The total number of color pages printed.

Mono

The total number of monochrome pages printed.

Printer Use Time

The total time the printer was used.

Completed

The total number of jobs that completed normally.

Canceled
Aborted

*1

The total number of jobs cancelled by user operation. (For
printing, when one or more sheets are printed)

*1

The total number of jobs cancelled by reasons other than
user operation.

*1

Abnormal completed

*1

The total number of jobs that completed abnormally.
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Item
Detailed Status

Details
• Log Buffer Full:
The total number of jobs cancelled because the printer
log is full.
• Access Control:
Total number of jobs cancelled due to use restrictions.
• Memory Over Flow:
Total number of jobs cancelled due to memory overflow.
• Color Control:
Total number of jobs cancelled due to use restrictions
(Disable Color Printing).
• Mono Printing (Color limited):
Total number of jobs printed in monochrome due to use
restrictions (Disable Color Printing).
• Lip Error: Total number of jobs cancelled due to lip error.

A4
A5
A6
:

Total print number for each paper size.

*1

Simplex
Duplex

*1

*1

The total number of sheets printed for simplex printing.
The total number of sheets printed for duplex printing.

Toner (C)

Total number of pages for each level of used cyan toner.

Toner (M)

Total number of pages for each level of used magenta
toner.

Toner (Y)

Total number of pages for each level of used yellow toner.

Toner (K)

Total number of pages for each level of used black toner.

Drum (C)

Total amount of use of cyan drum.

Drum (M)

Total amount of use of magenta drum.

Drum (Y)

Total amount of use of yellow drum.

Drum (K)

Total amount of use of black drum and 4-in-one color
drum.

Belt

Total amount of use of belt.

Fuser

The total amount of belt and fuser used.

Staple

*1

When the optional finisher is installed, this shows the
number of times the stapler is used.

Plain *1 *2
Letter Head
Transparency

Total print number for each paper type.

Auto *1 *2
Light
Medium
:

Total print number for each paper thickness.

Tray1

*1 *2

Total number of sheets supplied from tray 1.

Tray2

*1 *2

Total number of sheets supplied from tray 2.

Tray3

*1 *2

Total number of sheets supplied from tray 3.

Tray4

*1 *2

Total number of sheets supplied from tray 4.
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Item
Tray5

Details
Total number of sheets supplied from tray 5.

*1 *2

Multi-Purpose Tray

Total number of sheets supplied from the multi-purpose
tray/manual feeding tray.

*1 *2

Multi-Purpose Feeder

*1 *2

Total number of pages printed at 300dpi.

300dpi*1 *2

Total number of pages printed at 600dpi.

600dpi

*1 *2

600×1200dpi

Total number of pages printed at 600 x 1200 dpi.

1200dpi*1 *2

Total number of pages printed at 1200dpi.

*1 *2

Total number of pages printed at 2400 x 600 dpi.

2400×600dpi*1 *2
Color Scan Page

*1

The total number of scanned color pages.

Mono Scan Page

*1

The total number of scanned monochrome pages.

Scan Job Print

Total number of scan jobs that are accompanied with
printing.

*1

Scan Job No Print
PC Print *1
Fax To Print
PC Scan *1
:

10

Total number of sheets supplied from the optional multipurpose feeder.

Total number of scan jobs that are not accompanied with
printing.

*1

Total log number for each function.
*1

Total log number for each service.

Print *1
Scan *1
Fax *1
:
Communication Time
Send

*1

Receive

Total time required to send or receive faxes.
Total number of jobs sent by fax.

*1

Total number of jobs received by fax.

*1

Multi-cast Send
Send on PC

Total number of jobs sent by fax to multiple recipients.

*1

Total number of jobs sent by fax from a PC.

*1

Multi-cast Send on PC
Email Send

*1

Total number of jobs sent by e-mail.

*1

Multi-cast Email Send
Communication page

Total number of jobs sent by fax to multiple recipients from
a PC.

*1
*1

Total number of jobs sent to multiple recipients by e-mail.
Total number of pages sent and received by fax.

White/Clear

Total number of pages printed in White/Clear color and the
other colors.

White/Clear only

Total number of pages printed only in White/Clear color.

Toner(W/L)

Total number of pages of each level corresponding to
White/Clear toner usage.

Drum(W/L)

Total usage of the White/Clear drum.

If the aggregate result for this item is 0, it is not displayed.
This item is not displayed in the default settings.

*1
*2
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Displaying the aggregate

Aggregating all logs for all printers
In the selection window, select [Log] >
[Printer] or [Log] > [Date] to
aggregate the logs.

Start the server software.
Click the plus mark on the left side of
[Log] in the selected window.
The log tree opens.

Aggregating all logs for specific
printers
In the selection window, select [Log]
> [Printer] > [Printer Name] to
aggregate the logs.
Aggregating all logs for a specific
month

Using the same operations as in step
open [Printer] and [Date] in the tree.

,

In the selection window, select [Log] >
[Date] > [XXXX/YY] (XXXX is the year,
YY is the month) to aggregate the
logs.
Aggregating all logs for specific
printers in a specific month
In the selection window, select [Log] >
[Printer] > [Printer Name] [XXXX/YY]
(XXXX is the year, YY is the month), or
select [Log] > [Date] > [XXXX/YY] >
[Printer Name] to aggregate the log.
Aggregating all logs for specific
groups
In the selection window, select [Log] >
[Printer] > [Group Name] to aggregate
the logs.

Select the logs to aggregate, and in the
[Log] menu > [Display Total], select [By
Printer], [By Job Account ID], [By User
Name], [By Month], [By Printer Group] or
[By User Group].
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Aggregating all logs for specific
groups in a specific month
In the selection window, select [Log] >
[Date] > [XXXX/YY] (XXXX is the year,
YY is the month) > [Group Name] to
aggregate the log.

Displaying all aggregated
items (detail display)
Start the server software.
Select the [Log] menu > [Display
Details], and check the [Total] check box.

①

③

①

⑤

Memo

10

⑥

②

④

If the aggregate is being displayed, the
display is updated and all of the items are
displayed.

④

• The dates and printer names of
the currently aggregated logs are
displayed at the top of the details
window.
• When the title section of each item is
clicked, the order is sorted (changed)
according to the item contents. When
clicked again, the items are sorted in
reverse order.

Dates of the
aggregated logs

Aggregated printer
names
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Changing aggregate items
Start the server software.
Select the [Log] menu > [Display/Export
Item Settings] > [Total Display Items].

Outputting the
aggregation results as a
CSV file
Outputting as a CSV file
The aggregated results can be output as a
CSV format file, and used in commercially
available spreadsheet software.
Start the server software.

Check the items that you want to display,
and uncheck items you do not want to
display.
The display order is the same order as
that in the details window aggregate
items. You can change the order by
selecting an item, and clicking [Up] or
[Down].

Click the plus mark on the left side of
[Log] in the selected window.
The log tree opens.
Using the same operations as in step
open [Printer] and [Date] in the tree.

,

Select the logs whose aggregates you
want to export, and in the [Log] menu
> [Export Total], select [By Printer], [By
Job Account ID], [By User Name], [By
Month], [By Printer Group] or [By User
Group].

10

Specify the folder and file name to be
saved, and click [Save].

Click [OK].
When the aggregate is displayed, the
display is updated.
Note!

Memo

In the detailed display, all of the items
are displayed irrespective of these
settings.
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Items within the exported items that
are not numbers are enclosed in ""
marks.

10. Aggregating logs

Changing the log items to be
exported
Start the server software.
Select the [Log] menu > [Display/Export
Item Settings] > [Total Export Items].

Check the items you want to export, and
uncheck the items you do not want to
export.
The items are exported in the displayed
order. You can change the order by
selecting an item, and clicking [Up] or
[Down].

10

Click [OK].
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11. Client Software

11.Client Software
This section explains the Job Accounting Mode set by the client software.

Changing Job Accounting
Mode
Job Accounting Mode is a method of setting
the user name and Job Account ID in the
Windows client computer. There are 4
modes.
Note!

Memo

The Job Accounting Mode cannot be
changed in MacOS or Mac OS X.
Job Accounting Mode settings can only
be configured in a print driver that
supports Print Job Accounting.

Even if printing is performed on the shared
printer client side, the input window is not
displayed. Use the hide mode for shared printers.
The system administrator creates an ID file that
contains the Job Account ID and User Name that
correspond to the Windows login user in advance.
By specifying this file with the client software, the
user that performed the printing is identified, and
the corresponding Job Account ID is automatically
acquired. Furthermore, the same Job Account
ID can be set for all login users. The users do
not need to configure settings or to know their
own Job Account ID. When using the Windows
computer as a print server and the printer as a

Types of Job Accounting
Mode

shared printer, install and use the client software
onto the computer to be used as a print server.

Not supported

Tab

11

Hide

Users identification is not performed, and all

The tab for setting the User Name and Job

jobs are recognized as unregistered ID. The User

Account ID to the print driver properties is

Name is the user name used to login to windows,

displayed.

and the Job Account ID is 0. Used when user

It is used by the user themselves to set or

recognition is not needed.

change the User Name and Job Account ID.
Note!

Popup
A pop-up window for setting the User Name and
Job Account ID to be sent for each print job is
displayed.
It is used when 1 computer is used by multiple
users.
Note!

Even if printing is performed on the
shared printer client side, the input
window is not displayed. Use the hide
mode for shared printers.
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When the printer drivers are updated
or reinstalled, the mode returns to
unsupported mode. Therefore, you need
to set the Job Accounting Mode again.
However, when using the function that
sets all printer drivers to the same
mode, it is not necessary to re-set the
mode settings.

11. Client Software

Using Tab Mode
Select [Start] > [All Programs] > [Oki
Data] > [Print Job Accounting Client] >
[Change Job Accounting Mode].
When the [User Account Control] window
is displayed, click [Yes] or [No].

In the [Job Accounting] tab, enter the
User Name and Job Accounting ID, and
click [OK]. In the default settings, the
User Name is the user name used to login
to Windows, and the Job Account ID is 1.

Select the printer driver of the printer
that will acquire the log from the [Driver]
list. To set all printer drivers to the same
mode, check the [Set the same mode for
all drivers] check box.
Select [Tab], and click [Change].

Click [OK] in the change notification
window.

Print from the application.

Select [File] menu > [Close].
In Windows 8.1/Server 2012 R2/8/Server
2012/7/Server 2008 R2/Vista/Server
2008, select [Start] > [Control Panel],
and click [Printer]. (For Windows Server
2003, select [Start] > [Printers and FAX].)
On the printer driver icon, right-click the
mouse button and select [Properties].
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11. Client Software

Using Popup Mode
Select [Start] > [All Programs] > [Oki
Data] > [Print Job Accounting Client] >
[Change Job Accounting Mode].
When the [User Account Control] window
is displayed, click [Yes] or [No].
Select the printer driver of the printer
that will acquire the log from the [Driver]
list. To set all printer drivers to the same
mode, check the [Set the same mode for
all drivers] check box.
Select [Popup], and click [Change].

Click [OK] in the change notification
window.

11

Select [File] menu > [Close].
Print from the application.
When the popup window is displayed,
enter the User Name and Job Accounting
ID, and click [OK].
When [Cancel] is clicked, the user name
is blank and Job Account ID is 0 in the
log. The print job is not cancelled.
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Switching each user for a Job Account ID in hidden mode
Create an ID file using software such as Notepad or Excel etc.

<For Notepad>
The login user and Job Account ID are included for each user individually on a separate line.
The login user name and Job Account ID are separated with a comma (,).
Login user name:
User name entered when logging in to Windows
Job Account ID:
Job Account ID that corresponds to the login user name
User name:
User names used in Print Job Accounting
The user name can be omitted. When omitted, the login user name is used as the user name.

Login user
name

Job Account ID

User name

Save in text format with the extension "CSV".

- 217 -

11

11. Client Software

<For Excel>

The login user and Job Account ID are included for each user individually on a separate line.
Save in CSV file format.
Select [Start] > [All Programs] > [Oki Data] > [Print Job Accounting Client] > [Change
Job Accounting Mode]. When the [User account management] window is displayed, click
[Continue] or [Yes].
Select the printer driver of the printer that will acquire the log from the [Driver] list. To set
all printer drivers to the same mode, check the [Set the same mode for all drivers] check
box.
Note!

11

When the shared printer is used, do not use the function that sets all printer drivers to the
same mode. When using a shared printer on the client side to print, the account information
is not output.
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Acquiring user information
from files in hide mode

Select [Hide], and click [Change].

User information can be acquired from a
specific file. The file created in "Exporting
data for client software" (page 130) can be
specified.
Select [Start] > [All Programs] >
[Okidata] > [Print Job Accounting Client]
> [Change Job Accounting Mode]. When
the [User Account Control] window is
displayed, click [Continue] or [Yes].
Click [OK] in the change notification
window.
Select [Hide Mode] menu > [Import ID
File].

Select the printer driver of the printer
that will acquire the log from the [Driver]
list. To set all printer drivers to the same
mode, check the [Set the same mode for
all drivers] check box.
Note!

When the shared printer is used, do
not use the function that sets all printer
drivers to the same mode. When using
a shared printer on the client side to
print, the account information is not
output.

Select [Hide], and click [Change].

Specify the ID file created in
[Open].

11

, and click

If [Hide Mode] menu > [Set the same
mode for all drivers] check box is
checked, uncheck it.
Select [File] menu > [Close].
Print from the application.
Note!

Memo

When printing is performed after
logging into Windows as a login user
that is not registered, the user name
is the current login user name, and the
Job Account ID is 0 in the log.

Click [OK] in the change notification
window.

Select [Display registered Job Account
IDs] in the hide mode menu, and you
can authenticate Job Account IDs that
have already been registered, delete
unneeded Job Account IDs, and import
ID files.
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Using the same Job Account
ID for all users in hide mode

Select [Hide Mode] menu > [Get user
information from a file].

Select [Start] > [All Programs] > [Oki
Data] > [Print Job Accounting Client] >
[Change Job Accounting Mode]. When the
[User account management] window is
displayed, click [Continue] or [Yes].

Check the [Get user information from a
file] check box, and click [Change].

Select the printer driver of the printer
that will acquire the log from the [Driver]
list. To set all printer drivers to the same
mode, check the [Set the same mode for
all drivers] check box.
Note!

When the shared printer is used, do
not use the function that sets all printer
drivers to the same mode. When using
a shared printer on the client side to
print, the account information is not
output.

Select [Hide], and click [Change].

11

Select the file used to obtain the user
information, and click [OK].
Click [OK].

Click [OK] in the change notification
window.
In the [Hide Mode] menu, check the [Set
the same mode for all drivers] check box.
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Select [Hide Mode] menu > [Setup Fixes
Job Account ID.

Using in an unsupported
mode
Select [Start] > [All Programs] > [Oki
Data] > [Print Job Accounting Client] >
[Change Job Accounting Mode]. When the
[User account management] window is
displayed, click [Continue] or [Yes].

Enter the User Name and Job Account ID,
and click [OK].
Memo

When the user name is omitted, the
login user name is used as the user
name.

Select [File] menu > [Close].
Print from the application.

Select the printer driver of the printer
that will acquire the log from the [Driver]
list. To set all printer drivers to the same
mode, check the [Set the same mode for
all drivers] check box.
Select [Not Supported], and click
[Change].

Click [OK] in the change notification
window.
Select [File] menu > [Close].
Print from the application.
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Memo

11

- 222 -

12. Operation and Management

Operation and Management .......... 224
Uninstalling software .......... 237

12. Operation and Management

12.Operation and Management
This section explains how to move the printer or change the server, and how to delete Print
Job Accounting.

Operation and Management
Setting the outgoing mail function
Configure the settings for using the mail send function. The outgoing mail server, outgoing
mail format, sender mail address and administrator mail address settings can be configured.
Start the server software.
Select [Option] menu > [Setup].
Configure the [Mail setup] tab settings.

①
②

③

④
⑤

⑥

⑦
⑧

⑨

12
Enter the mail server (SMTP) used by the job account server. If you do not know the
server name, contact the network administrator.
Enter the port number. This is usually [25].
Check to perform user authentication when sending mail.
When user authentication is used, enter the login user name.
When user authentication is used, enter the password.
Select the content to send.
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Message to be sent with
logs

This is the content of the mail sent using the function
to e-mail the log to the administrator.

Message to be sent when
the Limit Value was
exceeded

This is the content of the mail sent to the user or
user group when the limit value is exceeded.

Message to be sent when
printing is permitted

This is the content of the mail sent to the user or
user group when the limit value is reset and printing
can be performed.

Message to be sent with
total result

This is the content of the mail sent using the function
to notify the aggregate results by e-mail.

Message to be sent with
log acquisition status

This is the content of the mail sent using the function
to notify the log acquisition status by e-mail.

Message to be sent when
the size of attachment
files exceeded limit value

This is the content of the mail sent when the size of
1 attachment file exceeds the size set in the function
for limiting the size of attachment files.

Message to be sent when
failing in log preservation
to database

This is the content of the mail sent by the function
that notifies when the log fails to be saved to the
database. (Only Enterprise edition)

Message to be sent when
failing in transmitting
card table

This is the content of the mail sent by the function
that notifies when the IC card compatibility table
cannot be sent. (Only Enterprise edition)

Message to be sent when
the card information
doesn't exist in table

This is the content of the mail sent by the function
that notifies when there is no IC card information
in the IC card compatibility table. (Only Enterprise
edition)

Message to be sent when
the card information
overlaps in table

This is the content of the mail sent by the function
that notifies when the IC card information in the
IC card compatibility table is duplicated. (Only
Enterprise edition)

Message to be sent when
the number of users
in card table exceeded
maximum value

This is the content of the mail sent by the function
that notifies when the maximum number of
registered users in the IC card compatibility table is
exceeded. (Only Enterprise edition)

Enter the mail title.
Enter to include a header in the mail body.
Enter to include a footer in the mail body.
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Configure the mail address tab settings.

①
②
③
④
⑤

Enter the name of the mail sender.
Enter the mail address of the mail sender.
,

 et the name and e-mail address of the person you want to send the log to using the
S
function to send log to the administrator. Enter the recipient's name in
and email
address in , and click [Add].
To send to multiple recipients, repeat this operation.
Check that the recipient is displayed, and click [OK].

12
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Sending print prohibited/
permitted by mail

Start the server software.

When [Notifies by e-mail when Limit Value
was exceeded] is checked, users are
notified by mail when the use limit value is
exceeded and printing cannot be executed.

Click the plus mark on the left side of
[Printer] in the selected window.
The printer tree opens.
Select the printer or printer group that
you want to configure from the selection
window, and then select the [Printer]
menu > [Properties].
Click the [User] tab.

Also, users are notified by mail when the
limit value is reset and printing can be
executed.

Select the user to set, and double-click it.
Check the [Notifies by e-mail when Limit
Value was exceeded] check box, and click
[OK].
Note!

Memo

Users are not notified when the mail
address is not entered. Enter the mail
address.
To set multiple users, repeat steps
and
.

Click [OK].
In the [Registration of Job Account ID]
window, click [OK].
In the [Properties of printer from which
logs are acquired] window, click [OK] to
close the printer properties.

12
Note!

The outgoing mail server and sender's
e-mail address need to be configured in
advance according to the "Setting the
outgoing mail function" (page 224).
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Notifying the log acquisition
status by email
The administrator can be notified of the log
acquisition status by e-mail once a day.

Limiting the size and number
of attachments
The size and number of attachments can
be limited, and sent separately in different
e-mails.

Start the server software.
Select [Option] menu > [Setup].
Click the [Mail detail setup] tab.

12

Note!

The outgoing mail server, sender's
e-mail address and administrator's
e-mail address need to be configured in
advance according to the "Setting the
outgoing mail function" (page 224).

Check the [The size and the number of
attachment files are limited] check box,
and enter the [Limit size] and [Limit
number of files].
Click [OK].
Note!

Start the server software.
Select [Option] menu > [Setup].
In the [Mail setup] tab, check the
[Notifies log acquisition status to
administrator by e-mail] check box.
Click [OK].
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When the limit size is exceeded for 1
file, a mail is sent notifying that the
attachment cannot be sent.

12. Operation and Management

Carrying over the unused
print limit quantity

Click [OK].
Click [OK] in the [Job Account ID
registration] window.
In the [Properties of printer from which
logs are acquired] window, click [OK] to
close the printer properties.

When the [Carry over unused value to the
next valid period] check box is checked,
and the printer use limit value is not
exceeded, the unused amount can be
carried over to the next valid period.
In the example in the figure, if a user who
has a limit of 1,000 sheets per month only
prints 500 sheets, they can then print
1,500 sheets the following month.

Limit value
1,000 sheets

Unused value
500 sheets

1,500 sheets

Printed value
500 sheets

Current month

12

Next month

Start the server software.
Click the plus mark on the left side of
[Printer] in the selected window.
The printer tree opens.
Select the printer/printer group to be set
in the selection window, and double-click
it.
Click the [User] tab.
Select the user to set, and double-click it.
Check [Carry over unused value to the
next valid period], and click [OK].
Memo

To set multiple users, repeat steps
and
.
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Deleting a registered printer
To remove a printer from management by
Print Job Accounting because the printer
is to be moved or scrapped, delete the
printer from the server software before
moving or scrapping it.

Click [Yes] in the end log acquisition
confirmation window.
Note!

Check that the printer power is ON.

When the following window is displayed,
a connection cannot be made to the
printer.
In this case, always click [No] and
connect to the printer before trying
again.

Start the server software.
Double-click [Printer] in the selection
window. The registered printer list is
displayed in the list view of the details
window.
When the "Please enter the administrator
password of the printer" window is
displayed, enter the printer administrator
password, and click [OK].
Note!

Depending on the printer, this may not
be displayed.

Select the printer that you want to
delete, and then select the [Printer]
menu > [Start/End Log].
Memo

Multiple printers can be selected.

12
Check that the printer [Status] field in
the details window is [Not acquired].
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Select the printer you want to delete,
and select the [Printer] menu > [Delete a
Printer/Printer Group].

Changing the printer
connection destination or IP
address
To change the printer connection
destination or IP address, change the
server software settings.
Check that the printer power is ON.
Start the server software.
Click the plus mark on the left side of
[Printer] in the selected window.
The printer tree opens.
Select the printer, and then select the
[Printer] menu > [Properties].

Click [Yes] in the delete printer
confirmation window.

In the [Printer] tab, click [Change Address].

Specify the items to delete, and click
[OK].
When the "Please enter the administrator
password of the printer" window is
displayed, enter the printer administrator
password, and click [OK].
Note!

Depending on the printer, this may not
be displayed.

In the user ID delete confirmation
window, click [Yes] to delete the Job
Account ID from the registered printer, or
click [No] to keep the Job Account ID for
the registered printer.
To delete the logs acquired until now by
the server software, click [Yes] in the log
delete confirmation window, or click [No]
to keep the logs in the server software.

12

To change the connection destination,
select the connection destination from
the list and click [OK].
To change the IP address, enter a new IP
address, and click [OK].

In the [Properties of printer from which
logs are acquired] window, click [OK].

- 231 -

12. Operation and Management

Automatically reconnecting
when the printer IP address
is changed
When the printer IP address is changed,
the new IP address can be automatically
connected, and the log can still be
acquired. This is effective when the
IP address is dynamically assigned in
the DHCP environment, or when the
administrator changes the IP address.

Click [Scope].
To add a search range, enter the
broadcast IP address of the search range
you want to add into [New Scope], and
click [Add].  

Select [Option] menu > [Setup].
Click the [Ports] tab.
Check the [Auto Reconnect] check box.

To delete a search range, select the
search range that you want to delete
from [Scope], and click [Delete].
To search the local subnet, check the
[Discover the local subnet] check box.
Click [OK].

12
Enter the interval (unit: hours) at which
the IP change is checked.
Click [OK].
Memo

Perform the following steps to change
the range in which a printer whose IP
address is changed is searched for.
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To change the server to a
different computer

Checking the server ID

To change the server that acquires the
current log to a different computer, delete
the printer on the current server, and then
re-add it to the new server.
If the current server cannot be used due
to a malfunction etc, perform the following
operations on the new server.

Start the server software.
Select [Help] menu > [Server ID].

Check that the printer power is ON.
Start the server software on the new
server.

Check the server ID, and click [OK].

Select the [Printer] menu > [Add a
Printer].
Follow the instructions on the screen to
add the printer.
When the server ID input window is
displayed, enter the server ID of the
server that acquires the current log, and
click [OK].

Continue setup by following the
instructions on the screen.

12
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Installing/uninstalling a
built-in hard disk or SD
memory card to the printer
See "Deleting a registered printer"
(page 230), and delete the printer
registered in the server software.
A built-in hard disk or SD memory card
can be installed/uninstalled to the printer
Add the printer again to the server
software.

Prohibiting initialization of the
built-in hard disk, SD memory
card, or flash memory
When the built-in hard disk, SD memory card,
or flash memory of the printer are initialized,
previous log obtained from the server
software is deleted. Also, as user information
is also deleted from the printer, the server
software cannot acquire the correct log. When
Print Job Accounting is used, it is necessary to
configure the settings so that the built-in hard
disk, SD memory card, and flash memory
cannot be initialized.
Check that the printer power is ON.
Start the server software.
Double-click [Printer] in the selection
window. The registered printer list is
displayed in the list view of the details
window.
Select the printer, and then select the
[Printer] menu > [Properties].
Memo

Multiple printers can be selected.

In the [Option] tab, check the [Inhibit the
initialization of the Hard Disk and Flash
Memory] check box.

12

Click [OK].
The printer built-in hard disk, SD memory
card, and flash memory can no longer be
initialized.

- 234 -

12. Operation and Management

Operations when the log is
full
The processes when the printer log buffer
is full before the log is acquired by the
server software can be set.
Check that the printer power is ON.
Start the server software.
Double-click [Printer] in the selection
window. The registered printer list is
displayed in the list view of the details
window.

When an option is added to a printer,
information can be acquired from the
printer, and the setting information
updated. When an SD card is installed
in the printer for receiving the IC card
compatibility table after the printer
is registered in the server software,
it is necessary to update the setting
information in the server software.
Check that the printer power is ON.

Select the printer, and then select the
[Printer] menu > [Properties].
Memo

Updating setting information
when an option is installed
(Only Enterprise edition)

Start the server software.

Multiple printers can be selected.

In the [Option] tab, change [Operation at
Log Full].

Double-click [Printer] in the selection
window. The registered printer list is
displayed in the details window.

Select the printer, and then select the
[Printer] menu > [Properties].
Memo

Delete old logs
The oldest log is deleted, and the new log is
received.

Cancel the job
All subsequent print jobs are cancelled.

Do not acquire the log
The log is not obtained for subsequent print jobs.

Click [OK].
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Multiple printers can be selected.
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Changing the number of
printers connected at the
same time

Display the [Printer] tab, and click
[Acquire Information].

The number of printers connected at the
same time can be changed. When the
number of printers connected at the same
time is set to a small value, the amount of
processing done by the computer for this
software is reduced.
Start the server software.
Click the [Option] menu > [Setup].  

Click [OK]. To browse the updated setting
information, repeat the steps from
to
.

Display the [Ports] tab.

12
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Change [Number of printers connected at
the same time].

Export job information in
a file if this utility acquires
logs
Job information in a log can be recorded
in a file when the log is acquired from the
printer. This setting is required to add job
information from the log (pages 77, 84,
87 and 91) if use restrictions are set for
the job information. When this setting
is disabled, the load of processing by
this server software on the computer is
reduced.
Start the server software.
Click the [Option] menu > [Setup].

Click [OK].
Display the [Ports] tab.

12
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Check the [Export job information in a file
if this utility acquires logs] check box.

Click [OK].

12
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Uninstalling software
Uninstalling server software
When uninstalling the server software,
always delete the registered printers first
before uninstalling the server software.
See "Deleting a registered printer"
(page 230), and delete the printer
registered in the server software.
Exit the server software.
Select [Start] > [All Programs] >
[Oki Data] > [Print Job Accounting] >
[Uninstall Print Job Accounting]. When
the [User account management] window
is displayed, click [Continue] or [Yes].
Note!

When the following window is displayed,
the printer is not deleted. Always click
[No] to cancel the uninstallation, then
delete the printers before uninstalling
the server software.

Uninstalling the client
software (Windows)
If the client software is running, exit it.
Select [Start] > [All Programs] > [Oki
Data] > [Print Job Accounting Client] >
[Uninstall Print Job Accounting Client].
When the [User account management]
window is displayed, click [Continue] or
[Yes].
Follow the instructions on the screen to
uninstall.
Click [Finish].

Uninstalling plugins (MacOS)
When the printer drivers are uninstalled,
the plugins are also uninstalled.

Uninstalling client software
(Mac OS X)
Delete the Print Job Accounting icon that
was copied to the desired location during
installation.

Follow the instructions on the screen to
uninstall.
Click [Finish].
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Memo

12
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13. Troubleshooting

13.Troubleshooting
This chapter explains some of the problems that could possibly occur when using Print Job
Accounting, and provides hints to their solutions.

Item
Cannot find the printer
even when searching
using [Add a Printer].

Details
• Check that the printer power is ON.
• Check whether the printer is processing or offline,
or whether an error has occurred (no paper etc).
Check that the printer is online, and click [Start new
search].
• Click [Back], and check that the correct search
option check boxes are checked.
• When the search target is [TCP/IP Network], check
whether the broadcast address is correct. If it is
unknown, contact the network administrator.
• The printer does not support Print Job Accounting.
Check the type of printer connected to the
connection destination.
• If the [Do not allow exceptions] check mark is
checked in the Server 2003 SP1 or later firewall
settings, printers cannot be searched beyond
the router segments. Therefore, in the Add log
acquisition printer wizard, select [Specify the printer
by address], select [Address] > [TCP/IP Network],
and enter the IP address directly.

When a printer connection The printer does not support Print Job Accounting.
Check the type of printer connected to the connection
destination is specified
using [Add a Printer], the destination.
error "Printer does not
have the log acquisition
capability" is displayed.

13

When adding a printer,
"There is no sufficient
capacity to store a log"
error is displayed.

There is not enough free space in the printer built-in
hard disk, SD memory card or flash memory.
Secure the appropriate amount of free space.

When adding a printer
or changing settings,
or when immediately
acquiring a log, the
"Cannot connect to the
printer. Wait for a while
and try again.", "Unable
to communicate with the
printer. Please check the
printer." or "The printer
is busy. Wait for a while
then try again" message
is displayed.

• Check that the printer power is ON.
• Check whether the printer is processing or offline,
or whether an error has occurred (no paper etc).
Check that the printer is online and try again.
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Item

Details

When creating a CSV file
to register Job Account
IDs and Names in a
batch, "An error was
found in the import
file" error message is
displayed.

• Check whether the CSV file format is correct.
• Check that the names and Job Account IDs do not
exceed the registration range. The Job Account ID
is registered from 1 to 999999999, and the User
Names within 80 characters.
• Check that the " symbol is not included in names.
Names that include " cannot be registered.

When the ID file for
setting the hide mode
in the client software
is imported, "An error
was found in the import
file" error message is
displayed.

• Check whether the CSV file format is correct.
• Check that the User names and Job Account IDs do
not exceed the registration range. The Job Account
ID is registered from 1 to 999999999, and User
Name within 80 characters.
• Check that the " symbol is not included in user
names. Names that include " cannot be registered.

When printing, the print
job is automatically
cancelled and cannot be
executed.

• Check whether the Job Account ID of the print job is
"Disable Printing" or "Disable Color Printing".
• Check whether the limit value for the Job Account
ID is exceeded, and check the limit values and valid
period.
• The operation when log is full is set to "Cancel
the job", and the printer log buffer is full. Select
the printer, and then select the [Printer] menu >
[Acquire a Log] to acquire the log. Next, reset the
log acquisition schedule to a shorter time.

The log cannot be
acquired according to the
set schedule.

Select the printer, and then select the [Printer] menu
> [Acquire a Log]. When an error is displayed, check
that the printer power is ON. Also, check whether the
printer is processing or offline, or whether an error
has occurred (no paper etc).
When the log is acquired correctly, check the log
acquisition schedule. Check that the acquisition time
is at the same time as when the printer and server
power are usually ON. If there are no problems in the
above settings, restart Windows.

Not all of the logs are
acquired.

The printer's log buffer is full when the operation
for when the log is full is set to "Delete old logs" or
"Do not acquire the log", Reset the log acquisition
schedule to a shorter time.

Some logs are not
If the printer model does not have a built-in clock,
displayed at the start time when the printer power is switched OFF/ON, time
or end time.
information cannot be stored in the log until the
printer is notified of the time. For details on how
to notify the printer of the time, see "Notifying the
printer of the time" (page 196).
For models that have a built-in clock, the time needs
to be set in the printer.
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13. Troubleshooting

Item

13

Details

When attempting to
delete a printer, "Cannot
delete while log is being
acquired" message is
displayed.

A printer cannot be deleted while the log is being
acquired. Select the printer that you want to delete,
select the [Printer] menu] > [Start/End Log] to end
acquiring the log, and then delete the printer.

When [Acquire a Log]
is performed, "Select
to start log before
attempting to acquire a
log" message is displayed.

The log is in the unacquired state. Select the printer
whose log you want to acquire, and select the
[Printer] menu > [Start/End Log] to start acquiring
the log. Logs can be acquired after starting.

When [Acquire a Log]
is performed, "This task
cannot be performed
while acquiring a log"
message is displayed.

The log is acquired according to the log acquisition
schedule.
Wait for a while to check whether the log is acquired.
If "Log acquisition schedule..." is shown for a long
time, restart Windows.

In the printer [Log] field
of the details window,
[Acquire from different
server] is displayed.

Either the log is set to be acquired by a different
server, or the printer flash memory was initialized.
Select the printer, and then select [Printer] menu >
[Delete a Printer/Printer Group] to delete the printer,
and then follow the steps in [Printer] menu > [Add a
Printer] to re-add the printer. If the printer is set to
acquire the log from a different server, see "To change
the server to a different computer" (page 233).

Cannot perform menu
printing or demo printing
from the control panel of
the printer.

• Check whether the local printer is set to printing
prohibited or color printing prohibited.
• Check the limit values and valid period to ensure
that the local print limit values are not exceeded.

Cannot initialize the flash
memory from the printer
control panel. Also, the
hard disk or SD memory
card cannot be initialized
for models equipped with
an internal hard disk or
SD memory card.

When using the Print Job Accounting, check the
[Inhibit the initialization of the Hard Disk and Flash
Memory] check box in the server software. In this
state, the flash memory, built-in hard disk and SD
memory card cannot be initialized. Follow "Deleting a
registered printer" (page 230) to delete the printer,
and then initialize the flash memory, built-in hard
disk or SD memory card. After initializing, select the
[Printer] menu > [Add a Printer], and follow the steps
to re-add the printer.
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